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Welcome to Discovery Manager
Administration

This guide describes how to work with Discovery Manager.

How This Guide Is Organized

Part |

Part Il

Part Il

Part IV

Part V

The guide contains the following chapters:

Introduction

Contains an explanation of what the discovery process is and describes the
Mercury Business Availability Center discovery process architecture.

Discovery Probe Installation

Describes how to install the Discovery Probe.

Packages

Describes how to create and deploy packages.

Working with the Discovery System

Describes how to run the discovery process by activating and editing
discovery patterns.

Performing Specific Discoveries

Contains a description of specific discoveries.
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Part VI Appendixes

Describes how to add the attribute optional="true” to a variable tag in a
discovery pattern. It also provides a list of discovery patterns, discovery
methods and discovery log descriptions.

Who Should Read This Guide

This guide is intended for the following users of Mercury Business
Availability Center:

» Mercury Business Availability Center administrators

» Mercury Business Availability Center platform administrators

» Mercury Business Availability Center application administrators

» Mercury Business Availability Center data collector administrators

Readers of this guide should be knowledgeable about enterprise system
administration, have familiarity with ITIL concepts, and be knowledgeable
about Mercury Business Availability Center in general and Mercury
Application Mapping technology specifically.

Getting More Information

For information on using and updating the Mercury Business Availability
Center Documentation Library, reference information on additional
documentation resources, typographical conventions used in the
Documentation Library, and quick reference information on deploying,
administering, and using Mercury Business Availability Center, refer to
Getting Started with Mercury Business Availability Center.
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Introduction to the Discovery Manager

This chapter introduces the Discovery Manager. The Discovery Manager
enables you to manage the discovery process.

This chapter describes: On page:

About the Discovery Process

Discovery Process Architecture

About the Discovery Manager

N | | W

Before You Begin

About the Discovery Process

Mercury Business Availability Center’s discovery system enables you to
automatically discover and map logical application assets in Layers 2
through 7 of the Open System Interconnection (OSI) Model. It is an
ongoing, automatic process that continuously detects changes that occur in
your IT infrastructure and updates the CMDB accordingly. You do not need
to install any agents on the discovered devices. The discovery process uses a
spiral discovery model that has over 100 out-of-the-box discovery patterns.

The discovery process is a gradual uncovering of the elements in your
system. Discovery is first done at the most basic level, and then at more
in-depth ones. Every time a discovery pattern is activated, it discovers more
ClIs, which in turn are used as triggers for other discovery patterns. This
process continues until your entire IT infrastructure is discovered and
mapped.
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The discovery process does the following:

Sweeps the application domain
Identifies application element details
Determines which ports are being used
Checks the operating system

Communicates with Industry standard or Application APIs

Discovery Process Architecture

Y Y Y Y Y

The architecture of the Mercury Business Availability Center discovery
process consists of the following components:

“Discovery Pattern” on page 4

“Discovery Module” on page 5

“Discovery Probe” on page 5

“Mercury Business Availability Center Servers” on page 5

“Discovery Protocol” on page S

Discovery Pattern

The discovery process is run by activating discovery patterns. A discovery
pattern is an XML template that contains definitions of one or more
discovery tasks. It defines which data is discovered, through which protocol,
when to pass the data on to the CMDB, and the executing schedule. A
discovery pattern contains a description of the configuration items (Cls) and
relationships that are created with each specific pattern. The CI and
relationship definitions are taken from the CI Type Model, which contains
the definitions of all the configuration item types (CITs) and relationships
defined in the system.
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Discovery Module

A discovery module contains one or more discovery patterns that together,
allow a discovery of a specific technology/application. For example,
discovery of the network includes patterns that discover: IPs, servers,
switches, routers, and so forth.

Discovery Probe

The Discovery Probe is the main discovery component responsible for
receiving discovery tasks from the Mercury Business Availability Center
server, dispatching them to the IT components and sending the results back
to the CMDB through the server. You define a range of network addresses to
a specific installed Discovery Probe. The connection between the Discovery
Probe ID to the physically installed Discovery Probe is made in the
appilog-remote.properties file, which is located in: \<Discovery Probe
installation location>/root/lib/collectors.

Mercury Business Availability Center Servers

The Mercury Business Availability Center Core Server hosts the servlets that
deliver discovery requests to the Discovery Probe. The Processing Server
receives the discovery results and stores the collected data in the CMDB.

If you install Mercury Business Availability Center using a single machine,
that server functions as both a Processing and Core Server.

Discovery Protocol

Discovery of the different IT infrastructure components is performed by
using various protocols such as SNMP, WMI, JMX, Telnet, and so forth.
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About the Discovery Manager

The Discovery Manager contains discovery modules. Each module contains
one or more discovery patterns required for discovering a specific group of
ClIs. You run the discovery process by activating discovery patterns in the
Discovery Manager. You can choose to activate all the patterns in the
module or only some of them.

The Discovery Manager also enables you to edit the discovery patterns. Only
administrators with an advanced knowledge of how the discovery process
works, should edit the discovery patterns. For details, see “Running the
Discovery Process” on page 25.

Before You Begin
Before you run the discovery process, you must first do the following:

» Obtain a license. For more information, contact your Mercury
representative.

> Install the Discovery Probe. For information on how to install the Discovery
Probe, see “Installing the Discovery Probe” on page 9.

Note:

» To perform a DB2 discovery, copy the files db2java.zip and db2jcc.jar
from the DB2 installation folder and place them in Mercury Business
Availability Center’s\DiscoveryProbe\root\ext\jdbcdrivers\DB2.

» When performing an Oracle RAC discovery, note that the discovery
process cannot discover links to the remote machines (DB clients) in the
following situation: The discovered database is reporting its clients by
their host names and not the IP addresses and the host name cannot be
resolved to an IP address. In this case, the remote client cannot be
created.
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Installing the Discovery Probe

This chapter describes the hardware and software requirements and the
procedures that are needed for the installation of the Discovery Probe on a
Windows platform.

This chapter describes: On page:
About Installing the Discovery Probe 9
Discovery Probe Hardware and Software Requirements 10
Discovery Probe Installation Procedure 10

About Installing the Discovery Probe

Before you run the discovery process, you first need to install the Discovery
Probe. Read about the hardware and software requirements for installing the
Discovery Probe below, and the Discovery Probe installation procedure in
“Discovery Probe Installation Procedure” on page 10.
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Discovery Probe Hardware and Software Requirements

The following table describes the hardware and software requirements for
installing the Discovery Probe.

Supported Environments

Memory

Free Hard Disk Space

» Microsoft Windows
2000

» Microsoft 2003 Server

» Microsoft Windows
XP

Minimum: 256 MB RAM

Recommended: 1024 MB
RAM

Minimum: 2 GB
Recommended: 4 GB

Discovery Probe Installation Procedure

10

It is recommended to install the Discovery Probe on a separate server with
Windows 2000 or 2003 to distribute the overall system load. Solaris is not

supported.

To install the Discovery Probe, follow the instructions of the Discovery

Probe wizard.

To install the Discovery Probe:

1 In the Admin menu, select Platform, and then click Downloads to open the

Downloads page.

Click the Auto Discovery Probe link. A dialog is displayed asking if you want
to open the Setup file or save it to your computer.

» If you choose to open the file, it will not be saved to your computer, and
the setup program will start immediately. In this case, depending on your
browser security settings, you might receive a security warning dialog
box. Confirm that you want to proceed.

» If you choose to save the file to your computer, double-click it to begin

installation.

The Discovery Probe wizard opens the Introduction page.

3 Click Next to open the Choose Installation Folder page.
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Click Choose to display a standard Browse dialog box. Browse to and select
the installation folder.

Note: If you change your mind after selecting a directory in the Browse
dialog box, click Restore Default Folder to restore the default installation
directory.

Click Next to display the Discovery Probe Configuration page.

6 In the Discovery Probe Configuration page, do the following:

» In the Core Server IP box, enter the IP or the DNS name of the Core
Server.

> In the Probe IP box, enter the IP address of the machine on which you
want to install the Discovery Probe.

> In the Probe Identifier box, enter the name you want to give for the
Discovery Probe to be used for the discovery process. The Discovery
Probe identifier defined here appears as the default Discovery Probe in
the Discovery Probes Manager tab in the Discovery Manager. For details,
see “Adding a Discovery Probe” on page 36.

» (For MMS environments only where a single server hosts multiple
environments) In the BAC Customer ID box, enter the Customer ID for
the environment to which the Discovery Probe reports.

7 Click Next to open the Server Communication Protocol page.

8 Select Probe Server HTTPS to secure the Discovery Probe/Server link.

9 Click Next to open the Memory Size page.

In the Memory Size page, define the minimum and maximum memory to
be allocated to the Discovery Probe. The values are measured in megabytes.

» In the Discovery Probe Min Heap box, enter a value that defines the
minimum amount of memory to be allocated to the Discovery Probe.

> In the Discovery Probe Max Heap box, enter a value that defines the
maximum amount of memory to be allocated to the Discovery Probe.

11
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Note: It is recommended not to change the defaults.

11 Click Next to open the Pre-Installation Summary page and review the
selections you have made.

12 Click Install to complete the installation of the Discovery Probe. When the
installation is complete the Install Complete page is displayed.

13 Click Done. The following shortcut is added to the Windows Start menu:

Programs > Business Availability Center > Administration > Discovery Probe
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Package Administration

This chapter explains how to deploy packages. Packages contain definitions,
resources, and tools that enable you to discover IT infrastructure resources
such as network extensions, applications, and databases.

This chapter describes: On page:
Package Administration Overview 15
Deploying a Package 16
Removing a Package 17
Displaying Packages Currently Deployed 17
Dependencies Among Packages 18
XML File Naming Conventions 21
Troubleshooting Issues 21

Package Administration Overview
Packages fulfill several functions:

» A package includes all resources needed for the discovery of a specific
IT infrastructure asset. For example, Mercury Business Availability Center
runs the SQL_Server package to discover Microsoft SQL Servers.

For details on using the Discovery Manager, see Chapter 1, “Introduction to
the Discovery Manager.”

» Mercury Business Availability Center extracts information from packages
when building views, hierarchies, TQL queries, and so on.

15
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» Packages enable you to copy resources from one environment to another,

for example, from a test to a production environment.

You can deploy and remove packages without the need to restart the server
by using the JMX console. You can also display currently deployed packages.

Deploying a Package

16

This section explains how to deploy a package using the JMX console.

To deploy a package:

Launch the Web browser and enter the following address:
http://<server_name>:8080/jmx-console, where <server_name> is the name of
the machine on which the Data Processing Server is installed.

Under MAM, click service=Package manager to open the JMX MBEAN View
page.
Locate deployPackages and enter the following information:

» In the customerld box, enter 1.

» In the dir box, enter the name of the folder which contains the package’s
zip file.

Include the full path to the folder.

» In the packagesNames box, enter the name of the package.
The rules for entering a package name are as follows:
» The package name can contain a wildcard character (*).
» The package name is case sensitive.

» The package name must have a .zip extension.

4 Click Invoke to deploy the package.
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Removing a Package
This section describes how to remove a package using the JMX console.

To remove (undeploy) a package:

1 Launch the Web browser and navigate to: http://<server_name>:8080/jmx-
console, where <server_name> is the name of the machine on which the
Data Processing Server is installed.

2 Under MAM, click service=Package manager to open the JMX MBEAN View
page.
3 Enter the following to the right of the undeployPackages box:

» In the customerld box, enter 1.

» In the packagesNames box, enter the name of the package you want to
remove.

The rules for entering a package name are as follows:
» Wildcard characters (*) are not supported
» The package name is case sensitive.

4 Click Invoke to remove the package.

Displaying Packages Currently Deployed
This section describes how to display packages that are currently deployed.

To display packages that are currently deployed:

1 Launch the Web browser and navigate to: http://<server_name>:8080/jmx-
console, where <server_name> is the name of the machine on which the
Data Processing Server is installed.

2 Under MAM, click service=Package manager to open the JMX MBEAN View
page.

3 To the right of the displaydeployedPackages box, enter 1 in the customerld
box.

4 Click Invoke to display the packages that are currently deployed.

17
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Dependencies Among Packages

Certain packages are dependent for their functioning on the installation of
other packages. This means that certain packages have to be deployed before
deploying others. These dependencies are specified in the descriptor.xml file
included in each package.

For example, the SQL_Server package is based on resources that are
contained in the Database_Basic package. To view this dependency, open

18

SQL_Server.zip and open descriptor.xml in a text editor:

<descriptor>

<dependency>Database_Basic.zip</dependency>

</descriptor>

The following table contains a list of the default packages in the package

directory and their dependencies.

Package Dependent On...
AutoDiscovery None
Basic_Classes None
BLE » SLP
» Basic_Classes
» Database_Basic
» EUM
» Business
Business Basic_Classes
BusinessService None

Credential_Less_Discovery

» Basic_Classes
» AutoDiscovery

Database_Basic

» Host_Resources_Basic

DB2

Database_Basic

Default_View

views
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Package

Dependent On...

diagnostics

» Network
» Business
> BLE

> views

>» SLP

EMS

» Network

» Business

» BLE
views

EUM

Business

views

EUM_61

BLE
EUM

>

>

>

» Business
>

>

» views

Host_Resources_Basic

Network

Host_Resources_By_NTCMD

Host_Resources_Basic

Host_Resources_By_SNMP

Host_Resource_Basic

Host_Resource_By_TTY

Host_Resources_Basic

Host_Resource_By_WMI

Host_Resource_Basic

IBM_HTTP_Server

» WebServer

> J2EE
ITU >» EUM
» sitescope
» views
J2EE Database_Basic
Layer2 Network
Mainframe Host_Resources_Basic

19
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Package Dependent On...
NetLinks » Basic_Classes
» Network
Network » Basic_Classes
» AutoDiscovery
Oracle Database_Basic
OracleApps » Database_Basic
> J2EE
» Oracle
SAP » J2EE
» WebServer
SAP_discovery > SAP
SAP_monitoring >» EUM
» sitescope
» BLE
» SAP
ServiceCatalog view
Siebel Database_Basic, WebServer
Siebel_discovery Siebel
sitescope Business
SLP None
snapshot None
SQL_Server Database_Basic
Sybase Database_Basic
TCP_discovery Network
UDX EMS
views None
watchdog » sitescope

» views

20
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Package Dependent On...
WebServer Network
Websphere_MQ Network

XML File Naming Conventions
Use the following naming conventions when naming the XML files:

» The names of the resources described in the XML file must be identical to
the names of the XML files. For example, a correlation rule called
MyCorrelation must be described in a file called MyCorrelation.xml.

» The XML file name is case sensitive.

Troubleshooting Issues

This section describes some of the troubleshooting issues that may arise
when using the JMX console to deploy, display, or remove deployed
packages.

This sections contains the following topics:
» “Verifying Dependency Among Packages” on page 21
> “Undeploying Packages” on page 22
» “Verifying Packaging Operations” on page 22

Verifying Dependency Among Packages

Certain packages are dependent for their functioning on the installation of
other packages. These dependencies are specified in the descriptor.xml file
included in each package. The success of package deployment or removal of
a package may depend on the installation of other packages.
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For example:

» If package A is dependent on package B, you cannot remove package B.

» If you want to deploy package A, which is dependent on package B, but

package B does not exist, you cannot deploy package A.

Note: For a list of the packages and their dependencies, see “Dependencies
Among Packages” on page 18.

Undeploying Packages

You cannot remove (undeploy) a package that contains a CIT if an instance
of that CIT appears in the CMDB.

You cannot undeploy a package if one of its resources remains deployed.

Verifying Packaging Operations

It is recommended to check the packaging.log file after each operation to
verify its success. If the operation was not successful, the log file contains
detailed information on why the operation failed.

The packaging.log file is located in: <Mercury Business Availability Center
root directory>\log.
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Running the Discovery Process

This chapter describes how to run the discovery process by activating and
editing discovery patterns.

This chapter describes: On page:
Understanding the Discovery Manager 26
Understanding the Module Manager Tab 27
Managing Modules 28
Adding a Discovery Probe 36
Configuring the Connection Data for a Protocol 40
Using Advanced Options in the Details View Pane 43
Discovery Process Configuration Files 59
Understanding the Discovery TQL Manager 63
Defining Discovery TQL Queries 64
Understanding the Pattern Editor 69
Editing a Pattern 70
Scheduling a Discovery Pattern to Run on a Periodic Basis 75
Defining Advanced Settings 80
Discovery Pattern Validation 81
Activating a Discovery Pattern 82
Deactivating a Discovery Pattern 82
Understanding the Discovery Manager Map View Tab 83
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Understanding the Discovery Manager

26

This chapter describes: On page:
Understanding the Schedule View Tab 90
Protocol Definitions 92

The Discovery Manager is displayed by selecting Admin > CMDB and then
clicking the Discovery Manager tab. The Discovery Manager contains the

following tabs:

Module Manager. Contains:

> Details View tab. Enables you to activate discovery patterns. The Module
Manager contains a list of discovery modules. Each discovery module
includes a group of discovery patterns. Select the required discovery
patterns from the various modules to discover a specific group of CIs. For
details, see “Understanding the Module Manager Tab” on page 27.

» Map View tab. Displays a visual representation of the real-time progress
of the discovery process. For details, see “Understanding the Discovery

Manager Map View Tab” on page 83.

» Schedule View tab. Displays all discovery pattern scheduling information
in one table. For details, see “Understanding the Schedule View Tab” on

page 90.

Probe Manager. Enables you to:

» Define a new discovery probe and the range of the IP addresses to be
discovered. For details, see “Adding a Discovery Probe” on page 36.

» Define the connection data for each protocol. For details, see

“Configuring the Connection Data for a Protocol” on page 40.
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Understanding the Module Manager Tab

The Module Manager tab contains a list of discovery modules. Each module
includes the discovery patterns necessary to discover a specific group of ClIs.

Moclule Manager | Probe Manager I
rDizcovery Modules—————————————

L Database - Oracle
_’ Dstabasze - Oracle THS

_g Databaze - SGLServer

¥ 54 Host Resources - REGISTR
_5!' Host Resources - SMWP

_I Host Resources - S5HMelne
_5!' Host Resources - Wil

_g Metwaork - Advanced

1 :l§ Metwork - Bazic

—1 =, Host_ID_Dizcowver

— =, ICMP_MET _Dis_lpC

k2 _g Metwork - Credential Less D
E:! :!_, Metweark - Pratocol Connec_
— = NWTCMWD_MET_Dis_Conne
—Y =1, SNMP_MNET Dis_Conne
— = TTY_Met_Dis_Connectic
¥ =1, wMI_NET Dis_Connec
_I Metvwark - TCP Discovery

_I ‘Wb Servers - Basic

:I Cthers

il I— = ICWMP MET Dii InE _I_I

3
..... >

@
xa

From the Discovery Modules pane, you can select the module(s) you want to
use for the discovery process. The discovery patterns contained in the

= | modules you select are used in the discovery process. Each icon represents a
module.
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When you select a module, the Details View tab in the Module Manager is
divided as follows:

Field Description
Discovery Module Contains the following fields:
Summary

» Discovery Module Name. The name of the
selected module.

» Description. A description of the selected
module.

Statistics Contains the following fields:

» CIT. The name of the CIT discovered by the
module.

» Created. The number of CIT instances created by
the module.

» Updated. The number of CIT instances updated
by the module.

» Deleted. The number of CIT instances deleted by
the module.

Note: The last row of the Statistics table, the Total

row, contains the total number of CIs in each

column.

Note: For details on the Map View tab, see “Understanding the Discovery
Manager Map View Tab” on page 83.

Managing Modules

28

This section contains the following topics:

>» “Editing a Discovery Module” on page 29
» “Activating a Discovery Module” on page 30

> “Deactivating a Discovery Module” on page 31
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“Creating a Discovery Module” on page 31
“Deleting a Discovery Module” on page 32
“Searching For a Discovery Pattern” on page 32

“Updating the Statistics Table for the Selected Discovery Module” on
page 33

“Resetting the Statistics Table for the Selected Discovery Module” on page 33

» “Sorting and Customizing Tables” on page 34

» “Maximizing and Restoring the Statistics Table” on page 35

Editing a Discovery Module

You can edit each module to include the discovery patterns you want it to
contain.

To edit a discovery module:

In the Discovery Modules pane, right-click the module you want to edit and
select Edit Module to open the Edit Discovery Module dialog box.

71 Edit Discovery Module x|

Discovery Module Mame:  Host Resources - SHMP

Description

Host Rezource data: Dizk, Software, Processes etc. using SMMP protocol.

~Module Patterr
(2 stmP_HR_pisk (2]
2] simP_HR_OSUser =l

(2] sMP_HR_Printgy
2] siMP_HR_Process
(2] stMP_HR_Service
[2) snmMP_HR_sottware

0K I Cancel
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The Edit Discovery Module dialog box has the following fields:
» Description. A description of the selected module.
» Module Patterns. A list of the discovery patterns in the selected module.

Click the Add Discovery Pattern to Module button to open the Choose
Discovery Patterns dialog box.

Select the pattern(s) you want to add to the module. You can make multiple
selections.

Click OK. The discovery patterns are added to the Module Patterns area in
the Edit Discovery Module dialog box.

Click OK in the Edit Discovery Module dialog box to save the changes you
have made.

Activating a Discovery Module

When you activate a discovery module, you activate all the patterns
contained in the module.

To activate a discovery module:

In the Discovery Modules pane, right-click the module you want to activate
and select Activate, or select the required module and click the Activate
button in the bottom right corner of the Discovery Modules pane.

A module that is activated, as seen here, is marked with green dots.

Note: If only some of the module’s patterns are activated, the module is
marked with a single green dot. If all patterns of the module are activated,
the module is marked with three green dots.

When the discovery module is activated, it discovers CITs and relationships
of the types that are described in each pattern, and places them in the
CMDB.
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Deactivating a Discovery Module

This section explains how to deactivate a module that is activated.

To deactivate a discovery module:

In the Discovery Modules pane, right-click the module you want to
deactivate and select Deactivate, or select the required module and click the
Deactivate button in the bottom right corner of the Discovery Modules
pane.

Creating a Discovery Module

This section describes how to create a discovery module.

To create a discovery module:

In the Discovery Modules pane, right-click Discovery Modules at the top of
the hierarchy.

Select Create new module. The Choose new name for discovery module
dialog box opens.

Enter a new name for the module.

Click OK to create the new module. The new discovery module appears in
the Discovery Module pane.

To add discovery patterns to the module, right-click the module and select
Edit Module. The Edit Discovery Module opens. For details, see “Editing a
Discovery Module” on page 29. After you add one or more discovery
patterns to the module, the module then appears in the Discovery Module
pane.
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Deleting a Discovery Module

This section describes how to delete a discovery module.

Note: Only administrators with an expert knowledge of the discovery
process should delete discovery modules.

To delete a discovery module:

In the Discovery Modules pane, right-click the module you want to delete
and select Delete.

Searching For a Discovery Pattern

Discovery Manager’s searching capabilities enable you to find a specific
discovery pattern in the Discovery Modules pane. These capabilities provide
different search criteria through which you can search for discovery
patterns. You can do a search according to their pattern name, input type, or
output type.

To search for a discovery pattern in the Discovery Modules pane:

At the bottom of the Discovery Module pane, click the Find Pattern button
to open the Find patterns dialog box.

To search for a pattern by name, do the following:
> Select Name.

> In the Discovery Pattern Name box, enter the name of the pattern you
want to find. Mercury Business Availability Center searches for patterns
whose names contain the entered text.

3 To search for patterns by ClIs that triggered the discovery pattern (input Cls),

do the following:
> Select Input type.

» In the Cl Type area, click the Cl Type button to open the Choose
Configuration Item Type dialog box.

» Select the required CIT and click OK.
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4 To search for patterns by CIs that are discovered as a result of the activated

discovery pattern (output Cls), do the following:
» Select Output type.

> In the Cl Type area, click the Cl Type button to open the Choose
Configuration Item Type dialog box.

» Select the required CIT and click OK.

In the Direction section, specifty whether you want to do a forward or
backward search.

To run the search do one of the following:

» Click Find Next. If Mercury Business Availability Center finds a match, it
highlights the next pattern that meets the search criteria you defined.

» Click Find All. If Mercury Business Availability Center finds a match, it
highlights all the patterns that meet the search criteria you defined.

Updating the Statistics Table for the Selected Discovery
Module

The discovery process results in the Statistics table are not automatically
updated.

To update the Statistics table:

In the Module Manager tab, click the Refresh Statistics button to the left of
the Statistics table.

Resetting the Statistics Table for the Selected Discovery
Module

You can delete all the statistics from the Statistics table and restart the
counting from zero.

To reset the Statistics table:

In the Module Manager tab, click the Reset Statistics button to the left of
the Statistics table.
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Sorting and Customizing Tables

This section describes how to sort the content in the columns and set which
columns you want to display and in what order.

“Sorting the Statistics Table” on page 34

“Hiding a Column in the Statistics Table” on page 34
“Displaying Hidden Columns in the Statistics Table” on page 34
“Customizing the Statistic Table” on page 35

Sorting the Statistics Table

You can sort the contents of the Statistics table to be displayed in either
ascending or descending order.

To sort the contents of a Protocol Entry column:

1 Click a column header.

To change the sort order, click the column header again.
Once a column has been sorted its header displays a pink triangle pointed

upwards for ascending order or downwards for descending order.

Hiding a Column in the Statistics Table
You can hide a column in the Statistics table.
To hide a column in the Statistics table:

On the selected tab, right-click the header of the column you want to hide
and select Hide Column.

Displaying Hidden Columns in the Statistics Table
You can display hidden columns in the Statistics table.

To display hidden columns:

Right-click one of the column headers and select Show All Columns.
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Customizing the Statistic Table

You can customize the Statistics table.

To customize the Statistics table:

1 Right-click one of the column headers and select Customize to open the

Columns dialog box.

To remove column(s) from the tab, select the required column(s) in the
Visible Columns area and click the Remove Column button. The selected
column(s) moves to the Hidden Columns area. (To return a column to the
Visible Columns area, select it and click the Add Column button.)

3 To change the display order of the columns, use the up and down arrows.

Click OK to apply your customization to the table.

Maximizing and Restoring the Statistics Table

This section describes how to maximize and restore the Statistics table to its
previous size.

To maximize and restore the Statistics table to its previous size:

Click the up arrow at the top left-hand corner of the Statistics table to
maximize the table.

Click the down arrow at the top left-hand corner of the Statistics table to
restore the table to its previous size.
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Adding a Discovery Probe
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This section explains how to add a Discovery Probe and define its discovery
range using the Probe Manager tab.

This section contains the following topics:

“Adding a Discovery Probe and Configuring the Discovery Range” on
page 36

“Deleting a Discovery Probe” on page 38

“Editing the Probe Description” on page 38
“Deleting an IP Range” on page 38

“Editing an Existing IP Range” on page 39

“Rules for Defining an IP Address Range” on page 39

Adding a Discovery Probe and Configuring the Discovery
Range

This section describes how to add a Discovery Probe and the range of the IP
addresses to be discovered.

To add a new Discovery Probe and configure the discovery range:
Select Admin > CMDB and click the Discovery Manager tab.
Click the Probe Manager tab.
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In the Discovery Probes pane, the Probe Identifier that is defined on the
Discovery Probe Configuration page of the Discovery Probe wizard appears
as the default Discovery Probe. (For details, see “Discovery Probe Installation
Procedure” on page 10.)

Module Manager Probe Manager I

Dizcovery Probes

J Probes
IJ:'I—@ hdercury
¥ JBOSS Protocal

¥ NTCMD Protocal

¥ SAP JMX Protocal
¥ SAP Protocal

_D,-EI Siehel Gateway Protog
¥ SNMP Protocal

¥ S@L Protocal

¥ S3H Protocal

_D,-EI Telnet Protocol
_D,-EI Wehlogic Protocol
—I Wehszphere Protocol

T Wl Protocal

In the Discovery Probes pane, right-click the Probes folder or any empty
space and select Add probe to open the Add New Probe dialog box.

In the Name box, type the new probe name.
In the Description box, type the probe description. This step is optional.
Click OK to add the new probe to the Discovery Probes list.

In the Ranges pane, click the Add IP range button to open the Add IP Range
dialog box.

x

——
oK I Cancel |

|Java Applet Windaw

Enter an IP address range (for details, see “Rules for Defining an IP Address
Range” on page 39).
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10 Click OK. The range of net addresses you defined appears in the Ranges
pane.

11 To enter another IP address range, click the Add IP range button again and
repeat steps 9 and 10.

12 Click Apply to save the changes you have made.

Deleting a Discovery Probe
This section describes how to delete a Discovery Probe.
To delete a Discovery Probe:

1 From the Discovery Probes box, right-click the probe you want to delete and
click Remove probe. A message appears asking you if you want to remove
the Discovery Probe.

2 Click Yes to delete the probe.

Editing the Probe Description
This section describes how to edit the description of an existing probe.
To edit a probe’s description:

1 From the Discovery Probes pane, select the Discovery Probe whose
description you want to edit.

2 In the Description box in the Probe Details pane, make the required
changes.

Deleting an IP Range

This section describes how to delete an IP range.

To delete an IP range:

In the Ranges box, select the IP range you want to delete and click the
(=] Remove IP range button.
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Editing an Existing IP Range

This section describes how to edit an existing IP range:

To edit an existing IP range:

1 In the Ranges box, select the IP range you want to edit.
2 Click the Edit IP range button to open the Edit IP Range dialog box.

3 Make the required changes (for details, see “Adding a Discovery Probe and

Configuring the Discovery Range” on page 36).

Click OK to save the changes you have made.

Rules for Defining an IP Address Range

The rules for defining an IP address range are as follows:

The IP address range must have the following format:
start_ip_address — end_ip_address
For example: 10.0.64.0 - 10.0.64.57

The range can include a wildcard character (*) so that Mercury Business
Availability Center can match the range to more than one IP address.
Mercury Business Availability Center scans the system to find the IP
addresses matching the range pattern you defined.

> An asterisk (*) represents any number in the range of 0-255.

» You can use a wildcard character (*) in the lower bound IP address of the IP

range pattern only.

For example:

Valid Not Valid

10.0.64.* - 10.0.64.10 10.0.64.10 - 10.0.64.*

If you do use an asterisk (*), you do not need to enter a second IP address.
For example, you can enter the range pattern 10.0.48.* to cover the range
from 10.0.48.0 to 10.0.48.255.
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> You can use more than one asterisk (*) in an IP address as long as they are

used consecutively. The asterisk(s) cannot be situated between two numbers
in the IP address, nor can it substitute the first digit in the number.

For example:

Valid Not Valid
10.0.64.* *0..60.10
10.0.*.* 10.*.64.*
10.*.*.* 10.*.*.1
10.*.7.1

If you use an asterisk (*) in the lower bound IP address and also enter an
upper bound IP address, the upper bound IP address is ignored. For example,
if you enter the pattern 10.0.*.* - 10.0.20.30, the upper bound IP address is
ignored. Since the asterisks (*) in the lower bound IP address cover a range
wider than 20 and 30, 20 and 30 in the upper bound IP address are rendered
irrelevant.

Configuring the Connection Data for a Protocol

40
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You can add the connection data for each protocol included in the discovery
process. The connection data can refer to a specific net address and/or to the
entire net addresses range. When referring to the entire range, the net
address value is DEFAULT. The default definitions relate to all IPs included in
the defined range.

For a description of the connection data that needs to be defined for each
protocol, see “Protocol Definitions” on page 92.

This section contains the following topics:
“Defining the Connection Data For the Protocol” on page 41
“Deleting the Connection Details for an Existing Protocol” on page 42

“Editing the Connection Details for an Existing Protocol” on page 42

“Sorting and Customizing the Protocol Entry Columns” on page 42
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Defining the Connection Data For the Protocol

This section describes how to define the connection data for each protocol
included in the discovery process.

To define the connection data for the required protocol:
Select Admin > CMDB and click the Discovery Manager tab.
Click the Probe Manager tab.

In the Discovery Probes pane, click the Expand button of the probe to which
you want to add an instance of a protocol. A list of protocols is displayed.

Select the protocol whose connection data you want to define.

Click the Add new connection details for selected protocol type button to
the right of the Protocol Entries area to add definitions to the protocol you
have selected. The Add Protocol Parameter dialog box displays the list of
attributes you need to define for the protocol.

Define the protocol parameters as required and then click OK. For
information on protocol definitions, see “Protocol Definitions” on page 92.
The parameter values you defined appear in the Protocol entries section.

Click Apply to save the changes you have made.

If your Discovery Probe definitions are incorrect or incomplete, you get a
message specifying what the problem is, as seen in the following example:

Discovery Definitions Problem: x|

T'f Probe Mews Probe does nok hold any ranges
L3

Return to edit?

Java Applet wWindow

Click:
> Yes to open the tab in which the issue has to be resolved.

> No to save the changes and close the Discovery Manager.
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Note: If the Discovery Probe appears red, it indicates that not all the
required protocols for the discovery pattern have been added as described in
“Defining the Connection Data For the Protocol” on page 41.

Click the Apply button at the bottom of the screen to save the changes.

Deleting the Connection Details for an Existing Protocol

You can delete the connection details for an existing protocol.

To delete the connection details for an existing protocol:

In the Probe Manager tab, select the entry that you want to delete in the
Protocol entries section, and click the Remove selected connection details
for selected protocol type button.

Click the Apply button at the bottom of the screen to save the changes.

Editing the Connection Details for an Existing Protocol
You can edit the connection details for an existing protocol.
To edit the connection details for an existing protocol:

In the Probe Manager tab, select the entry that you want to edit in the
Protocol entries area.

Click the Edit selected connection details for selected protocol type button.

3 Edit the details as required in the Edit Protocol Parameter dialog box that

opens. For details, see “Protocol Definitions” on page 92.

Click the Apply button at the bottom of the screen to save the changes.

Sorting and Customizing the Protocol Entry Columns

For information on how to sort and customize the Protocol Entry table, see
“Sorting and Customizing Tables” on page 34.
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Using Advanced Options in the Details View Pane

You can view and edit the discovery patterns included in the modules.

Note: Only administrators with an expert knowledge of the discovery
process should be allowed to delete discovery modules.

The following table describes the icons in the Discovery Modules pane.

Icon What it Represents
A module
v
= A pattern

» When you select a pattern in the Discovery Modules pane, the Details View
tab is divided as follows:

Field

Description

Discovery Pattern

The name of the selected discovery pattern and the package

Name in which it is found.
Description A description of the selected pattern.
Trigger TQLs Define one or more TQL queries to be used as triggers to

activate the selected discovery pattern.
It contains the following fields:

» TQL Name. The name of the trigger TQL query that
activates the discovery pattern. For details on TQL
queries, see “Mercury Business Availability Center
Topology Query System” in View Manager Administration.

» Probe Limit. The probes you want to use for the
discovery process.

For details, see “Defining a Trigger TQL Query” on page 47.

43



Chapter 4 » Running the Discovery Process

44

Field

Description

Triggered Cls

Display the CIs used by the discovery pattern for its
discovery. For more information, see “Manually Activating
a Discovery Pattern Using Specific CIs” on page 49.

Statistics

Display statistics on discovery results for the selected

pattern.

» CIT. The name of the CIT discovered by the discovery
pattern

» Created. The number of CIT instances created by the
discovery pattern

» Updated. The number of CIT instances updated by the
discovery pattern

» Deleted. The number of CIT instances deleted by the
discovery pattern

Note: The last row of the Statistics table, the Total row,
contains the total number of CIs in each column.

» When you select the Discovery Modules root in the Discovery Modules pane
(as in the picture below):

hacule Manadger | Probe Maraoer I

Dizcovery Modules

. Discovery Modules

i) Application - Siekel

i Application - Oracle E-Business Suite
i) Application - SAP (R
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The Details View pane is divided as follows:

Field Description

Configuration files Contains configuration files with default parameter
values that are used for the discovery process. For
details, see “Discovery Process Configuration Files”
on page 59.

Statistics Displays statistics on discovery results for all the
discovery modules.

It contains the following fields:

» CIT. The name of the discovered CIT.

» Created. The number of CIT instances created.

» Updated. The number of CIT instances that were
updated.

» Deleted. The number of CIT instances deleted.

Note: The last row of the Statistics table, the Total

row, contains the total number of CIs in each

column.

This section contains the following topics:

“Selecting a Pattern” on page 46

“Defining a Trigger TQL Query” on page 47

“Selecting the Probe(s) to Be Used in the Discovery Process” on page 48
“Manually Activating a Discovery Pattern Using Specific CIs” on page 49
“Filtering the Triggered Cls Table” on page 53

“Updating the Triggered Cls Table” on page 54

“Redispatching a Triggered CI to Manually Activate the Discovery Pattern
Again” on page 55

“Removing the Error Status of a Triggered CI” on page 55
“Showing Error Details” on page 56

“Sorting and Customizing the Triggered CI Table” on page 56
“Maximizing and Restoring the Triggered CI Table” on page 56
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“Updating the Statistics Table for the Selected Discovery Pattern” on page 56
“Resetting the Statistics Table for the Selected Discovery Pattern” on page 57
“Sorting and Customizing the Statistic Table” on page 57

“Maximizing and Restoring the Statistic Table” on page 57

“Showing CI Instances” on page 57

“Creating a Discovery Pattern” on page 58

“Deleting a Discovery Pattern from a Module” on page 58

Y Y Y Y Y Y Y Y

“About Problem Indicators” on page 58

Selecting a Pattern

This section describes how to select a pattern in a module.

To select a pattern in a module:

+ In the Discovery Modules pane, click the Expand button to the left of the
required module to display the patterns contained in that module.
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Defining a Trigger TQL Query

You can define one or more TQL queries to be used as triggers to activate the
selected discovery pattern.

To define a trigger TQL query:
1 Select the required discovery pattern.
[m] 2 Inthe Trigger TQLs pane, click the Add TQL button to open the Choose
Discovery TQL dialog box.

/3 Choose Discovery TOL (that outputs ip) x|

~TOL Preview

ip_on_mainframe_without_|par

o4 | Zancel |

|Java Applet Windaw

The dialog box contains a list of discovery TQLs that match the discovery
pattern’s input CITs.

3 Select the TQL you want to serve as the trigger that invokes the discovery
pattern’s task, and click OK. The TQL query you selected appears in the
Trigger TQLs pane.

Note: If necessary, you can create discovery TQLs from which to choose. For
details, see “Defining Discovery TQL Queries” on page 64.
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4 To remove a TQL query from the list, select the TQL you want to remove

and click the Delete TQL button.

Note: If a TQL query is removed for an active discovery pattern, the
Discovery Manager no longer receives new Cls coming from that TQL query.
Existing triggered Cls that originally came from the TQL query are not
removed.

To add another TQL query, click the New TQL button again and repeat
step 3.

Selecting the Probe(s) to Be Used in the Discovery Process

This section describes how to define the probe(s) to be used in the discovery
process.

To select the probe(s) to be used in the discovery process:

From the Trigger TQLs pane, click the button to the right of the Probe Limit
field to open the Edit probe limitation for TQL output dialog box.

/3 Edit Probe limitation for TOL output x|

[~ all Discavery Probes

~Mon selected probes: —————————————— —Selected probes:
defaultProbe

Ck Cancel

|Java Applet Window
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This screen displays a list of the Discovery Probes defined in the Probe
Manager tab. For details, see “Adding a Discovery Probe and Configuring the
Discovery Range” on page 36.

To activate all the probes, select the All Discovery Probes check box and
click OK.

To activate a specific probe, do the following:
» Clear the All Discovery Probes check box.

> Select the required probes using the Add and Remove buttons to move
them between the Non selected probes and Selected probes lists. You
can also move multiple probes by making multiple selections.

Click OK to save the changes you have made.

Manually Activating a Discovery Pattern Using Specific Cls

Each discovery pattern contains the ClIs that the pattern uses for the
discovery process. After you have activated a discovery pattern, the CIs that
are currently being used by the discovery pattern are displayed in the
Triggered ClIs pane.

When you can define one or more TQL queries to be used as triggers to
activate the selected discovery pattern (for details, see “Defining a Trigger
TQL Query” on page 47), the trigger TQL automatically triggers CIs that
invoke the discovery pattern. You can choose to manually activate the
discovery pattern so that it runs using only ClIs that appear in the Triggered
ClIs pane instead of all the Cls triggered by the TQL. (For information on
TQL queries, see Mercury Business Availability Center Topology Query
System in View Manager Administration.)
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The Triggered Cls pane has the following fields:

» Cl. The triggered CI’s label.
» Status. The current status of the triggered CI.
Its status can be one of the following:

» Waiting for Probe. The triggered CI is ready to be dispatched and is
waiting for the Discovery Probe to retrieve it.

» Active. The triggered CI is active and is running on the Discovery Probe.

» Discovery Errors. Due to an error, the Mercury Business Availability
Center server has failed to dispatch the discovery task.

Following are the discovery error statuses:

» Server Processing Failure. The server failed to add the CI to the list of
triggered Cls.

> Active (Having error). An error occurred while running the discovery
process (the discovery process continues running).

> Probe Fatal Error. An error occurred while running the discovery
process and the discovery pattern is no longer using this specific
triggered CI for the discovery process.

» Active (being removed). The triggered CI is being removed from the
Triggered ClIs list.

» Probe. The discovery probe to which the triggered CI belongs.

» Page. The list of CIs are divided into pages. The number in the Page box
indicates which page is currently being displayed.

» To view other pages, use the up and down arrows, or type the page
number, and click Enter.

» To determine the number of ClIs that appear on a page, right-click either
the up or down button and select the required number. The default is 25.

50



Chapter 4 » Running the Discovery Process

To manually activate the discovery pattern using specific Cls:

[m] 1 Inthe Triggered Cls pane, click the Add ClI button to open the Choose CIs to

add dialog box.
; Choose Cls to add E2
—=earch Cls
Biy Discovery TGL: |4l ip Cls Host =]

Shaovwy only Cls containing: I Search |

~Search Results

ar | | Retated Host | Related IPs |
IﬁD host |impulse |impu|se | |

Page I 13: of 1 1 -1 out of 1

Add | Cloze |

|Java Applet window

Note: The Add Cl button is only enabled if the pattern is active. To activate
the pattern, see “Activating a Discovery Pattern” on page 82.
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The Choose Cls to add dialog box is divided as follows:

Field Description

Search Cls Contains two filters with which you can limit the
number of CIs that appear in the Search Results
pane.

» By Discovery TQL
» Show only Cls containing
For details on how to use the filters, see step 3.

Search Results Displays the list of triggered CIs from which you
can choose. It has the following fields:

» CIT. The CI type of the selected triggered CI
» Cl. The label of the triggered CI

» Related Host. The label for the host related to the
triggered CI

> Related IPs. The IPs of the related host

2 The list of Cls are divided into pages. The number in the Page box indicates
which page is currently being displayed.

» To view other pages, use the up and down arrows, or type the page
number, and press Enter.

» To determine the number of CIs that appear on a page, right-click either
the up or down button and select the required number. The default is 25.

3 To limit the number of triggered Cls that are displayed in the Search Results
list, use the following filters:

> (Required) In the By Discovery TQL box, choose one of the following:

> All Cis of the CI Type. Display all CI instances of the CI type used by
the discovery pattern.

» TQL. Display only CI instances that are triggered by this TQL.
> In the Show only Cis containing box, enter the text defining what you

want to appear in the list. Only the triggered CIs that contain the text in
the Show only Cls containing box are displayed. This step is optional.

4 Click Search to display only the CIs that match the filter criteria.
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5 Select the required CI or CIs. You can make multiple selections.

Click Add. The discovery pattern runs using only the Cls that appear in the
Triggered ClIs pane.

To remove a triggered CI from the list of triggered CIs on which the
discovery pattern runs, select the source CI you want to remove from the
Triggered Cls pane and click the Remove Cl button. The discovery pattern
no longer runs using the Triggered CI you deleted from the Triggered Cls
pane.

Filtering the Triggered Cls Table

You can limit the number of CIs that appear in the Triggered Cls pane.

To limit the number of Cls that appear in the Triggered Cls pane:

1 Click the Filter Cls button.

Use one of the following filters:

Filter Description

By Status Display a list of triggered Cls according to status.
Following are the options:

» All. Display all the triggered ClIs.

» Waiting for Probe. The triggered CI is ready to be
dispatched and is waiting for the Discovery Probe
to retrieve it.

» Active. The triggered ClI is active and is running
on the Discovery Probe.

» Active (being removed). The triggered CI is being
removed from the Triggered Cls list.

» Discovery Errors. Due to an error, the Mercury
Business Availability Center server has failed to
dispatch the discovery task. For more
information on CI statuses, see “Manually
Activating a Discovery Pattern Using Specific
CIs” on page 49.

By Probe Display only the ClIs triggered by a selected probe.
For details, see “Selecting the Probe(s) to Be Used in
the Discovery Process”.
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Filter Description

By Dispatch Type Display a list of CIs according to one of the
following options:

» All. CIs that were used both to manually activate
the discovery pattern as well as the CIs from the
Discovery TQL(s) that were used to activate the
discovery pattern.

» Manually added. Only the CIs that were used to
manually activate the discovery pattern. For
details, see “Manually Activating a Discovery
Pattern Using Specific CIs”.

» By Discovery TQL. All the CIs from the Discovery
TQL(s) used to activate the discovery pattern. For
details, see “Defining a Trigger TQL Query”.

By Selected TQL Display a list of only the triggered ClIs that match
the output of the selected TQL.

Note: If none of the selected CIs in the Triggered Cls
pane match the output of the selected TQL, the
Triggered ClIs pane is empty.

For details, see “Defining a Trigger TQL Query”.

Updating the Triggered Cls Table

After you have activated a discovery pattern, the Cls that are currently being
used by the discovery pattern are displayed in the Triggered Cls pane. The
discovery results are not updated automatically.

To update the list of triggered Cls currently being used by the discovery
pattern:

£ Click the Refresh button on the left side of the Triggered ClIs pane.
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Redispatching a Triggered Cl to Manually Activate the
Discovery Pattern Again

You can choose to manually activate a discovery pattern again by
redispatching one or more selected triggered Cls. The discovery pattern runs
using only the redispatched Cls.

To redispatch a triggered Cl:

1 Select one or more required Cls in the Triggered ClIs table.

Right-click and select Redispatch. The discovery pattern runs again using
the triggered ClIs you selected.

Removing the Error Status of a Triggered Cl

You can remove the error status of one or more triggered ClIs in the Triggered
CIs pane.

To remove the error status of one or more triggered Cls:

In the Triggered CI pane, select the triggered CI(s) whose error status you
want to remove. You can use multiple selections.

Right-click or click the Handle errors button and select Acknowledge error.
The status of the selected CI(s) changes to Active.

Note: To acknowledge the errors of all the Cls in the Triggered CIs pane,
select all the Cls, right-click and select Acknowledge error or click the
Handle errors button and select Acknowledge all Cls. The status of the
selected CIs changes to Active.
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Showing Error Details

Mercury Business Availability Center allows you to view the details of the
errors that appear for the triggered Cls.

To view the details of the triggered Cl:

1 In the Triggered CI pane, select the required trigger CI.

Click the Handle errors button.

3 Select Show Error Details to open the Error dialog box.

Note: You can also double-click the required trigger CI to open the Error
dialog box.

Sorting and Customizing the Triggered Cl Table

For information on how to sort and customize the Triggered CI table, see
“Sorting and Customizing Tables” on page 34.

Maximizing and Restoring the Triggered Cl Table

For information of how to maximize and then restore the Triggered CI table
to its previous size, see “Maximizing and Restoring the Statistics Table” on
page 3S.

Updating the Statistics Table for the Selected Discovery
Pattern

The discovery pattern results in the Statistics table are not automatically
updated.

To update the Statistics table:
Click the Refresh Statistics button to the left of the Statistics table.
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Resetting the Statistics Table for the Selected Discovery
Pattern

You can delete all the statistics from the Statistics table and restart the
counting from zero.

To reset the Statistics table:
Click the Reset Statistics button to the left of the Statistics table.

Sorting and Customizing the Statistic Table

For information on how to sort and customize the Statistics table, see
“Sorting and Customizing Tables” on page 34.

Maximizing and Restoring the Statistic Table

For information of how to maximize and then restore the Statistics table to
its previous size, see “Maximizing and Restoring the Statistics Table” on
page 35.

Showing Cl Instances

You can display all of the CI instances created by the discovery pattern in a
table.

To display all of the Cl instances created by the discovery pattern in a table:

Click the View Instances button to the left of the Statistics table to open the
ClIs discovered by pattern window.

The list of nodes are divided into pages. The number at the bottom of the
screen indicates which page is currently being displayed. For example, 2/4
means that it is the second out of four pages.

To view other pages, use the left and right arrows.

3 To determine the number of node instances that appear on a page, do the

following:
» Click the Set bulk size button to open the Set bulk size dialog box.

» Use the up and down arrows or type the number of node instances you
want to appear on a page and click OK.
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4 To update the table, click the Refresh button.

5 Click OK to save the settings you have defined.

Creating a Discovery Pattern

You can create a discovery pattern. The new discovery pattern you create is
based on an existing pattern.

To create a discovery pattern:

1 In the Discovery Modules pane, right-click the pattern on which you want
to base your new pattern and select Save as to open the Choose new name
for discovery pattern dialog box.

2 Enter a new name for the pattern.

3 Click OK to create the new pattern. The new pattern appears in the
Discovery Module pane.

4 To edit the pattern, right-click it and select Edit Pattern. For details on how
to edit the pattern, see “Editing a Pattern” on page 70.

Deleting a Discovery Pattern from a Module

This section describes how to delete a discovery pattern from a module.

To remove a discovery pattern from a module:

In the Discovery Modules pane, right-click the module you want to delete
and select Delete pattern.

About Problem Indicators

Problem Indicators appear to the left of a module in the Modules pane if one
or more of its discovery patterns are experiencing a problem that could
affect the discovery process, such as a protocol connection failure.

The Refresh All button at bottom of the Discovery Modules pane updates all
the data within the Discovery Manager dialog box, such as the list of
Discovery Probes, discovery patterns and protocol information.
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If the problem for which the Problem Indicators appears is due to a problem
that is resolved by clicking the Refresh All button, the Problem Indicator
disappears.

If clicking the Refresh All button does not solve the problem, click the
iy Handle errors icon in the Triggered Cls pane to view either a solution to the
problem or show details regarding the specific problem.

Discovery Process Configuration Files

Mercury Business Availability Center configuration files define default
parameter values that are used for the discovery process. For example, the
portNumberToPortName.xml file contains known port numbers, names and
types that are used for TCP discovery. You can view and edit existing
configuration files as well as create new ones. You can also define which text
editor you want to use to edit the configuration files.

This section contains the following topics:
>» “Viewing and Editing Configuration Files” on page 59
» “Creating Configuration Files” on page 61

> “Deleting Configuration Files” on page 62

Viewing and Editing Configuration Files
This section describes how to view and edit a configuration file.
To view and edit a configuration file:

1 Click the Module Manager tab.

2 In the Discovery Modules pane, select the Discovery Modules root.

hacule Manadger | Probe Maraoer I

Dizcovery Modules

= covery Modules

i Application - Oracle E-Business Suite
i) Application - SAP (R
i) Application - Siekel
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The Configuration Files pane is displayed.

3 Double-click the required configuration file or select it and click the Edit
Configuration File button to open the Script Editor.

4 Make the required changes.
5 To find specific text in the Script Editor, do the following:

Ky > In the top left corner of the Script Editor, click the find in text button to
open the Find dialog box.

> In the Text to Find section, type the text you want to find.

» In the Direction section, specify whether you want to do a forward or
backward search.

> In the Options section, select Case Sensitive if you want the matches to
be case sensitive.

» Click Find. If Mercury Business Availability Center finds a match, it
selects the matching text.

6 To find a line in the Script Editor, do the following:

e » In the top left corner of the Script Editor, click go to line to open the Go
to Line dialog box.

» Type the required line number and then click OK. The insertion point
appears to the left of the desired line.

7 Click OK to save the changes you have made.
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Creating Configuration Files

This section describes how to create a configuration file.

To create a configuration file:

1 Click the Module Manager tab.

In the Discovery Modules pane, select the Discovery Modules root.

todule Manager I Probe Manager I

Discovery Modules

very Modules
_’ Application - Oracle E-Business Suite
i) Application - SAP (R
i) Application - Siekel

The Configuration files pane is displayed.

Click the Create configuration file button to open the Choose new name for
configuration file dialog box.

Type a name for the new configuration file and click OK. The new
configuration file appears in the Configuration Files list with the
extension xml.

Double-click the configuration file to open it.

6 Type the required text.

7 Click OK to save your changes.
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Deleting Configuration Files

This section describes how to delete a configuration file.

Note: Only administrators with an expert knowledge of the discovery
process should be allowed to delete discovery modules.

To delete a configuration file:
1 Click the Module Manager tab.

2 In the Discovery Modules pane, select the Discovery Modules root.

todule Manager I Probe Manager I

Discovery Modules

..._ Dizcovery Modules

i) Application - Oracke E-Business Sute
B opplication - S&P (RiE)
i) application - Siekel

The Configuration Files pane is displayed.

3 Select the configuration file you want to delete and click the Delete
configuration file button.
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Understanding the Discovery TQL Manager

The Discovery TQL Manager allows you to define discovery TQL queries.
These queries extract the information from the CMDB that is relevant to
you. Once a discovery TQL query has been created, it persists in the system
memory and generates updated results automatically.

i Discovery TOL Manager
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The Discovery TQL Manager is divided as follows:

Editing Pane. Displays the currently selected TQL query, which consists of
nodes and the relationships between them. For more information about the
toolbar buttons, see “Toolbar Options” in Working with the CMDB.

Configuration Item Types. Represents the Configuration Item Type model
and contains icons for each CIT, as defined by the administrator (for details,
see “Assigning an Icon to a CIT” in CI Type Manager Administration). By
clicking and dragging CITs to the topology map and then defining the
relationship between them, you can define a query and save it to the
database. For example, you can drag the NT and IP CIT nodes to the
topology map and then define the connection between them by adding
relationships. For more information, see “Adding Nodes and Relationships
to Discovery TQL Queries” on page 66.

Information pane. Displays the attribute conditions you defined for the
selected node/relationship. For details, see “Setting TQL Node and
Relationship Definitions” on page 67.

Defining Discovery TQL Queries

64
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You use the Discovery TQL Manager to define a new discovery TQL query.
You select the nodes and relationships that are to be part of the query, and
then define specific attribute conditions for each node, including the
attributes of the relationships that define the connections between nodes.
You can also edit or delete an existing discovery TQL.

This section has the following topics:

“TQL Workflow” on page 65

“Creating a Discovery TQL Query” on page 65

“Adding Nodes and Relationships to Discovery TQL Queries” on page 66
“Setting TQL Node and Relationship Definitions” on page 67

“Creating a Dependency Graph” on page 68

“Deleting a Node or Relationship” on page 68

“Editing an Existing Discovery TQL” on page 68
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> “Deleting a TQL” on page 69

TQL Workflow

You create discovery TQL queries according to the following workflow:

» Create a new discovery TQL query. For details, see “Creating a Discovery
TQL Query” on page 65.

» Add nodes and relationships to the query. For details, see “Adding Nodes
and Relationships to Discovery TQL Queries” on page 66.

» Define node and relationship attribute conditions. For details, see “Setting
TQL Node and Relationship Definitions” on page 67.

» Create a graph that represents additional TQL query data related to a specific
CI. This step is optional. For details, see “Creating a Dependency Graph” on
page 68.

Creating a Discovery TQL Query
This section explains how to create a discovery TQL query.
To create a discovery TQL query:

1 In the Trigger TQLs pane, click the Open Discovery TQL Manager button to
open the Discovery TQL Manager.

2 Click the New TQL button to open the Input dialog box.

nput x|
@ hoose a name for the newly created TOL

[
Zancel |

Java Applet Window

3 Type a unique name for the new TQL query and click OK. The new TQL
name appears in the Choose discovery TQL to edit list.
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Adding Nodes and Relationships to Discovery TQL Queries

Once you have created the discovery TQL query, the next step is to add the
nodes and relationships that define the query. The nodes represent the CITs,
as defined in the CI Type Model, and the relationships represent the
connections between them. Relationships are defined one at a time for each
pair of nodes in the query.

For a list of the existing relationships and their definitions, see
“Relationship Definitions” in CI Type Manager Administration.

To add TQL nodes and relationships to a query:

From the Choose discovery TQL to edit list, select the TQL query to which
you want to add TQL nodes and relationships.

From the tree displayed in the Configuration Item Types pane, click and
drag one or more TQL nodes on to the topology map. These are the TQL
nodes that are included in the query.

3 Select two TQL nodes by holding down CTRL and clicking the TQL nodes.

Right-click and select Add Relationship to open the Add Relationship dialog
box.

For details on how to add a relationship, see “Defining TQL Nodes and
Relationships” in View Manager Administration.

Click OK. The selected nodes are linked by the relationship you have
selected.
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The direction of the relationship indicates which node is dependent on the
other. The following example displays two hosts, an IP server, and an IP
client that are linked to one another via a client/server connection.
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Setting TQL Node and Relationship Definitions

After you have added the TQL nodes and relationships required for your
query, you can define their specific attribute conditions.

» For details on how to define Discovery TQL nodes and relationships, see
“Defining TQL Nodes and Relationships” in the View Manager
Administration.

» For details on how to define attribute for nodes and relationships, see
“Defining Attribute Conditions for Nodes and Relationships” on page 117
in the View Manager Administration.

» For details on how to define relationship cardinality, see “Defining
Relationship Cardinality” in the View Manager Administration.

» For details on how to filter query results, see “Filtering Query Results in the
Attribute Condition Tab” in the View Manager Administration.
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Creating a Dependency Graph

You can create a graph that represents additional TQL query data related to a
specific CI. The discovery pattern searches for the results from TQL query as
well as the dependency graph definitions.

For details on how to define a dependency graph, see “Defining a
Dependency Graph” in View Manager Administration.

For details on how to delete a dependency graph, see “Deleting a
Dependency Definition” in View Manager Administration.

For details on how to edit a dependency graph, see “Editing a Dependency
Definition” in View Manager Administration.

Deleting a Node or Relationship

This section describes how to delete a node or relationship.

To delete a node or relationship:

In the Trigger TQLs pane, click the Open Discovery TQL Manager button to
open the Discovery TQL Manager dialog box.

In the editing pane, right-click the TQL node or relationship you want to
delete and select Delete.

Editing an Existing Discovery TQL
This section describes how to edit an existing TQL.
To edit an existing TQL:

In the Trigger TQLSs pane, click the Open Discovery TQL Manager button to
open the Discovery TQL Manager dialog box.

From the Choose Discovery TQL to edit list, choose the TQL you want to
edit.

Make the required changes.

Click OK to save the changes you have made.
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Deleting a TQL
This section describes how to delete a TQL.
To delete an existing TQL:

B 1 In the Trigger TQLs pane, click the Open Discovery TQL Manager button to
open the Discovery TQL Manager dialog box.

2 From the Choose Discovery TQL to edit list, choose the TQL you want to
delete.

3 Click the Delete TQL button.

Understanding the Pattern Editor
The Pattern Editor dialog box contains the following tabs and features:

> Design View tab. Enables you to define the following:
» The CITs that are discovered during the discovery process.

» The protocols that are required to perform the discovery process. For
details, see “Protocol Definitions” on page 92.

> Pattern Parameters tab. Enables you to design and edit a discovery pattern.
For details, see “Configuring a Discovery Pattern” on page 71.

» Source View Tab. Displays the discovery pattern in XML format, which can
be edited. For details, see “Editing the Discovery Pattern” on page 74.

» Advanced Settings. Allows you to define advanced settings for your
discovery pattern. For details, see “Defining Advanced Settings” on page 80.

» Pattern Validation Indicator. Indicates whether the discovery pattern is valid
or not. For details, see “Discovery Pattern Validation” on page 81.
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Editing a Pattern

70
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You can edit a pattern in the Module Manager tab by accessing the Pattern
Editor. The Pattern Editor allows you to either edit the pattern in XML
format in the Source View tab or in the Pattern Parameters tab.

This section contains the following topics:

> “Defining the Discovery Pattern” on page 70
» “Configuring a Discovery Pattern” on page 71

> “Editing the Discovery Pattern” on page 74

Defining the Discovery Pattern

You define a discovery pattern by specifying the CITs the pattern will
discover and the protocols needed to perform the discovery.

To define a discovery pattern:

Right-click the pattern you want to edit in the Module Manager tab and
click Edit Pattern, or click the Edit button in the top right corner of the
Discovery Pattern Summary pane to open the Pattern Editor.

Click the Design View tab.

3 In the Discovery Pattern Version box, enter the version of the discovery

pattern you are using. This step is optional.

4 In the Description box, type a description of the discovery pattern.

5 In the Trigger CIT box, select the CIT you want to use as the trigger that

activates the selected discovery pattern.
To define which CITs the pattern discovers, do the following:

» In the Discovered CITs box, click the Add discovered CIT button to
display the CITs in the CI Type Model pane.

> Select the CIT or CITs you want the pattern to discover.
» Click OK to save the changes you have made.

» To delete an existing CIT from the Discovered CITs box, select the CIT
you want to delete and click the Remove discovered CIT button.



Chapter 4 » Running the Discovery Process

7 To define which protocols the pattern requires for the discovery task, do the
following:

» In the Required Discovery Protocols box, click the Add required protocol
button to open the Add Required Protocol dialog box.

» From the Choose Protocol Type list, select the required protocol.
» Click OK to save the changes you have made.

» To delete an existing protocol from the Required Discovery Protocols
box, select the protocol you want to delete and click the Remove
required protocol button.

8 In the Discovery Scheduler section, you can schedule a discovery pattern to
run on a periodic basis. Select the Invoke on New Triggered Cls immediately
check box to run the discovery pattern as soon as the triggered CI reaches
the Discovery Probe.

For details on how to schedule a discovery pattern to run on a periodic basis,
see “Scheduling a Discovery Pattern to Run on a Periodic Basis” on page 75.

Configuring a Discovery Pattern
This section describes how to configure parameters for a discovery pattern.
To configure a discovery pattern:

1 Right-click the pattern you want to configure in the Module Manager tab
and click Edit Pattern, or click the Edit button in the top right corner of the
Discovery Pattern Summary pane.

2 Click the Pattern Parameters tab.
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3 In the Discovery Pattern Parameters section, define the following parameter

values:
» Parameter name. The name of the parameter.
» Value. The value you want to assign to the attribute.

» Description. Description of the parameter (optional).

Note: Each row represents the definitions for one parameter.

» To define another pattern parameter, click the Add Parameter button.
Another row of parameter attribute definitions appears. Configure the
parameters according to the list above.

» To delete a pattern parameter, select the parameter you want to delete
and click the Remove Parameter button.

In the Triggered Cl Data section, define the information that is needed to
perform a discovery task on a specific CI. That information is passed to the
CI queried in the discovery task.
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To configure the triggered CI, do the following:
» Define the triggered ClI's attributes according to the following table:

Attribute Description
Attribute name The name of the attribute.
Value The attribute value. Variables are written using the

following syntax:
${VARIABLE_NAME attributeName}

where <VARIABLE_NAME > can either be one of
three predefined variables:

» Source. Refers to the CI that functions as the
task’s trigger.
» Host. Host in which the triggered CI is contained.

» Parameters. This variable refers to the parameter
defined in the Parameter section as described
above.

or a variable that you have created.

For example:

${SOURCE.network_netaddr}

indicates that the triggered CI is a network.

Encrypted Select this check box if the field is defined as a
Password type in the CMDB.

» To define another attribute, click the Add Triggered ClI Data button, and
modify the attribute according to the table above.

» To delete an existing attribute, select the attribute you want to delete and
click the Remove Triggered Cl Data button.
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Editing the Discovery Pattern

The Source View tab displays the discovery pattern in XML format, which
can be edited.

To edit the discovery pattern in the Source View tab:

Right-click the pattern you want to edit in the Module Manager tab and
click Edit Pattern, or double-click the pattern to open the Pattern Editor.

Click the Source View tab.

3 Make the required changes.

To find specific text in the Script Editor, click the find in text button. For
details, see “Viewing and Editing Configuration Files” on page 59.

To find a line in the Script Editor, click the go to line button. For details, see
“Viewing and Editing Configuration Files” on page 59.

6 Click Save to save the changes you have made.

7 The Discovery Scripts pane at the bottom contains a list of Jython scripts

used by the discovery patterns. Jython is a Java implementation of the
Python language, allowing python code to access Java classes. The Jython
scripts that appear in bold are the scripts that the currently selected pattern
is using. To edit the Jython scripts, do the following:

» Select the Jython script you want to edit.
» Click the Edit Script button to open the Script Editor window.

» To find specific text, find a specific line, see “Viewing and Editing
Configuration Files” on page 59.

\

Edit the script as required.

» Click OK to save the changes you have made.
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Scheduling a Discovery Pattern to Run on a Periodic Basis

Y Y Y Y Y Y

This section explains how to set the schedule for activating a discovery
pattern. It has the following topics:

“Setting the Date for Starting and Stopping a Discovery Pattern” on page 75
“Running a Discovery Pattern on a Periodic Basis” on page 76

“Running a Discovery Pattern at Set Time Intervals” on page 77

“Running a Discovery Pattern on a Daily Basis” on page 77

“Running a Discovery Pattern on a Weekly Basis” on page 78

“Running a Discovery Pattern on a Monthly Basis” on page 78

Setting the Date for Starting and Stopping a Discovery
Pattern

This section describes how to set the date for starting and stopping a
discovery pattern.

To set the date for starting and stopping a discovery pattern:

In the Module Manager tab, right-click the pattern or patterns you want to
run on a periodic basis and click Edit Pattern, or click the Edit button in the
top right corner of the Discovery Pattern Summary pane to open the Pattern
Editor.

Note: You can set the date for more than one pattern at a time by holding
the CTRL key down to make multiple time selections.

Click the Design View tab.

3 In the Discovery Scheduler section, click Edit Scheduler to open the

Schedule dialog box.

To set the date for activating the discovery pattern, click the down button in
the Start on box to display a calendar.
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5

Use the diagonal arrow buttons to choose the month and year, and then
click the required day.

6 Click anywhere outside the calendar to close it.

7 To delete the date you entered in the Start on box, click Reset.

Running a Discovery Pattern on a Periodic Basis

This section describes how to run a discovery pattern on a periodic basis.

To run a discovery pattern on a periodic basis:

Right-click the pattern you want to run on a periodic basis in the Module
Manager tab and click Edit Pattern, or click the Edit button in the top right
corner of the Discovery Pattern Summary pane to open the Pattern Editor.

Click the Design View tab.

3 In the Discovery Scheduler section, click Edit Scheduler to open the

Schedule dialog box.
Select one of the following options:

> Interval. Activates the discovery pattern at a predefined time interval. For
details, see “Running a Discovery Pattern at Set Time Intervals” on
page 77.

> Daily. Activates the discovery pattern on a daily basis. For details, see
“Running a Discovery Pattern on a Daily Basis” on page 77.

> Weekly. Activates the discovery pattern on a weekly basis. For details, see
see “Running a Discovery Pattern on a Weekly Basis” on page 78.

» Monthly. Activates the discovery pattern on a monthly basis. For details,
see “Running a Discovery Pattern on a Monthly Basis” on page 78.

Click OK to save the settings you have defined. The discovery schedule you
have defined appears in the Discovery Scheduler section.
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Running a Discovery Pattern at Set Time Intervals

This section describes how to run a discovery pattern at a predefined time
interval.

To run a discovery pattern at a predefined time interval:

Select Interval in the Discovery Scheduler dialog box (see step 4 in “Running
a Discovery Pattern on a Periodic Basis” on page 76), and then select the
date on which you want to activate the pattern. For details, see “Setting the
Date for Starting and Stopping a Discovery Pattern” on page 75.

In the Repeat Every boxes, do the following:
» Type or select a value for the interval between successive runs.

» Choose the required unit of time measurement (seconds, minutes,
hours).

Choose the time and date for the task to end (for details, see “Setting the
Date for Starting and Stopping a Discovery Pattern” on page 75).

Click OK to save the settings you have defined.

Running a Discovery Pattern on a Daily Basis

This section describes how to run a discovery pattern on a daily basis.

To run a discovery pattern on a daily basis:

Select Daily in the Discovery Scheduler dialog box (see step 4 in “Running a
Discovery Pattern on a Periodic Basis” on page 76), and then select the date
on which you want to activate the pattern. For details, see “Setting the Date
for Starting and Stopping a Discovery Pattern” on page 75.

From the Every day at hour list, select the required time or times.

Note: Hold the CTRL key down to make multiple time selections.

In the Discovery Time Limitations section, choose the date and time you
want the task to stop running. For details, see “Setting the Date for Starting
and Stopping a Discovery Pattern” on page 75.
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4 Click OK to save the settings you have defined.

Running a Discovery Pattern on a Weekly Basis

This section describes how to run a discovery pattern on a weekly basis.

To run a discovery pattern on a weekly basis:

Select Weekly in the Discovery Scheduler dialog box (see step 4 in “Running
a Discovery Pattern on a Periodic Basis” on page 76), and then select the
date on which you want to activate the pattern. For details, see “Setting the
Date for Starting and Stopping a Discovery Pattern” on page 75.

From the Start hour list, select the hour or hours at which you want the task
to run.

Note: You can hold the CTRL key down to make multiple time selections.

In the Days of week section, select the day or days of the week on which you
want the task to run.

In the Discovery Time Limitations section, choose the date and time you
want the task to stop running. For details, see “Setting the Date for Starting
and Stopping a Discovery Pattern” on page 75.

Click OK to save the settings you have defined.

Running a Discovery Pattern on a Monthly Basis

This section describes how to run a discovery pattern on a monthly basis.

To run a discovery pattern on a monthly basis:

Select Monthly in the Discovery Scheduler dialog box (see step 4 in
“Running a Discovery Pattern on a Periodic Basis” on page 76), and then
select the date on which you want to activate the pattern. For details, see
“Setting the Date for Starting and Stopping a Discovery Pattern” on page 75.

From the Start hour list, select the hour or hours at which you want the task
to run.
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Note: You can hold the CTRL key down to make multiple time selections.

In the Days of month box, click the Add the required day of the month
button to specify the day or days of the month on which you want the
pattern to run. The Add Required Day dialog box opens.

From the Choose a day list, select required day in the month and click OK.
The day you selected appears in the Days of the month box. You can repeat
this step to select as many days as you want.

To delete a day from the Days of month box, select the required day and
click the Delete the required day of the month button.

In the Discovery Time Limitations section, choose the date and time you
want the task to stop running. For details, see “Setting the Date for Starting
and Stopping a Discovery Pattern” on page 75.

7 Click OK to save the settings you have defined.

8 To choose when you want the discovery pattern to stop, do one of the

following:
» If you do not want to specify an ending date, select No time limitations.

» To set the pattern to stop after it has been activated a specific number of
times, select End after and then enter or choose the required number
from the recurrences list (maximum is 1000).

» To choose the date and time for when you want the discovery task to
stop, select End by, and do the following:

» Click the down button to display a calendar.

» In the Date and Time tabs, use the diagonal arrow buttons to choose
the date and time.

» Click anywhere outside the calendar to close it.
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Defining Advanced Settings

80

You can define advanced settings for your discovery pattern.

To define advanced settings for the discovery pattern:

In the Discovery Modules pane, right-click the required pattern and select
Edit Pattern to open the Pattern Editor.

2 Click the Design View tab.
3 Click Advanced Settings to open the Advanced Settings dialog box.

In the Task Management section, do the following:

» Select Merge if you want a task to include several Triggered Cls rather
than only one triggered CI per task. The default is selected.

» Select Enforce Dispatch if you want to invoke a task for CIs whose
Discovery Probe is not included in the discovery scope you define in the
Probe Manager tab (see “Adding a Discovery Probe” on page 36). The
default is not selected.

» If a CI that acted as a trigger for a discovery pattern was deleted from the
database, select Deletable if you want the discovery task it activated to be
deleted as well. The default is not selected.

By default, the Discovery Manager chooses the Discovery Probe for the
triggered CI automatically according to the CI's related host. After obtaining
the CI's related host, the system chooses one of the host's IPs and chooses
the Discovery Probe according to the probe’s network scope definitions (see
“Adding a Discovery Probe” on page 36).

This might fail in the following situations:
> A triggered CI does not have a related host (such as the network CIT).

> A triggered CI's host has multiple IPs, each belonging to different
Discovery Probe.

To resolve these issues, you can specify which Discovery Probe to use with
the discovery pattern by doing the following:

> In the Probe Selection section, select Override default probe selection.

» In the Probe box, enter the Discovery Probe you want to use for the
discovery task.
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6 In the Result Grouping section:

» Select Group Results if you want to group discovery results in the
Discovery Probe before being sent to the Mercury Business Availability
Center server.

> In the Grouping Interval (Seconds) box, type the value that indicates
how long discovery results are stored in the Discovery Probe before
being transferred to the Mercury Business Availability Center server.

> In the Group Max ClIs box, specify the number of CIs that should
accumulate in the Discovery Probe before being transferred to the
Mercury Business Availability Center server.

Note: If you entered a value in both fields, Mercury Business
Availability Center applies whichever occurs first.

» If you do not select Group Results, all discovery results are immediately
sent to the Mercury Business Availability Center server.

» Click OK to save the changes you have made.

Discovery Pattern Validation

The Discovery Pattern Indicator indicates whether the selected discovery
pattern is valid or not. It can be either green or red.

Design Yiew I Pattern Parameters | Source Yiew | T
i

Nscovery Fatiern
Indicator

» Green indicates that the pattern is valid.

> Red indicates that the pattern is not valid. To display a description of the
problem, move the pointer over the Discovery Pattern Indicator.
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Activating a Discovery Pattern

K\

You can choose to activate either all the discovery patterns in a discovery
module or some of them.

To activate discovery patterns in a module:

1 Select Admin > CMDB and select the Discovery Manager tab.

In the Discovery Modules area, click the Expand button of the module
whose discovery pattern you want to activate.

Right-click the module you want to activate and click the Activate button,
or select the required module and click the Activate button in the bottom
right corner of the Discovery Modules pane.

A pattern that is activated, as seen here, is marked with a green dot.

Note: If only some of the module’s patterns are activated, the module is
marked with a single, green dot. If all patterns of the module are activated,
the module is marked with three green dots.

Deactivating a Discovery Pattern
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This section describes how to deactivate a discovery pattern that is being
used in the discovery process.

To deactivate a discovery pattern that is being used in the discovery
process:

1 Select Admin > CMDB and click the Discovery Manager tab.

Click the Expand button of the module whose discovery pattern you want
to deactivate.

In the Discovery Modules area, right-click the pattern you want to
deactivate and click the Deactivate button, or select the required pattern
and click the Deactivate button in the bottom right corner of the Discovery
Modules pane.
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Understanding the Discovery Manager Map View Tab

The Mercury Business Availability Center discovery process is run by
activating discovery patterns.

Each pattern contains a description of the CITs and relationships that are
created with each discovery pattern. The definitions of the CITs and
relationships are taken from the CI Type Manager (for details, see CI Type
Manager Administration which contains the definitions of all CITs and
relationships). When the discovery module is activated, it discovers CITs
and relationships of the types that are described in each pattern, and places
them in the CMDB.

The discovered Cls act as triggers that activate another discovery pattern.
Every time a discovery pattern is activated, it discovers more Cls, which in
turn are used as triggers for other discovery patterns.

The Map View tab displays a visual representation of the real-time progress
of the discovery process. It displays which CIs triggered which discovery
pattern (trigger or input Cls), as well as which CIs that were discovered as a
result of the activated discovery pattern (triggered or output ClIs).

The Map View tab also displays other information, such as how many
instances of a specific CI are contained in the CMDB and how many
instances were created by a specific discovery pattern.
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To display the Map View:
Click the Module Manager tab and then click the Map View tab.

Details view Map View | Schedule view |
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Map View displays the real-time progress of a discovery pattern. Selecting a
discovery pattern, either in the Discovery Modules pane or the Map View,
simultaneously selects that pattern in both places.

This section includes the following topics:

“Using the Map View Tab Toolbar” on page 85

“Displaying Data in the Discovery Map View” on page 85
“Understanding Items in the Discovery Map View” on page 87

“Understanding Statistics in the Map View” on page 88

Y Y Y Y Y

“Understanding Map View Tooltips” on page 90
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» “Using the Toolbar Options” on page 90

» “Printing the Contents of the Map View Tab” on page 90

» “Understanding Layout Options” on page 90

Using the Map View Tab Toolbar

For a description of the toolbar options in the Map View tab, see “Toolbar
Options” in Working with the CMDB.

Displaying Data in the Discovery Map View

The Discovery Map View displays data according to the selection in the

Discovery Modules pane.

» When you select a module in the Discovery Modules pane, the map view
displays the module’s active and inactive patterns, as displayed by the

following illustration:

Module Manager | Probe Managerl
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» When you select the Discovery Modules root at the top of the Modules
pane, and select the Show only active discovery patterns check box at the
bottom, the map view displays only the active discovery patterns from the

modules and the input/output CITs, as seen in the illustration below:
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Note: If there are no active patterns, the Map View tab is empty.
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When you select the Discovery Modules root at the top of the Modules
pane, and clear the Show only active discovery patterns check box at the
bottom, the map view displays all discovery patterns from the modules and
their interdependencies, as seen in the illustration below:
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Understanding Items in the Discovery Map View

The following table describes the items in the Map View and what they
represent:

Item Description

m An inactive pattern.

An active pattern.
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Note: You can edit a discovery pattern by double-clicking it to open the
Pattern Editor. For details, see “Understanding the Pattern Editor” on
page 69.

Understanding Statistics in the Map View

The Map View tab displays the following statistics on discovery results for
the selected pattern:

The number of instances of a specific CI in the CMDB.

Note: You can also find the same statistical number in the Created column
in the Statistics table in the Details View pane. For details, see “Using
Advanced Options in the Details View Pane” on page 43.

» The number of CI instances that were created by a specific pattern.

» The number of triggered Cls currently being used by a discovery pattern to

run the discovery pattern.

Note: You can also find the same statistical number at the bottom right
corner of the Triggered CI pane. For example 25 out of 90 means that 90
triggered Cls are being used for the discovery pattern.
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The following example displays the following statistics:
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The discovery pattern SNMP_NET_Dis_Connection created 37 instances of IP
Cls.

The discovery pattern SNMP_NET_Dis_Connection created 3 instances of
Network ClIs.

There are 10 instances of Network CIs in the CMDB.
There are 170 instances of IP CIs in the CMDB.

The discovery pattern ICMP_NET_Dis_IpC is using 3 triggered CI to run the
discovery pattern.

The discovery pattern SNMP_NET_Dis_Connection is using 1 triggered CI to
run the discovery pattern.

Note: To update the statistics in the Map View, click the Refresh button (for
details, see “Using the Map View Tab Toolbar” on page 85).
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Understanding Map View Tooltips

When the pointer is moved over either a CI or discovery pattern, a tooltip
displays the description.

Using the Toolbar Options

For a description of each toolbar option in the Map View tab, see “Toolbar
Options” in Working with the CMDB.

Printing the Contents of the Map View Tab

You can print the contents of the Map View tab. The result is similar to a
screen capture. Therefore, it is recommended to arrange the contents of the
map view according to your requirements before printing. For details, see
“Printing the Topology Map” in Working with the CMDB.

Understanding Layout Options

For a description of how you can display the contents of the topology map
in the Map View tab using different layout options, see “Defining a View’s
Layout” in Working with the CMDB.

Understanding the Schedule View Tab

90

The Schedule View tab displays all discovery pattern scheduling information
in one table.

» When you select the Discovery Modules root in the Discovery Modules pane

(see the picture below), the Schedule View tab displays scheduling
information for only the active patterns.

todule Manager I Probe Manager I

Discovery Modules

N Di=covvery hodules

i) Application - Oracke E-Business Sute
B opplication - S&P (RiE)
i) application - Siekel
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» When you select a module or a pattern in a module, the Schedule View tab
displays scheduling information for the patterns in the selected module.

To view the Schedule View tab:
Click the Module Manager tab.
2 Click the Schedule View tab to view the Schedule View table.

Diatails Views | Map View Scheduls View I

Pattern name Trigger Tqls Invoke Immediathy
= SAP_Dis_SolutionManager  [Every 1 Days sapsystem_connected L
= SAP_Dis_Site Every 1 Days sap_ports "
=, 3AP_Dis_Applications Every 1 Days sapsystem_connected L
= SAP_Dis_IT3 Every 1 Days sap_its_process "
The Schedule View table is divided as follows:
Field Description
Pattern Name The name of the discovery pattern.
Schedule info The scheduling information of the discovery pattern as defined in

Discovery Scheduler. For details, see “Setting the Date for Starting
and Stopping a Discovery Pattern” on page 75.

Trigger Tqls The name of the TQL that activated the discovery pattern.

Invoke Immediately The options for this field are as follows:

» If this column contains a check, the discovery pattern runs as soon
as the triggered CI reaches the Discovery Probe. In this case, the
Invoke on new triggered Cls immediately check box is selected in
the Design View tab of the Pattern Editor. For details, see “Defining
the Discovery Pattern” on page 70.

» If this column does not contain a check, the pattern runs
according to the patterns schedule as defined in the Pattern Editor.
For details, see “Defining the Discovery Pattern” on page 70.
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Protocol Definitions

This section contains the definitions that are needed for Mercury Business
Availability Center protocols.

Protocol Parameter Description

JBOSS Protocol Connection Timeout Timeout in milliseconds after which
the Discovery Probe stops trying to
connect to the JBoss application
server.

Network Address The discovered IP net address or the
net address range.

Note A textual message.
Port Number The port number.
Protocol Index Indicates the order in which protocol

instances will be used to make a
connection attempt. The lower the
index is the higher the priority it has.

The default is 9999. If you do not
change the default, this protocol
instance will be used last.

User Name The user name.

User Password The user password.
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Protocol

Parameter

Description

NTCMD Protocol

Connection Timeout

Timeout in milliseconds after which
the Discovery Probe stops trying to
connect to the NTCMD server.

Network Address The discovered IP net address or the
net address range.

Note A textual message.

NT Domain The Microsoft domain.

Protocol Index

Indicates the order in which protocol
instances will be used to make a
connection attempt. The lower the
index is the higher the priority it has.

The default is 9999. If you do not
change the default, this protocol
instance will be used last.

User Name

The user name.

User Password

The user password.
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Protocol

Parameter

Description

SAP JMX Protocol

Connection Timeout

Timeout in milliseconds after which
the Discovery Probe stops trying to
connect to the SAP JMX console.

Network Address The discovered IP net address or the
net address range.
Note A textual message.

Port Number

The port number of JMX.

Protocol Index

Indicates the order in which protocol
instances will be used to make a
connection attempt. The lower the
index is the higher the priority it has.

The default is 9999. If you do not
change the default, this protocol
instance will be used last.

User Name

The user name.

User Password

The user password.
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Protocol

Parameter

Description

SAP Protocol

Connection Timeout

Timeout in milliseconds after which
the Discovery Probe stops trying to
connect to the SAP server.

Network Address The discovered IP net address or the
net address range.
Note A textual message.

Protocol Index

Indicates the order in which protocol
instances will be used to make a
connection attempt. The lower the
index is the higher the priority it has.

The default is 9999. If you do not
change the default, this protocol
instance will be used last.

Sap Client

An independent unit within the R/3
system, which is identified by a
three-digit number.

Sap Router String

A string that contains the host and
port of the SAP router.

Sap System Number

An unique identifier of SAP system.
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Protocol

Parameter

Description

Siebel Gateway Protocol

Connection Timeout

Timeout in milliseconds after which
the Discovery Probe stops trying to
connect to the Siebel gateway.

Network Address The discovered IP net address or the
net address range.
Note A textual message.

Protocol Index

Indicates the order in which protocol
instances will be used to make a
connection attempt. The lower the
index is the higher the priority it has.

The default is 9999. If you do not
change the default, this protocol
instance will be used last.

Siebel Site Name

The name of the Siebel site.

srvrmgr path

The directory in which the srvr.exe
file is located.

User Name

The user name.
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Protocol Parameter Description

SNMP Protocol Community (For SNMP v1 and SNMP v2 only)
Enter the password you used when
connecting to the SNMP service
community you defined while
configuring the SNMP service (for
example, a community for read-only
or read/write).

Connection Timeout Timeout in milliseconds after which
the Discovery Probe stops trying to
connect to the SNMP agent.

Network Address The discovered IP net address or the
net address range.

Note A textual message.

Port Number (For SNMP versions v1, v2, and v3)
The port number on which the
SNMP agent listens.

Protocol Index Indicates the order in which protocol

instances will be used to make a
connection attempt. The lower the
index is the higher the priority it has.

The default is 9999. If you do not
change the default, this protocol
instance will be used last.

Retry The number of times the Discovery
Probe tries to connect to the SNMP
agent. If the number is exceeded, the
Discovery Probe stops attempting to
make the connection.

SNMP version The options are:

» version 1 or 2
» version 3

User Name (For SNMP v3 only) The name of the
user authorized to log on to the
management application.
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Protocol

Parameter

Description

User Password

(For SNMP v3 only) The password
used to log on to the management
application.

V3 - Authentication algorithm

(For SNMP v3 only) Two algorithms
are supported:

> MDS5

» SHA
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Protocol Parameter Description

V3 - Authentication method (For SNMP v3 only) Select one of the
following options for securing the
access to management information:

» NoAuthNoPriv. Using this option
provides no security,
confidentiality, or privacy at all. It
might be useful for certain
applications, such as development
and debugging to turn security off.
This option requires only a user
name for authentication (similar
to requirements for v1 and v2).

» AuthNoPriv. The user logging on
to the management application is
authenticated by the SNMP v3
entity before the entity allows the
user to access any of the values in
the MIB objects on the agent.
Using this option requires a user
name, password and the
authentication algorithm
(HMAC-MDS or HMAC-SHA
algorithms).

» AuthPriv. The user logging on to
the management application is
authenticated by the SNMP v3
entity before the entity allows the
user to access any of the values in
the MIB objects on the agent. In
addition, all of the requests and
responses from the management
application to the SNMP v3 entity
are encrypted, so that all the data
is completely secure. This option
requires a user name, password
and an authentication algorithm
(either (HMAC-MDS or
HMAC-SHA).

99




Chapter 4 » Running the Discovery Process

Protocol

Parameter

Description

V3 - Privacy algorithm

(For SNMP v3 only) The following
algorithm is supported: DES.

V3 - Privacy key

(For SNMP v3 only) The secrete key
used to encrypt the scoped PDU
portion in an SNMP v3 message.

SQL Protocol

Connection Timeout

Timeout in milliseconds after which
the Discovery Probe stops trying to
connect to the database.

Database Name

The database name.

Database SID (Oracle, DB2)

The database SID.

Database Type The database type, such as Oracle
and Microsoft SQL Server.

Network Address The discovered IP net address or the
net address range.

Note A textual message.

Port Number

The port number on which the
database listens.

Protocol Index

Indicates the order in which protocol
instances will be used to make a
connection attempt. The lower the
index is the higher the priority it has.

The default is 9999. If you do not
change the default, this protocol
instance will be used last.

User Name

The user name.

User Password

The user password.
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Protocol

Parameter

Description

SSH Protocol

Authentication Mode

These are the following
authentication options:
» Password

» Key

» Keyboard Interactive

Connection Timeout

Timeout in milliseconds after which
the Discovery Probe stops trying to
connect to the remote machine.

Key Path Location of the authentication key.

Network Address The discovered IP net address or the
net address range.

Note A textual message.

Port Number

The port number.

Protocol Index

Indicates the order in which protocol
instances will be used to make a
connection attempt. The lower the
index is the higher the priority it has.

The default is 9999. If you do not
change the default, this protocol
instance will be used last.

User Name

The user name.

User Password

The user password.
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Protocol

Parameter

Description

Telnet Protocol

Connection Timeout

Timeout in milliseconds after which
the Discovery Probe stops trying to
connect to the remote machine.

Network Address The discovered IP net address or the
net address range.
Note A textual message.

Port Number

The port number.

Protocol Index

Indicates the order in which protocol
instances will be used to make a
connection attempt. The lower the
index is the higher the priority it has.

The default is 9999. If you do not
change the default, this protocol
instance will be used last.

User Name

The user name.

User Password

The user password.
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Protocol Parameter Description

Uddi Registry Protocol Connection Timeout Timeout in milliseconds after which
the Discovery Probe stops trying to
connect to the UDDI Registry.

Network Address The discovered IP net address or the
net address range.

Note A textual message.

Protocol Index Indicates the order in which protocol
instances will be used to make a
connection attempt. The lower the
index is the higher the priority it has.

The default is 9999. If you do not
change the default, this protocol
instance will be used last.

Publishing Organization The name of the service publisher
whose services you want to publish.

UDDI inquiry URL The URL where the UDDI Registry is
located.
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Protocol

Parameter

Description

WebLogic Protocol

Connection Timeout

Timeout in milliseconds after which
the Discovery Probe stops trying to
connect to the WebLogic application
server.

Network Address The discovered IP net address or the
net address range.
Note A textual message.

Port Number

The port number.

Protocol Index

Indicates the order in which protocol
instances will be used to make a
connection attempt. The lower the
index is the higher the priority it has.

The default is 9999. If you do not
change the default, this protocol
instance will be used last.

User Name

The user name.

User Password

The user password.
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Protocol Parameter Description

Websphere Protocol Connection Timeout Timeout in milliseconds after which
the Discovery Probe stops trying to
connect to the WebSphere server.

Network Address The discovered IP net address or the
net address range.

Note A textual message.
Port Number The port number.
Protocol Index Indicates the order in which protocol

instances will be used to make a
connection attempt. The lower the
index is the higher the priority it has.

The default is 9999. If you do not
change the default, this protocol
instance will be used last.

Trust Store The location of SSL trust store file.
Trust Store Password The SSL trust store password.

User Name The user name.

User Password The user password.
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Protocol

Parameter

Description

WMI Protocol

Connection Timeout

Timeout in milliseconds after which
the Discovery Probe stops trying to
connect to the WMI agent.

Network Address The discovered IP net address or the
net address range.

Note A textual message.

NT Domain Microsoft domain.

Protocol Index

Indicates the order in which protocol
instances will be used to make a
connection attempt. The lower the
index is the higher the priority it has.

The default is 9999. If you do not
change the default, this protocol
instance will be used last.

User Name

The user name.

User Password

The user password.
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Performing a SAP Discovery

The SAP discovery process enables you to discover SAP elements and SAP

topology.

This chapter describes: On page:
Step 1 - Installing the Java Connectors 110
Step 2 - Preparing for a SAP Discovery 110
Step 3 — Adding a Network CI to Trigger the Discovery of SAP System | 113
Networking

Step 4 - Accessing the Discovery Modules 113
Step 5 - Running the Discovery Patterns 115
Step 6 — Checking that the Discovery Ran Correctly 124
Step 7 — Running SAP Solution Manager Discovery 125
CIs Created by the Discovery Process 126

Note: For details about how to perform a discovery, see “Running the

Discovery Process” on page 25.
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Step 1 - Installing the Java Connectors

Step 1 is a prerequisite to the other steps. Steps 2 to 5 discover different SAP
elements and different parts of SAP topology.

Before you run a SAP discovery, you install the Java connectors, if you have
not already done so. For details, see “Step 3 — Performing the Discovery
Probe Post-Installation Procedure” on page 275.

Step 2 - Preparing for a SAP Discovery

Before you run a SAP discovery, you must add a discovery probe and define
the protocols as indicated in this section.

Note: Ensure that the Discovery Probe is running.

To prepare for a SAP discovery:
1 In Mercury Business Availability Center, select Admin > CMDB.
2 Click the Discovery Manager tab.
3 Click the Probe Manager pane.
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4 In the Discovery Probes pane, select the relevant Discovery Probe.

5 Click the Add IP Range button to open the Add IP Range window.

6 Enter the range of IP addresses that includes the IP address of the probe you
want to discover. If there is only one address, enter its value in both boxes.

7 Click OK.
8 Click the Add IP Range button to open the Add Range window once more.

9 Enter the range of IP addresses that includes the IP address of the SAP system
you want to discover. If there is only one address, enter its value in both
boxes.

10 Click OK.
11 Click Apply to save the changes you have made.
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12 Expand the appropriate Discovery Probe:

rDiscover

v Probes

EN

_ 4 Probes

DefaultProbe
o/ JBOSS Protocol
g0 MTCMD Pratocol
o/ SAP I Protocal
50 SAP Protocol
oY Siebel Gateway Protacal
o SNMP Protacal
78 S0L Protocol
o 55H Protocal
0 Telnet Protocol
o Uddi Registry Protocol
-0 Weblogic Protocol
o Websphere Protocol

o0 WMI Protocal

13 Define the following protocols:

» Select SNMP Protocol, and click the Add new connection details for the
selected protocol type button. Populate the following field:

(2]

» Community. Enter the password you used when connecting to the
SNMP service community you defined while configuring the SNMP
service (for example, a community for read-only or read/write).

» Select WMI Protocol, and click the Add new connection details for the
selected protocol type button. Populate the following fields:

(2]

» NT Domain. The name of the host where the Discovery Probe is
installed.

> User Name. The name of the user you use to connect to the host as
administrator.

» User Password. The password of the user you use to connect to the
host as administrator.

» Select NTCMD Protocol, and click the Add new connection details for the
selected protocol type button. Populate the following fields:

(2]

> NT Domain. The name of the host where the Discovery Probe is
installed.

> User Name. The name of the user you use to connect to the host as
administrator.
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» User Password. The password of the user you use to connect to the
host as administrator.

» Select SAP Protocol, and click the Add new connection details for the
selected protocol type button. Populate the following fields:

» SAP Client. The default value is 800. It is recommended to use the
default value.

> SAP System Number. The default value is 00. It is recommended to use
the default value.

> User Name. The name of the user you use to log on to the SAP system.

» User Password. The password of the user you use to log on to the SAP
system.

Note: If you want to discover more than one SAP System, it is recommended
to create a SAP Protocol for each SAP system with different users and
passwords.

Click Apply to save the changes.

Step 3 - Adding a Network CI to Trigger the Discovery of
SAP System Networking

h W N =

To trigger the discovery of SAP System networking features, you must add a
Network CI to the CMDB.

To add a Network Cl to trigger a discovery of SAP System networking:
To add the Network CI, access the New CI Wizard.

Select Display all possible CITs.

Expand System, expand Network Resource, and select Network.

Click OK to open the Define General Properties page, and then click Next to
open the Define CIT-Specific Properties page.
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5 Enter the following information:

> In the Network Domain Name box, enter the name of the domain that
was specified during SAP installation.

» In the Network Mask box, enter the mask for the IP address of the SAP
System network.

> In the Network Address box, enter the IP address of the SAP System
network.

If the Network CI was added successfully, you get the following message:
Network Cl was added successfully.

6 Click Finish:

For details about this procedure, see “Using the New CI Wizard” in
IT Universe Manager Administration.

Step 4 - Accessing the Discovery Modules

114

Access the discovery modules and activate the appropriate discovery
patterns.

For details on how to activate a discovery pattern, see Discovery Manager
Administration.

To access the discovery modules:
1 Click the Discovery Manager tab in CMDB Administration.
2 Click the Module Manager tab.
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Step 5 - Running the Discovery Patterns

To run the discovery patterns, you must trigger them in the order described
in this section. Fach discovery pattern discovers different components. For
details on the components and their hierarchy structure, see “Cls Created by
the Discovery Process” on page 126.

This section includes the following topics:

» “Running the Discovery” on page 115

> “Selecting the Discovery Modes for Discovering Application Components,
SAP Transactions, and Transports” on page 118

Running the Discovery
This section describes how to run the discovery.
To run the discovery:

In the Module Manager tab, expand the modules, select the patterns, and
activate them:

Expand Module Activate Pattern Description

Network — Basic ICMP_NET_Dis_IpC Discover which machines are
active by pinging the
machines within the range of
given IP addresses that you
provided in “Step 2 -
Preparing for a SAP Discovery”
on page 110.
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Expand Module

Activate Pattern

Description

Network - Protocol
Connections

SNMP_NET_Dis_
Connection

Discovers, in the range of
given IP addresses, the hosts
that communicate using the
SNMP protocol.

NTCMD_NET_Dis_
Connection

Discovers, in the range of
given IP addresses, the hosts
that communicate using the
NTCMD protocol.

WMI_NET_Dis_Connection

Discovers, in the range of
given IP addresses, the hosts
that communicate using the
WMI protocol.

Host Resources —- WMI

WMI_HR_Process

Discovers the processes that
are running on the server.

If the SAP system you are
discovering has an ITS
configuration and you want to
discover the ITS entities of the
SAP system, run this pattern as
a prerequisite to the SAP
discovery that discovers ITS
entities.

Network — Advanced

TCP_NET_Dis_Port

Discovers the server’s open
active ports.

Web Servers — Basic

TCP_Webserver_Detection

Discovers the Web servers
running on this host.

If the SAP system you are
discovering has an ITS
configuration and you want to
discover the ITS entities of the
SAP system, run this pattern as
a pre requisite to the SAP
discovery that discovers ITS
entities.
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Expand Module Activate Pattern Description

Application — SAP (R/3) SAP_Dis_Site Discovers infrastructure
entities in the SAP System:
Hosts, R/3 Application
server/s, Work Processes,
databases, SAP clients,
Configuration files, software
components (discovered as a
configuration file), and
support packages (discovered
as a configuration file).

SAP_Dis_ITS Discovers Internet Transaction
Server (ITS) entities
(Application Gateway and

Web Gateway).
SAP_Dis_Solution Run this discovery pattern if
Manager you are using SAP Solution

Manager and you want to
discover the SAP Solution
Manager components. For
details on the SAP Solution
Manager components, see “Cls
Created by the Discovery
Process” on page 126.

Note: Before you run this
discovery pattern to discover
application components, SAP
transactions, and SAP
transports, you must set the
discovery mode.

If you want to discover
changed SAP transactions you
must determine the
appropriate range of dates. For
details, see “Determining the
Appropriate Range of Dates for
Changed SAP Transaction
Discovery” on page 122.
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Selecting the Discovery Modes for Discovering
Application Components, SAP Transactions, and
Transports

Before you run the SAP_Dis_Applications discovery pattern to discover
application components, SAP transactions, and SAP transports, you must set
the discovery mode.

If you want to discover changed SAP transactions you must determine the
appropriate range of dates. For details, see “Determining the Appropriate
Range of Dates for Changed SAP Transaction Discovery” on page 122.

You can use the following parameter’s structure to run the required
discovery pattern.

Partial
get tx change get_tx_active
true false true false
gel fx_change interval Does not Active Does not
retrieve any retrieve any
=0 =0 data data

Within period Last x seconds

txc_from_date

txc_to_date

txc_from_time

txc_to time
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Depending on the combination of parameters and their values you can
discover all SAP transactions, active SAP transactions, the SAP transactions
that were modified by a SAP transport, or both the active and modified SAP
transactions.

Once you have selected what you want to discover, run the appropriate
discovery.

This section includes the following topics:

“Discover Active SAP Transactions” on page 119

“Discover Changed SAP Transactions” on page 120

“Discover Active and Changed SAP Transactions” on page 121
“Determining the Appropriate Range of Dates for Changed SAP Transaction
Discovery” on page 122

Discover Active SAP Transactions

You can discover active SAP transactions.

To discover active SAP Transactions:

Double-click SAP_Dis_Application discovery pattern to open the Pattern
Editor page.

Set get_tx_all to false.
Set get_tx_active to true.
Click OK to save the changes.

Go to the next procedure. For details, see “Step 7 — Running SAP Solution
Manager Discovery” on page 125.
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120
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Discover Changed SAP Transactions

You can discover the SAP transactions that have been changed by discovered
transports.

To run changed SAP Transactions:

Double-click SAP_Dis_Application discovery pattern to open the Pattern
Editor page.

Set get_tx_all to false.

Set get_tx_active to false.

Set get_tx_change to true.

Set get_tx_change_interval to one of the following:

» 0. To discover the changes to transactions in the period of time specified
in the txc_from_date, txc_from_time, txc_to_date, and txc_to_time
parameters. For details about the range to specify, see “Determining the
Appropriate Range of Dates for Changed SAP Transaction Discovery” on
page 122.

» x. To discover (where x > 0) the changes to transactions in the last x
seconds.

6 Click OK to save the changes.

7 Go to the next procedure. For details, see “Step 7 — Running SAP Solution

Manager Discovery” on page 125.
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Discover Active and Changed SAP Transactions

You can discover the SAP transactions that are active and have changed
since the last discovery.

To discover active and changed SAP Transactions:

Double-click SAP_Dis_Application discovery pattern to open the Pattern
Editor page.

Set get_tx_all to false.

Set get_tx_active to true.

Set get_tx_change to true.

Set get_tx_change_interval to one of the following:

» 0. To discover the changes to transactions in the period of time specified
in the txc_from_date, txc_from_time, txc_to_date, and txc_to_time
parameters. For details about the range to specify, see “Determining the
Appropriate Range of Dates for Changed SAP Transaction Discovery” on
page 122.

> x. (where x > 0) to discover the changes to transactions in the last x
seconds

6 Click OK to save the changes.

7 Go to the next procedure. For details, see “Step 7 — Running SAP Solution

Manager Discovery” on page 125.
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122

Determining the Appropriate Range of Dates for Changed SAP
Transaction Discovery

Note: This procedure is only required if the parameter
get_tx_change_interval = 0. For details, see “Selecting the Discovery Modes
for Discovering Application Components, SAP Transactions, and
Transports” on page 118.

To discover the SAP transactions that have changed, you must determine
the appropriate range of dates before entering them in the appropriate
discovery pattern. For details, see “Selecting the Discovery Modes for
Discovering Application Components, SAP Transactions, and Transports” on
page 118.

To determine the appropriate range of dates for changed SAP transactions
discovery:

1 Click the SAP Logon icon to log in to SAP.
2 Activate SE16 in SAPGUI to open table E070.

Lttilities

Tahle Edit Goto

Settings

& aldBICEa@  DHE DL IER @ m
Data Browser: initial Screen

0O

Table Narne EA7H| (=)
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3 Enter the range of dates for which you want to display the transports
deployed.

g 0B iee@ DHE OO0 HAR @F
Data Browser: Table E070: Selection Screen

o

WL '

01.09. 2604
oo:oo: e

[1. 09,2005 [
06000

B e Y

I

| |

| |

-

||

I

Jo1.20.2604]

T

I
gthofouputlist 250
MaimumNe.ofHts S0

4 Press the Execute button, in the top left corner.
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The outcome is the result of the query you just defined in SAP. The time
range is indicated in the AS4DATE and AS4TIME columns.

Table Entry Edit Goio S ies  Environment ¢ em Help

(V] Bla @ SHE DDOD BRI @
Data Browser: Table EQ70 Select Entries 270
& G & F S| Check Table...

% ~

Table: EQYE 4 ™
Displayed fields: 10 of 18 Fixed columns: 1 List width 0250/ Ay
TREORR TREUMCTION|TRETATUS| TARSYSTEN |KORRDEY | AS4USER ﬂS4DMTE .“.S4TIME\ STREORR
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[ |MITKI0O041 K R SYST EBIxON ."‘ 14.08.2005|12:28:43( |

[ |MITK9ROO42 K R SYST EBIxON [ [14.08.2005|12:28:40 \
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[ [MITKOREE46 K R SYST EBIXON |' 14.08.2005(12: |

[ [MITKOREE4T 5 R SYST EBIXON | 14.08.2005(12: MI?FQBDBJB
[ |mITK9pAR4R K R SYST EBIXON | 14.08.2005(12:

[ |MITK9POO44 W R CUST EBIXON | 14.08.2005(12: |

[ |MITK9ROOSD 0 R CUST EBIXON 14.08.2005(12: MITE9O0049
[ |MI7K900051 W R CUST EBIXON 14.08.2005(12:

[ |MI7K9POOS2 0 R CUST EBIXON 14.089.2005(12: HMI7E900851
[ |MI7KORRES? W R CUST EBIXON 14.088.2005(12:

[ [MITKOREEGS 0 R CUST EBIXON | 14.08.2005(12: HI7ROOOAS3
[ |MITK90EEES W R CUST EBIXON | 14.08.2005(12:
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Step 6 - Checking that the Discovery Ran Correctly

After running all the discoveries, check that all the information is displayed
correctly.

To check that the discovery ran correctly:

Select Application > Dashboard, click the Console tab, and open the SAP
Systems view or select Admin > CMDB, and click the IT Universe Manager
tab.
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The view is as follows if Business Process Monitor profiles and CCMS
monitors were configured before running discovery. Otherwise, the view is
similar but the status indicators are grey:

Top View | Console Filters | Geographical Map | Custom Map | Topology Map Reports |

ur w8 4)
Customer | %7 sAp @ +*  performance \47  Availability @ +® Transactions I
Locations DT Ack

MName Customer SAP Performance Availability Transactions Locations Ack
Agglication Components i it} @+° &
i} Business Processes ¥ @+ @+ ]
Clisnts ]
L% Hosts v @+ ]
i} Locations ¥ @s° 9:° ]
L gap Corfiquration ¥ ]
Transports * ~]

Step 7 - Running SAP Solution Manager Discovery

You run the SAP Solution Manager discovery to discover the business
process hierarchy.
To run SAP Solution Manager Discovery:

1 Select Admin > CMDB and click the Discovery Manager tab to open the
Discovery Management page.

Click the Module Manager tab.
In the Discovery Modules pane, expand Application — SAP (R/3).
Select the SAP_Dis_SolutionManager discovery pattern.

wni A W N

Click the Activate button to start the discovery.

The outcome is the business process hierarchy. For details, see “Cls Created
by the Discovery Process” on page 126.
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Cis Created by the Discovery Process

126
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During discovery, specific SAP Cls and a hierarchy of CIs are entered in the
CMDB.

This section includes the following topics:

“Hierarchy” on page 127

“SAP System” on page 128

“SAP Applications” on page 128

“SAP Application Component” on page 128
“SAP Transaction” on page 129
“Business Process Step” on page 129
“BPM Monitor” on page 129
“Solution Manager Projects” on page 130
“Locations” on page 130

“Contained Location” on page 130
“Business Processes” on page 131
“Transports” on page 131

“Client” on page 131

“Hosts” on page 132

“Application Gateway” on page 132
“Web Gateway” on page 132

“R/3 Application Server” on page 132
“Work Processes” on page 133
“Database” on page 133

“Software Component” on page 134
“Support Package” on page 134

“Configuration File” on page 134



Chapter 5 » Performing a SAP Discovery

> “CCMS Counters” on page 134

» “Monitor” on page 135

Hierarchy

The ClIs hierarchy is as follows:

P s ] -
—{ Appication Compenents | [ GroopiContziner | [ Instance
LSAP Application Components |
L (S Tranaasione |
[ rme ] o]
I
| I Solution Manager Projects” |
L_["SAF Business Pracess Steps | —@
S aneaciors
=
[ Cocatoe ]
B Poceses | | e
.
g
o] Ll S M e
baars assigned Transsstion/Locatian option
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SAP System

SAP System is a logical unit, grouping together SAP-related CIs (and possibly
other Cls as well) into one homogenous SAP deployment.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPIs for this CI are:

“Performance”
“Availability”
“System”

" SAPH
“Transactions”

“Locations”

SAP Applications

SAP Applications is a logical unit, grouping together Application
Components.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPIs for this CI are:

» “Performance”

> “Availability”

>

>

SAP Application Component

A SAP Application Component may include other SAP Application
Components and some SAP transactions with some common denominator.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPIs for this CI are:

“Performance”

“Availability”
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SAP Transaction

A SAP Transaction Cl is part of a business process defined in the SAP System.
It is comprised of request-response couples called dialog steps. The end user
uses SAP transactions to carry out actions on the SAP System.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPIs for this CI are:

» “Performance”

> “Availability”

Business Process Step

Business Process Steps (BPM transactions inside a script) are emulated SAP
transactions executed on a Business Process Monitor machine. They are used
to supply proactive monitoring of end user experience.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPIs for this CI are:

» “Performance”

> “Availability”

BPM Monitor

The BPM Monitor Cls represent Business Process Monitor entities used to
monitor user experience.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPIs for this CI are:

» “Performance”

> “Availability”
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Solution Manager Projects

The Solution Manager Projects CI type includes SAP Business Project Cls,
SAP Scenario Cls, SAP Business Process Cls, and SAP Business Process Step
Cls.

The Solution Manager Projects hierarchy is specified by the user in SAP
Solution Manager.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPIs for this CI are:

» “Performance”

> “Availability”

Locations

The Contained Group Locations is a logical unit, grouping together
Contained Locations CIs.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPIs for this CI are:

» “Performance”

> “Availability”

Contained Location

Location Cls are created as part of the Business Process Monitor hierarchy
when working with the Transactions/locations option.

To separate the SAP Business Process steps location status from the Location
CI (from the Business Process Monitor), the Contained Location Cls are
created by the SAP solution and are connected to the SAP Business Process
steps (identified by following the naming convention or by manually
linking them).
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The regular Location CI is connected to all Business Process steps both
regular and SAP, but the Contained Location CI is connected only to the SAP
Business Process steps.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPIs for this CI are:

» “Performance”

> “Availability”

Business Processes

The Contained Group called Business Processes is a logical container that
contains all the Business Process steps attached to all the SAP transactions.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPIs for this CI are:

» “Performance”

> “Availability”

Transports

A Transport represents packaged change requests that include the changes
that are to be deployed onto the system.

This CI does not have KPIs.

Client

A client is an organizational and legal CI in the SAP system. The main
objective of the client is to keep the data isolated: the data in a client can
only be visible within that client; it cannot be displayed or changed from
another client. Each client on a system can represent a unique working
environment.

This CI does not have KPIs.
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Hosts

Hosts is a logical unit, grouping together Host Cls.

A Host CI represents the physical machine on which a server is installed.
This is not a SAP-specific element.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPIs for this CI are:

> “System”

> “SAP”

Application Gateway

An Internet Transaction Server (ITS) component. Establishes the connection
to the R/3 System and performs the processing of tasks that are required to
move data between R/3 applications and the Internet.

This CI does not have KPIs.

Web Gateway

An ITS component. A web server extension that establishes the connection
between ITS and the Web server and forwards user requests to the
Application Gateway.

This CI does not have KPIs.

R/3 Application Server
SAP R/3 Application Server is SAP's integrated software solution for
client/server and distributed open systems.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPI for this CI is:

) IISAPII
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Work Processes

Each work process CI is a logical, single-instance representation of all the
work processes of the same type existing on the R/3 server.

There are several available types of work processes:

> Dialog Work Process. Executes dialog programs (ABAP).

» Update Work Process. Responsible for asynchronous database changes
(controlled by a COMMIT WORK statement in a dialog work process).

» Update2 Work Process. Used for statistical, non-critical updates (for
example, result calculations).

» Background Work Process. Executes time-dependent or event-controlled
background jobs.

» Enqueue Work Process. Executes locking operations (if SAP transactions
have to synchronize themselves).

» Spool Work Process. Performs print formatting (to printer, file, or database).

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPI for this CI is:

) HSAPH

Database

A database management system holding the data tier, including all the SAP
elements: SAP transactions, programs, work processes, and so forth. This is
not a SAP-specific CI.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPIs for this CI are:

> “System”

> “SAP”
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Software Component

A software component installed on the SAP System, for example: SAP_ABA
(cross-application component), SAP_HR (human resources), and so forth.

This CI does not have KPIs.

Support Package

A Support Package contains quality improvements for the SAP system, or
adjustments due to legal changes.

This CI does not have KPIs.

Configuration File

Configuration files are used to enter configuration parameters into the
system/servers.

This CI does not have KPIs.

CCMS Counters

CCMS Counters (also called Measurements) are pieces of information
elements, relevant to SAP, retrieved from SAP CCMS (Computer Center
Management System).

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPI for this CI is:

) IISAPII
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Monitor

The monitors are SiteScope entities used to monitor the various Cls that
exist in the CMDB. The monitors that are most likely to appear in the SAP
view are host monitors: CPU, memory, disk space, and so forth. These
monitors appear in the SAP view only if they are manually attached to the
Host CI.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPI for this CI is:

> “System”
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Performing a Siebel Discovery

This chapter includes the steps involved in discovering Siebel topology in
your organization.

This chapter describes: On page:
About Performing a Siebel Discovery 138
Running Siebel Discovery 138
Step 1 - Preparing for a Siebel Discovery 139
Step 2 - Adding a Network CI to Trigger the Discovery of Siebel 143
Enterprise Networking

Step 3 - Accessing the Discovery Modules 144
Step 4 - Discovering the Network 145
Step S — Running the Pre-Discovery Patterns for the Web Tier 146
Step 6 — Running the Siebel Discovery 147
Step 7 — Checking that Discovery Ran Correctly 148
Manual Configuration for Specific Siebel CIs 149
CIs Created by the Discovery Process 151

Note: For details about how to perform a discovery, see “Running the
Discovery Process” on page 25.
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About Performing a Siebel Discovery

Using the Siebel patterns, you can run an automatic Siebel discovery to
create the Siebel world, with all its components inside Mercury Business
Availability Center.

During the discovery process:

All Siebel-related IT entities that reside in the organization are discovered
and corresponding configuration items (Cls) are entered into the CMDB.

When a new Siebel Application CI is created, two KPIs are created under it:
Transactions and Locations.

» The relationships between the elements are created and saved in the CMDB.

» The newly generated Cls appear when the Siebel Enterprises view is selected

in View Explorer under the Siebel Enterprises root CI.

In addition, four logical containers: Applications, Business Processes, Hosts
and Locations are also created under the Siebel Enterprises root CI.

After the discovery has been performed, you must manually update some of
the discovered CI's properties. For details, see “Matching Connection
Parameters to SiteScope” on page 370.

Running Siebel Discovery

138

The Siebel discovery process enables you to discover Siebel elements and
Siebel topology. The Siebel discovery process consists of the following steps:

» “Step 1 — Preparing for a Siebel Discovery” on page 139

\

Y Y Y Y Y

“Step 2 — Adding a Network CI to Trigger the Discovery of Siebel Enterprise
Networking” on page 143

“Step 3 — Accessing the Discovery Modules” on page 144

“Step 4 - Discovering the Network” on page 145

“Step 5 — Running the Pre-Discovery Patterns for the Web Tier” on page 146
“Step 6 — Running the Siebel Discovery” on page 147

“Step 7 — Checking that Discovery Ran Correctly” on page 148
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Steps 1 to 4 are a prerequisite to the following steps. Steps 5 to 7 discover
different parts of Siebel topology.

Step 1 - Preparing for a Siebel Discovery

Y Y Y Y Y

Before you run a Siebel discovery, you must define the protocols as indicated
in this section.

Note: Ensure that the Discovery Probe is running.

To define Siebel protocols, ask the Siebel enterprise administrator for the
following information:

Siebel Enterprise name
Gateway host

User name

Password

The path to the srvrmgr directory on the Discovery Probe server. For details,
see “Copying the srvrmgr Tool to the Discovery Probe Server” on page 327.

To prepare for a Siebel discovery:
In Mercury Business Availability Center, select Admin > CMDB.
Click the Discovery Manager tab.

3 Click the Probe Manager tab.
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4 In the Discovery Probes pane, select the relevant Discovery Probe.

Madule Manager FProbe Manager |

Probe Detail

~Discovery Probes

_‘J Probes Probe IPs: 10.168.23.51
@ DefaulProbe

Last Ltime probe accessed : Never Accessed Status: disconnes

~Descripkion

~Ranges

& Before changing the probe range it is recommended to stop all active patterns.

[
(=]

[m] 5 Click the Add IP Range button to open the Add IP Range dialog box.

6 Enter the range of IP addresses that includes the IP address of the discovery
probe. If there is only one address, enter its value in both boxes.

7 Click OK.

[m] 8 Click the Add IP Range button to open the Add IP Range dialog box once
more.

9 Enter the range of IP addresses that includes the IP address of the Siebel
server(s) you want to discover. If there is only one address, enter its value in
both boxes.

Note: Make sure that all the Siebel servers IP addresses are included in the
range. If you do not want to cover all servers with one IP range, you may
split it into a few ranges.

10 Click OK.
11 Click Apply.
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12 Expand the appropriate Discovery Probe:

~Discovery Probes

_A Prabes
= @ DefaultProbe

----- o/ JBOSS Protocol

----- IJ/{I MTCMD Protocal

----- o0 SAP IME Protocal

----- 51 SAP Protocol

----- o1 Siebel Gateway Prokacol
----- D/‘U SMMP Protocol

..... 39 SGL Protocol

----- D/‘U 55H Pratocol

----- IJ/{I Telnet Prokocal

----- o0 Uddi Registry Protocol
----- D/ﬂ sweblogic Protocal

----- o1 Websphere Protocal
----- D/‘U WML Protocol

13 Define the appropriate protocols.

To define the protocols for the NT platform:

1 Select WMI Protocol, click the Add new connection details for the selected
protocol type button, and populate the following fields:

>

Windows Domain. The name of the domain that includes the host where
discovery probe is installed.

User Name. The name of the user you use to connect to the host as
administrator.

User Password. The password of the user you use to connect to the host
as administrator.

2 Select NTCMD Protocol, click the Add new connection details for the
selected protocol type button, and populate the following fields:

>

NT Domain. The name of the domain that includes the host where
discovery probe is installed.

User Name. The name of the user you use to connect to the host as
administrator.

User Password. The password of the user you use to connect to the host
as administrator.

3 Select Siebel Gateway Protocol, click the Add new connection details for the
selected protocol type button, and populate the following fields:
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> Siebel Enterprise Name. The name of the Siebel Enterprise.

» srvrmgr path. The location where you copied srvrmgr on the Probe
server. For details, see “Copying the srvrmgr Tool to the Discovery Probe
Server” on page 327.

» User Name. The name of the user you use to log on to the Siebel
enterprise.

» User Password. The password of the user you use to log on to the Siebel
enterprise.

Note: If you have several protocol entries with different srvrmgr versions,
the entry with the newer version should appear before the entry with the
older version. For example, if you want to discover Siebel 7.5.3. and Siebel
7.7, define the protocol parameters for Siebel 7.7 and then the protocol
parameters for Siebel 7.5.3.

Click Apply to save the changes.

To define the protocols for the UNIX platform:

Select SSH Protocol, click the Add new connection details for the selected
protocol type button, and populate the following fields:

> User Name. The name of the user you use to connect to the host as
administrator.

> User Password. The password of the user you use to connect to the host
as administrator.

If your server is slow, it is recommended to change the Connection
Timeout to 40000.

Select Telnet Protocol, click the Add new connection details for the selected
protocol type button, and populate the following fields:

> User Name. The name of the user you use to connect to the host as
administrator.
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> User Password. The password of the user you use to connect to the host
as administrator.

If your server is slow, it is recommended to change the Connection
Timeout to 40000.

3 Select Siebel Gateway Protocol, click the Add new connection details for the
[z selected protocol type button, and populate the following fields:

> Siebel Enterprise Name. The name of the Siebel Enterprise.

> srvrmgr path. The location where you copied srvrmgr on the Probe
server. “Copying the srvrmgr Tool to the Discovery Probe Server” on
page 327.

» User Name. The name of the user you use to log on to the Siebel
enterprise.

» User Password. The password of the user you use to log on to the Siebel
enterprise.

Note: If you have several protocol entries with different srvrmgr versions,
the client with the newer version should appear before the client with the
older version. For example, if you want to discover Siebel 7.5.3. and Siebel
7.7, define the protocol parameters for Siebel 7.7 and then the protocol
parameters for Siebel 7.5.3.

4 Click Apply to save the changes.

Step 2 - Adding a Network Cl to Trigger the Discovery of
Siebel Enterprise Networking

To trigger the discovery of Siebel enterprise networking features, you must
add a Network CI to the CMDB.

To add a Network Cl to trigger the discovery of Siebel Enterprise
networking:

1 To add the Network CI, access the New CI Wizard.

143



Chapter 6 * Performing a Siebel Discovery

2

Select Display all possible CITs.

3 Expand System, expand Network Resource, and select Network.

Click OK to open the Define General Properties page, and then click Next to
open the Define CIT-Specific Properties page.

Enter the following information:

» In the Network Domain Name box, enter the name of the domain that
was specified during the Discovery Probe's installation.

> In the Network Mask box, enter the mask for the IP address of the Siebel
enterprise network. For example: 255.255.255.0

> In the Network Address box, enter the IP address of the Siebel enterprise
network. For example: 10.168.11.0.

Click Finish.

For details about this procedure, see “Using the New CI Wizard” in
IT Universe Manager Administration.

Step 3 - Accessing the Discovery Modules

144

1
2

Access the discovery modules and activate the appropriate discovery
patterns.

For details on how to activate a discovery pattern, see “Running the
Discovery Process” on page 25.

To access the discovery modules:
Click the Discovery Manager tab in CMDB Administration.
Click the Module Manager tab.
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Step 4 - Discovering the Network

To discover the network, run the discovery patterns, select them and
activate them as indicated in the procedure.

You can select all the discovery patterns and activate them at once. Each
discovery pattern discovers different components. For details on the
components and their hierarchy structure, see “Cls Created by the
Discovery Process” on page 151.

To discover the network:

In the Module Manager tab, expand the modules, select the patterns, and
activate them:

Expand Activate Pattern Description

Module

Network - ICMP_NET_Dis_ Discovers which machines are active in the range of
Basic IpC given IP addresses by pinging the machines in the IP

address range that you provided in “Step 1 — Preparing
for a Siebel Discovery” on page 139.

Network — NTCMD_NET_Dis_ Discovers, in the range of given IP addresses, the hosts
Protocol Connection that communicate using the NTCMD protocol when
Connections working with the NT platform.

Network — WMI_NET_Dis_ Discovers, in the range of given IP addresses, the hosts
Protocol Connection that communicate using the WMI protocol when
Connections working with the NT platform.

Network — TTY_NET_Dis_ Discovers, in the range of given IP addresses, the hosts
Protocol Connection that communicate using the SSH/Telnet protocol when
Connections working with the UNIX platform.
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Step 5 - Running the Pre-Discovery Patterns for the Web
Tier
To discover the Web tier, run the discovery patterns, select them and

activate them as indicated in the procedure.

You can select all the discovery patterns and activate them at once. Each
discovery pattern discovers different components. For details on the
components and their hierarchy structure, see “Cls Created by the
Discovery Process” on page 151.

To run the discovery:

In the Module Manager tab, expand the modules, select the patterns, and
activate them:

Expand Activate Pattern Description

Module

Network — TCP_NET_Dis_Port Discovers the http_80 port server’s open active ports. If

Advanced the port is not 80, the discovery procedure updates the

portNumberToPortName.xml file.

Others NTCMD_HR_Reg_ Discovers the installation path of the Siebel Web Server
Software Extension for the NT platform.

Others TTY_HR_ Discovers the installation path of the Siebel Web Server
Software Extension for the UNIX platform.

Others WMI_HR_Software Discovers installed software using WMI.

Web Server - TCP_Webserver_ Discovers the Web Servers running on the host. This

Basic Detection pattern is one of the pre-discovery steps needed to

discover the Siebel Web Server Extension.
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Step 6 - Running the Siebel Discovery

To discover Siebel, activate all the patterns in the Siebel module. The
patterns are scheduled to run every 24 hours, by default.

You can select all the discovery patterns and activate them at once. Each
discovery pattern discovers different components. For details on the
components and their hierarchy structure, see “Cls Created by the
Discovery Process” on page 151.

To run the discovery:

In the Module Manager tab, expand the modules, select the patterns, and
activate them:

Expand Activate Pattern Description
Module
Application - SIEBEL_DIS_ Discovers the appropriate IT entities and creates the
Siebel WEBAPPS_NT (for corresponding Siebel Web Server Extensions, Siebel Web
Windows platform) Application, and Siebel Gateway CIs in the CMDB.
or SIEBEL_DIS_ Currently, Siebel discovery discovers IIS and SunOne
WEBAPPS_UNIX (for | (Planet).
UNIX platform) Siebel Gateway Cls are discovered by the
SIEBEL_DIS_WEBAPPS_NT discovery pattern when the
Web requests load balancing is performed by the
gateway.
Application - SIEBEL_DIS_ Select this pattern if the Web requests load balancing is
Siebel GATEWAY _ not performed by the gateway but by an external load
CONNECTION balancer.
(GTWY) Discovers the appropriate IT entities and creates the
corresponding Siebel Gateway ClIs.
Application - SIEBEL_DIS_APP_ Discovers the appropriate IT entities and creates the
Siebel SERVERS Siebel Application Server, Component Group, and

Component CIs.
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Expand Activate Pattern Description
Module
Application - SIEBEL_DIS_APP_ Discovers the appropriate IT entities and creates the
Siebel SERVER_CONFIG Siebel configuration files.
Application - SIEBEL_DIS_DB_NT Discovers the appropriate IT entities and creates the
Siebel (for the Windows Siebel Database CIs.

platform) or

SIEBEL_DIS_DB_

UNIX (for the UNIX

platform)

Note that the following enrichment patterns are automatically running in
the background while discovery is taking place:

> Siebel_Route_WebApp_To_Component. Builds the route between Siebel
Web Application CIs and Siebel Component ClIs.

> Siebel_Web_To_Middle_Tier. Builds the route between the Web tier and
the middle tier when the Siebel enterprise uses a Resonate server for load
balancing.

Step 7 - Checking that Discovery Ran Correctly

148

After running all the discovery patterns, check that all the information in
the Siebel view is displayed correctly For information on which ClIs are
created, see “Cls Created by the Discovery Process” on page 151.

To check that the discovery ran correctly:

Select Application > Dashboard, and click the Console tab or select Admin >
CMDB and click the IT Universe Manager tab.
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The Siebel Enterprises view opens:

Bl 52 sSiebel Enterprizes

=

3
v

siebel

Applications

*

% Business Processes

=]

7 Hastz

*

*. Locations

=]

Note: Some of the properties of some of the CIs must be entered manually
in order for data to be inserted properly in the Siebel Enterprises view. For
details, see “Deploying the SiteScope Siebel Monitors” on page 344.

Manual Configuration for Specific Siebel Cls

When you run the Siebel discovery, the process creates Cls for the
discovered components in the CMDB. In addition to the CI’s properties that
are automatically defined by the discovery process, you must manually
define some properties so the Monitor Deployment Wizard and the Siebel
diagnostics tools can run correctly.

You manually define properties in IT Universe Manager. For details on
defining properties for a CI, see “CIT-Specific Properties” in IT Universe
Manager Administration.
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The following properties remain empty and must be entered manually.

Cl Type

Properties

Description

Siebel Enterprise

Admin user name

The name of the user used to login to the Server
Manager.

Admin password

The password of the user used to login to the Server
Manager.

SARM Script Path

The path to the location of the Siebel Application
Response Measurement (SARM) Analyzer package on
the SiteScope server. The path is relative to the
SiteScope server.

Server Manager

The path to the location of the Server Manager

Transaction User
Name

Script Path package on the SiteScope server. The path is relative
to the SiteScope server. For details, see “Copying the
srvrmgr Tool and the SARM Analyzer Tool to the
SiteScope Server” on page 328.

Siebel Application Emulated The name of the user used in the script that analyzes

the application. It is the default user name that
appears when configuring the Database Breakdown
tool.

Siebel Web Server
Extension

SARM Log Folder

The log folder to which SARM log files are written
on the Web Server Extension's machine. The path is
relative to the SiteScope server. The folder should be
shared. The format should be:
\\<siebel_web_server_extension_name>\
<log_directory>

Siebel Application
Server

SARM Log Folder

The log folder to which SARM files are written on
the Application Server machine. The path is relative
to the SiteScope server. The folder should be shared.
The format should be:
\\<siebel_app_server_name>\<log_directory>

Log Folder

The log folder to which Siebel general log files are
written on the Application Server machine. The path
is relative to the SiteScope server. The folder should
be shared. The format should be:
\\<siebel_app_server_name>\<log_directory>
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Note: In addition, you must make sure that the connection parameters used
to connect to SiteScope monitors are the ones that exist in the various
relevant Cls (Enterprise, Application Server, and so forth). For details, see
“Matching Connection Parameters to SiteScope” on page 370.

Cis Created by the Discovery Process

Y Y Y Y Y Y Y Y Y Y VY VY Y Y Y'Y

During the discovery process, specific Siebel Cls and a hierarchy of CIs are
entered in the CMDB.

This section includes the following topics:

“Hierarchy” on page 152

“Siebel Enterprise” on page 153
“Contained Group” on page 153

“Siebel Application” on page 154
“Business Process Step” on page 154
“Contained Location” on page 154

“BPM Transaction/Location” on page 155
“Host” on page 155

“Web Server” on page 155

“Siebel Web Server Extension” on page 156
“Siebel Web Application” on page 156
“Siebel Gateway” on page 156

“Siebel Application Server” on page 156
“Siebel Component Group” on page 157
“Siebel Component” on page 157
“Database” on page 157
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> “SiteScope Measurement” on page 158

» “Configuration File” on page 158

Hierarchy
The ClIs hierarchy is as follows:

|_3Inbel Enterprises view Lacigid
Siebel Entarprisa | Logicalgrouping | | Siabel specific Cl Typa

| Applications { Mon-Siebal speciic Gl Typa )

—1 Siebal Application
BP Step
BPM Transaction/Location

Siabel Application Server |
Siebel Web Server Extensicn |
SiteScope Measuramant
L Siebel Web Application

—| Sigbal Componant Group |

SiteScope Measurement

«F
Hast

BP Step
BPM Transaction/Lecalion

BEPM Transactionlocation
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Siebel Enterprise

The Siebel Enterprise CI represents the logical grouping of Siebel Application
Servers that support the same group of users accessing a common database
server.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPIs for this CI are:

“Availability”
“Locations”
“Performance”
“Sessions”
“Siebel”
“System”

“Transactions”

Contained Group

The Group Cl is a logical container. This is not a Siebel-specific CI. The
Siebel Enterprises view includes the following groups: Applications, Business
Processes, Hosts, and Locations.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPIs for this CI are:

“Availability”
“Locations”
“Performance”
“Sessions”
“Siebel”
“System”

“Transactions”
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Siebel Application

The Siebel Application CI represents the Siebel complete solution for an
organization’s needs in a certain area. For example: marketing, call center,
and so forth.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPIs for this CI are:

> “Availability”
» “Performance”

» “Sessions”

Business Process Step

The Business Process Steps (BPM transactions inside a script) Cls are
emulated Siebel transactions executed on a Business Process Monitor
machine. They are used to supply proactive monitoring of end user
experience.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPIs for this CI are:

> “Availability”

» “Performance”

Contained Location

The Contained Location ClIs are created as part of the Business Process
Monitor hierarchy when working with the Transactions/locations option.
They represent the locations from which the BP Steps monitoring Siebel are
run.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPIs for this CI are:

> “Availability”

» “Performance”
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BPM Transaction/Location

The BPM Transaction/Location ClIs represent a BP Step/Location intersection
(a specific transaction running at a specific location).

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPIs for this CI are:

> “Availability”

» “Performance”

Host

A Host CI represents the physical machine on which a server is installed.
This is not a Siebel-specific element.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPIs for this CI are:

» “Sessions”

» “Siebel”
> “System”
Web Server

The Web Server CI represents the Web server that forwards requests to the
Siebel enterprise.

This is not a Siebel-specific element.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPIs for this CI are:

» “Siebel”

> “System”
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Siebel Web Server Extension

The Siebel Web Server Extension CI represents the Siebel Web Server
Extension installed on the Web server.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPI for this CI is:

“Siebel”

Siebel Web Application

The Siebel Web Application CI represents the application URL as it exists on
the Siebel Web Server Extension.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPI for this CI is:

“Siebel”

Siebel Gateway

The Siebel Gateway server is a coordinating server that routes requests to the
correct component and provides enhanced scalability, load balancing, and
high availability across the Siebel Enterprise.

This CI does not have KPIs.

Siebel Application Server

The Siebel Application Server CI represents a server running the business
logic tier that supports both back-end and interactive processes for every
Siebel client.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPIs for this CI are:

“Sessions”
“Siebel”

“Tasks in Error”
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Siebel Component Group

The Component Group CI represents an administrative grouping of
components comprising an application running on the Siebel Application
Server.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPI for this CI is:

» “Siebel”

Siebel Component

The Component CI represents a process running on the Siebel Application
Server, which encapsulates some Siebel application functionality.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPIs for this CI are:

» “Sessions”
» “Siebel”

» “Tasks in Error”

Database

The Database CI represents the database that is holding the data tier. This is
not a Siebel-specific CI.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPI for this CI is:

> “System”
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SiteScope Measurement

The SiteScope Measurement CI is not a Siebel-specific CI. However, in the
Siebel Enterprises view, it usually represents a metric of a Siebel monitor; for
example, the Siebel Application Server monitor.

The default KPIs are described in “Dashboard KPIs Detailed Description” in
Repositories Administration. The default KPI for this CI is:

“Siebel”

Configuration File

The Configuration File CIs represent the siebel.cfg configuration file that
includes information from the application server installation or the
parameters.cfg that includes the output of the list parameters for
component command using srvrmgt.

The Configuration File CIs do not have KPIs.
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Performing a Veritas Cluster Discovery

The Veritas Cluster discovery process enables you to discover Veritas Cluster
Servers (VCS), and their member machines (also referred to as nodes), that

activate the discovered resources provided by the cluster.

This chapter describes: On page:
Step 1 - Preparing for a Veritas Cluster Discovery 160
Step 2 — Running the Discovery Patterns 162
Step 3 — Checking that the Discovery Ran Correctly 163
ClIs Discovered by the Discovery Process 165
Troubleshooting 167

Note: For details about how to perform a discovery, see “Running the

Discovery Process” on page 25.
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Step 1 - Preparing for a Veritas Cluster Discovery

Before you run a Veritas Cluster discovery, you must add a Discovery Probe
and then define the protocols as indicated in this section.

Note: Ensure that the Discovery Probe is running.

To prepare for a Veritas discovery:

In Mercury Business Availability Center, select Admin > CMDB.
Click the Discovery Manager tab.

Click the Probe Manager pane.

W N =

In the Discovery Probes pane, select the relevant Discovery Probe.

Module Manager  Probe Manager |

Dizcovery Probes Probe Details

_4Probes Probe IPs: Mone

Last time probe accessed | Never Accessed

WERITASCluster
]

J Corlct =
§ Mortgagespp
L) appdarain

Description

[m] 5 Click the Add IP Range button to open the Add IP Range window.

6 Enter the range of IP addresses that includes the IP address of the Discovery
Probe you want to discover. If there is only one address, enter its value in
both boxes.

7 Click OK.
8 Click Apply to save the changes you have made.
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9 Expand the Discovery Probe:

Digcavery Probes

_ 4 Probes

EN T Y /ERITASCluster

—p ¥ JBOSS Protocal

¥ NTCMD Protocal

¥ SAP JMX Protocal

¥ SAP Protocal

_D,-EI Siehel Gateway Protocol
¥ SHMP Protocal

¥ S@L Protocal

¥ S3H Protocal

_D,-EI Telnet Protocol

¥ Ucldli Registry Protocal
_D,-EI Wehlogic Protocol
_D,-EI Wehszphere Protocol

T il Protocal

10 Define the following protocols:

» Select SSH Protocol, and click the Add new connection details for the
selected protocol type button. Enter values for the following fields:

> User Name. The name of the user you use to connect to the host as
administrator.

» User Password. The password of the user you use to connect to the
host as administrator.

> Key Path. In certain environments, the Key Path is required to connect
to an SSH agent.

> Port Number. By default a an SSH agent uses port 22. If you are using a
different port for SSH in your environment, enter the required port
number.

» Select Telnet Protocol, and click the Add new connection details for the
selected protocol type button. Enter values for the following fields:

> User Name. The name of the user you use to connect to the host as
administrator.

» User Password. The password of the user you use to connect to the
host as administrator.
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> Port Number. By default a Telnet agent uses port 23. If you are using a
different port for Telnet in your environment, enter the required port
number.

11 Click Apply to save the changes.

Step 2 - Running the Discovery Patterns

To run the discovery process, you must activate the discovery patterns
described in the table below. Each discovery pattern discovers different
components. For details on the components that are discovered by the
patterns, see “Cls Discovered by the Discovery Process” on page 165.

Note: For details on how to activate a discovery pattern, see “Running the
Discovery Process” on page 25.

To run the Veritas Cluster discovery:

Click the Module Manager tab. Expand the modules, select the following
patterns, and activate them:

Expand Module Activate Pattern Description
Network — Protocol TTY_NET_Dis_ Discovers, in the range of
Connections Connection given IP addresses, the hosts

that communicate using the
SSH/Telnet protocol when
working with the UNIX
platform.

Host Resources — SSH/Telnet TTY_HR_Process Discovers the HAD processes
that are running on the
cluster’s nodes.

Veritas Cluster Veritas_Cluster_Topology Discovers Veritas Cluster
server architecture by TTY.
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Step 3 - Checking that the Discovery Ran Correctly

After running all the discoveries, check that all the information is displayed
correctly.

To check that the discovery ran correctly:
1 Select Admin > CMDB.
2 Click the IT Universe tab.
3 In the Folders pane, select the view called Veritas cluster server.

The following view depicts the Veritas Cluster Server topology.

Viantas Cluster
-
SOL-Clustert
member member
mamber
mamber
[ q
- J -l
dagran: labmZsun05.ma 0. dangarous
nodes

This view shows the top layer of the Veritas Cluster topology. It displays the
discovered Veritas Cluster and the nodes that are members of that cluster.
Each member node is linked by a member relationship to the Veritas
Cluster.

Veritas Clusters contain multiple nodes. Each node is responsible for
running certain services and applications. The nodes are used as backups for
one another. When a system components fails, another node takes over to
provide the necessary service.
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Double-click the required node to drill down to the CIs folded underneath.

}

o
member SOLClustenl
membel T CoMaing_f
mgmher — container_f
e b -
) - 3 J
e 4 i
petra dagranat  dangersus labem2sun3.mercury o i
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Prefeired Chvmer
Piefened Owaner
Pietenied Owinei
a v ¥ - v
2.£) b, T
SALI_Grouip SOL1 ) Greasp SOL2_Grup
camainer_{ " carkir_f
cophairer ¢ et _1 conkaner_t container_{ contaner_ -
conthinkprfalner_f ot AREd e f ol siner_f
i Ll ¥ ¥ . & " " . ¥ ¥ e i
-ll. j. 4 l'l. ". ‘ lj. ‘. d J- l. 4 ". | I- 4 ’. l‘ " l. l.
mysql_3 dadg proxyd ddmount wilbs3_ip miysql_1 it wilbl_nic disidg vilsi_ip iyl _2 d2dg wilbs2_ip d2meant
) The resouce
Ventas Cluster group coRisnad i the
qroup

This view displays the Veritas Cluster groups and the resources contained in
each group.

A Veritas Cluster group is a collection of dependent or related resources that
is managed as a single unit. Each Veritas Cluster group is linked to a
designated node, which is responsible for activating the resources contained
in the group. The node is linked to the group by a Preferred Owner
relationship. If a failure occurs in the designated node, then the

responsibility for activating the resources is switched over to a different
node.

Certain resources in each group are dependent on one another. Resources
that are dependent on one another are linked by a Dependent relationship.

The figure below shows the following dependencies:

» db1dg is dependent on db1mount
» db1mount is dependent on mysql_1

» vdbs1_nic is dependent on vdbs1_ip
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> vdbs1_ip is dependent on mysql_1

[ Ay
_RI(
SOL1_Group
) container_f
contairier_f |
container_f :
) container_f
5 LRy depend
depend | o
Zid, o7,
db1mount container_f vdbsi_ip
“depend L b
b i depend
JJ
db1dg %
vdhs1_nic

Cis Discovered by the Discovery Process

You can view the CIs discovered by the Veritas Cluster discovery.
To view the Cls discovered by the Veritas Cluster discovery:

In Mercury Business Availability Center, select Admin > CMDB.
Click the Discovery Manager tab.

Click the Module Manager tab.

In the Discovery Modules pane, expand the Veritas Cluster module.

©i,. h W N =

Select the Veritas_Cluster_Topology pattern.
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In the Details View tab, the Statistics table at the bottom displays the CIs
discovered by the Veritas Cluster discovery.

E W etk - Layer2
& Metweark - Protocol Connections
+- gl Metwork - TCP Discovery

= 5 “eritas Cluster

ter_Topology

.J Wieh Servers - Basic

.J Wiebsphere_hG

+ ,J Wik Servers - HS
o wieh Servers - IS
4

L

B L@

-

Statistics: (Last update time: Sun Aug 20 10:35:51 IDT 2006)

CIT

Created Updated Deleted ¥ Discovered

Weritas Cluster

Crenier

WCS Group

Host

hember

Depend

WIS resource

Configuration File

Container link

Total

HEIEEEEEEEE

HEIEEEEEEEE
=
X

F A= =3 =N =N =] =N =]

The following table contains a description of the discovered ClIs.

Display Name Cl Type Description

Container link contained The relationship that links the discovered
resource to the group to which it belongs.

Configuration File configfile The configuration files for the nodes, groups
and resources.

Host host The Veritas Cluster nodes.

IP ip

Veritas Cluster veritascluster The discovered Veritas Cluster instance.

VCS Group vesgroup Veritas Cluster groups.

VCS Resource vesresource Veritas Cluster resources.

Member member The relationship that links the Veritas Cluster
to its nodes.

Owner owner The relationship that links the nodes to its
groups.

Depend depend The relationship that links the dependent
resources within their group.

Oracle oracle
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Troubleshooting

i, & W N =

(=)}

This section provides information that can help troubleshooting some of
the problems that can occur when performing a Veritas Cluster discovery.

Problem. Failure to connect to the TTY (SSH/Telnet) agent.

Solution. To troubleshoot connectivity problems with the TTY (SSH/Telnet)
agent, use a utility that can verify the connectivity with the TTY
(SSH/Telnet) agent. An example of such a utility is the client tool PuTTY.

Problem. Failure to access the requested main.cf file.

Solution. The location of the main.cf file is defined in the discovery pattern.
If the main.cf file is not found at the defined location, then you can set the
location in the Pattern Parameters tab in the Pattern Editor of the Discovery
Manager.

To set the location of the main.cf file:

In Mercury Business Availability Center, select Admin > CMDB.
Click the Discovery Manager tab.

Click the Module Manager tab.

In the Discovery Modules pane, expand the Veritas Cluster module.

Double-click the Veritas_Cluster_Topology pattern to open the Pattern
Editor.

Click the Pattern Parameters tab.

7 For the parameter main_cf_path, enter the location of the main.cf file in the

Value field if you do not want to use the default value in the Description
field.

Click OK to save your changes.
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Performing an SNMP Host Resources

Discovery

This chapter explains how to discover hosts in your network that contain an

SNMP agent.

This chapter describes: On page:
Step 1 - Preparing for an SNMP Discovery 170
Step 2 - Running the Discovery Patterns 173
Step 3 — Checking that the Discovery Ran Correctly 174
CIs Discovered by the Discovery Process 175
Troubleshooting 176

Note: For details about how to perform a discovery, see “Running the

Discovery Process” on page 25.

169




Chapter 8 » Performing an SNMP Host Resources Discovery

Step 1 - Preparing for an SNMP Discovery

W N =

Before you run an SNMP discovery, you must add a discovery probe and
define the protocols as indicated in this section.

Note: Ensure that the Discovery Probe is running.

To prepare for an SNMP discovery:

In Mercury Business Availability Center, select Admin > CMDB.
Click the Discovery Manager tab.

Click the Probe Manager pane.

In the Discovery Probes pane, select the relevant Discovery Probe.

Module Manager  Probe Manager I

Discovery Probes Probe Detail=

_ 4 Probesz Probe P Mone
Lazt titne prokbe

Description

=S

5 Click the Add IP Range button to open the Add IP Range window.

6 Enter the range of IP addresses that includes the IP address of the probe you

10
11

170

want to discover.

Click OK.

8 Click the Add IP Range button to open the Add Range window once more.

Enter the range of IP addresses that includes the system with the SNMP
agent you want to discover. If there is only one address, enter its value in
both boxes.

Click OK.
Click Apply to save the changes you have made.
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12 Expand the Discovery Probe:

13

14

~Dizcovery Probes

4 Probes

DefaultProbe
= SMMPProke

¥ JBOSS Protoco
— I MTCMD Protoce
T SAP JMX Proto
-1 S&P Protocol

_D/-EI Siebel Gateway
— shwP Protocol
¥ S6L Protocol

— ==H Protocol

—I Telnet Protocal
I i Reegsistry P
—I Wighlogic Proto
—I Wighsphere Pri

I vl Protocol

Note: Mercury Business Availability Center supports SNMP versions v1, v2,
and v3.

Select SNMP Protocol, and click the Add new connection details for the
selected protocol type button. The Add Protocol Parameters dialog box
opens.

Populate the following fields:

» (For SNMP v1 and SNMP v2 only) Community. Enter the password you
used when connecting to the SNMP service community you defined
while configuring the SNMP service (for example, a community for
read-only or read/write).

» (For SNMP versions v1, v2, and v3) Port Number. The port number on
which the SNMP agent listens.

» (For SNMP v3 only) User Name. The name of the user authorized to log
on to the management application.

» (For SNMP v3 only) User Password. The password used to log on to the
management application.
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» (For SNMP v3 only) V3 — Authentication method. Select one of the
following options for securing the access to management information:

» NoAuthNoPriv. Using this option provides no security, confidentiality,
or privacy at all. It might be useful for certain applications, such as
development and debugging to turn security off. This option requires
only a user name for authentication (similar to requirements for v1
and v2).

» AuthNoPriv. The user logging on to the management application is
authenticated by the SNMP v3 entity before the entity allows the user
to access any of the values in the MIB objects on the agent. Using this
option requires a user name, password and the authentication
algorithm (HMAC-MDS or HMAC-SHA algorithms).

> AuthPriv. The user logging on to the management application is
authenticated by the SNMP v3 entity before the entity allows the user
to access any of the values in the MIB objects on the agent. In
addition, all of the requests and responses from the management
application to the SNMP v3 entity are encrypted, so that all the data is
completely secure. This option requires a user name, password and an
authentication algorithm (either (HMAC-MDS or HMAC-SHA).

» (For SNMP v3 only) V3 Authentication algorithm. Two algorithms are
supported: MDS and SHA.

» (For SNMP v3 only) V3 Privacy algorithm. The following algorithm is
supported: DES.

> (For SNMP v3 only) V3 Privacy key. The secrete key used to encrypt the
scoped PDU portion in an SNMP v3 message.

15 Click OK to save the changes.

172



Step 2 - Running the Discovery Patterns

Chapter 8 ¢ Performing an SNMP Host Resources Discovery

To run the discovery patterns, you must trigger them in the order described
in this section. Fach discovery pattern discovers different components. For
details on the components, see “Cls Discovered by the Discovery Process”

on page 175.

To run the discovery patterns:

Click the Module Manager tab. Expand the modules, select the patterns, and

activate them.

Important: You must first activate the SNMP_NET_Dis_Connection pattern
before activating the other patterns on this list.

Expand Module

Activate Pattern

Description

Network — Protocol
Connections

SNMP_NET_Dis_Connection

Discovers the elements or
devices in the network on
which SNMP is running.

Host Resources - SNMP

SNMP_HR_OSUser

Discovers the users on the
discovered machine.

SNMP_HR_Printq

Discovers the print queue on
the discovered machine.

SNMP_HR_Process

Discovers the processes
running on the discovered
machine.

SNMP_HR_Software

Discovers the installed software
on the discovered machine.

SNMP_HR_Service

Discovers the services running
on the discovered machine.

SNMP_HR_Disk

Discovers the disks on the
discovered machine.
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Step 3 - Checking that the Discovery Ran Correctly

After running all the discoveries, check that all the information is displayed
correctly.

To check that the discovery ran correctly:
Select Admin > CMDB.
2 Click the IT Universe tab.

3 In the Folders pane, select the view called Host Resources.

The following figure depicts the topology of the Host Resources view:

L~ Host ™

Cr:untainerlilllj_,/ 4 \ g R“‘x_\_Container link

c iner linf—
/Cﬁn/tain;r{l&k : \DH}HQ?I ”: : i
ontainec, Contatmer link
2 /- % e
4 7 \ S 2y
» Gyl 4 4 .
T & {1 & T S
Deamon Disk IP Mem'gw CPLU FProgram

This Host Resources view shows the hosts that were discovered in the
system. The host contains the discovered Services, Disks, Print Queues,
Processes and Programs discovered in the system.

Important: The IP CI is folded underneath the Host icon. In the Host
Resource view, only the IP icon must appear in the view. All the other ClIs,
such as Disks, Services, and so forth, are optional.
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Cis Discovered by the Discovery Process

You can view the CIs discovered by the SNMP HR discovery.

To view the Cls discovered by the SNMP HR discovery:

h W N =

In Mercury Business Availability Center, select Admin > CMDB.
Click the Discovery Manager tab.
Click the Module Manager tab.

In the Discovery Modules pane, select the Host Resources SNMP module.

In the Details View tab, the Statistics table displays the Cls discovered by the
SNMP HR discovery.

—¥ =, SNMP_HR_Disk

2 SMMP_HR_OSUser

* =

=, SMMP_HR _Printg
s =, SMMP_HR_Process

» =, SNMP_HR_Service

+ =, SNMP_HR_Software
B¢ Host Resources - SSHITelne
— =2 TTY_HR_A

— = TT¥ HR Process

W L D

—Statistics: (Last updste time: Tue Aug 29 14:41:02 DT 20087

CIT Created Updiated Deleted
Cartainet link 474 0 ]
Dizk 10 0 ]
05 User 13 ] ]
Progratn 136 ] 0
Service 144 0 ]
Softweare 166 ] ]
Total 948 0 ]

The following table contains a description of the discovered CIs.

Display Name Cl Type Description

Container link container_f The relationship that links the discovered resource
to the group to which it belongs.

OS User osuser (Discovered by the SNMP_HR_OSUser pattern)
The OS users defined on the discovered machine.

Print Queue printq (Discovered by the SNMP_HR_Printq pattern) The
print queue on the discovered machine.

Program program (Discovered by the SNMP_HR_Process pattern)
The programs running on the discovered
machine.
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Display Name Cl Type Description

Software software (Discovered by the SNMP_HR_Software pattern)
The installed software on the discovered machine.

Service service (Discovered by the SNMP_HR_Service pattern) The
running services on the discovered machine.

Disk disk (Discovered by the SNMP_HR_Disk pattern) The
disks on the discovered machine.

Troubleshooting

This section provides information that can help troubleshooting some of
the problems that can occur when performing an SNMP HR discovery.

Problem. Failure to collect information from SNMP devices.

> Solution 1. Verify that you can actually access information from your
Network Management station by using a utility that can verify the
connectivity with the SNMP agent. An example of such a utility is GetIf.

» Solution 2. Verify that the connection data to the SNMP protocol has been
defined correctly in the Add Protocol Parameters dialog box. For details, see
“Step 1 — Preparing for an SNMP Discovery” on page 170.

> Solution 3. Verify that you have the necessary access rights to retrieve data
from the MIB objects on the SNMP agent.
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Performing an IIS Discovery

This chapter describes the steps involved in discovering (Internet
Information Services) IIS elements and topology in your organization.

This chapter describes: On page:
Step 1 - Preparing for an IIS Discovery 178
Step 2 - Running and Configuring the Discovery Patterns 180
Step 3 — Checking that the Discovery Ran Correctly 181
ClIs Discovered by the Discovery Process 183

Note: Mercury Business Availability Center supports IIS versions 5 and 6.
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Step 1 - Preparing for an IIS Discovery

178

h W N =

Before you run an IIS discovery, you must add a discovery probe and then
define the NTCMD protocol as described in this section. For details about
how to perform a discovery, see “Running the Discovery Process” on
page 25.

Note: Ensure that the Discovery Probe is running.

To prepare for an IIS discovery:

In Mercury Business Availability Center, select Admin > CMDB.
Click the Discovery Manager tab.

Click the Probe Manager pane.

In the Discovery Probes pane, select the relevant Discovery Probe.

Discovery Probes Probe Details

| F:robes Probe IPs: None

¢

g DefaultProbe
Probe I15Probe

Laszt tirme probe

—

5 Click the Add IP Range button to open the Add IP Range window.
6 Enter the range of IP addresses that includes the IP address of the probe you

want to discover. If there is only one address, enter its value in both boxes.
For details, see “Rules for Defining an IP Address Range” on page 39.

7 Click OK.

8 Click Apply to save the changes you have made.
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9 Expand the Discovery Probe:
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10 Select NTCMD Protocol, and click the Add new connection details for the
selected protocol type button. The Add Protocol Parameters dialog box

opens.

11 Populate the following fields:

» Windows Domain. The name of the domain that includes the host where

discovery probe is installed.

» User Name. The name of the user you use to connect to the host as

administrator.

» User Password. The password of the user you use to connect to the host

as administrator.

12 Click OK to save the changes.
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Step 2 - Running and Configuring the Discovery Patterns

180

Each discovery pattern discovers different elements. For details on the
discovered elements, see “Cls Discovered by the Discovery Process” on
page 183.

This section contains the following topics:

> “Configuring the NTCMD_APP_Dis_IIS Pattern” on page 180

» “Running the Discovery Patterns” on page 180

Configuring the NTCMD_APP_Dis_IIS Pattern

You can set the configuration of the NTCMD_APP_Dis_IIS pattern to define
whether web services are discovered or not.

To define whether web services are discovered:

Click the Module Manager tab. Double-click the NTCMD_APP_Dis_IIS
pattern to open the Pattern Editor.

Click the Pattern Parameters tab.

3 In the Discovery Pattern Parameters area, enter one of the following in the

Value column of the do_web_service parameter:

» True if you want the NTCMD_APP_Dis_IIS pattern to discover web
services.

» False if you do not want the NTCMD_APP_Dis_IIS pattern to discover
web services.

Note: The default is True.

Click OK.

Running the Discovery Patterns

This section describes the patterns you need to run for an IIS discovery.



To run the discovery patterns:
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In the Module Manager tab, expand the modules, select the following
patterns, and activate them.

1 Verify that the following patterns are already running:

Expand Module

Activate Pattern

Description

Network — Protocol
Connections

NTCMD_ NET_Dis_Connection

Discovers NTCMD connections to
the remote machine.

Network — Advanced

TCP_NET_Dis_port

Discovers the HTTP ports defined in
the portNumberToPortName.xml
file. If there are ports that need to be
discovered that are not defined in
the portNumberToPortName.xml
file, they must be added.

Web Servers — Basic

TCP_Webserver_Detection

Discovers the CIs on which IIS is
running and the IIS version.

2 Activate the following pattern:

Expand Module

Activate Pattern

Description

Web Servers - IIS

NTCMD_APP_Dis_IIS

Discovers IIS topology by
connecting to the remote machine
using NTCMD and running the IIS
administration Adsutil.vbs utility.

Step 3 - Checking that the Discovery Ran Correctly

After running all the discoveries, check that all the information is displayed

correctly.

To check that the discovery ran correctly:

1 Select Admin > CMDB.
2 (Click the IT Universe Manager tab.

3 In the Folders pane, select the view called 1I1S_Topology.
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The following depicts the topology of the IIS_Topology view:
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The dependency graph for the IIS Web Site node is defined as follows:

1’4 Dependency List x|

—Dependencies

Node 1 | Relationship | Node 2 |
ek Service Container link Configuration File ‘I
1= Wik Dir Cortainer link 1= Wik Diir
|IIS Wik Dir Containg ek Service
|Web Service Container link Wik Service Operation
|IIS Wb Site Cartainer link IS Wyeb Dir ﬂ

Deptrs | 5= =] [=]
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Cis Discovered by the Discovery Process

You can view the CIs discovered by the IIS discovery.

To view the Cls discovered by the IS discovery:

In Mercury Business Availability Center, select Admin > CMDB.

Click the Discovery Manager tab.
Click the Module Manager tab.

h W N =

In the Discovery Modules pane, select the NTCMD_APP_Dis_IIS pattern.

In the Details View tab, the Statistics table displays the Cls discovered by the
1IS discovery.

+~ W Neflinks - Passive Melwork Cor| [ e s
- i, Network - Advanced Staistics: (Last upcste tine: Sat Sep 02 16:39:25 IDT 2008)
- @ Network - Basic oo Io’ea"Ed IUnﬂdeﬂ
[ i Metwark - Credentisl Less Discr [ JRjCcrfiguration Fiie 34 o
£ @ Netorork - Laver2 (Coritaires itk 374 o
' el = Lanres, P |contains 32 0
-3 Gl Metwork - Protocol Connection IS FTP Service n 0
[ @ Metwark - TCP Discovery IS FTP Ste 4 0
- B Vertas Cluster IS SMTP Service 4 0
L o e o IS Virtusl Dir 37 0
T -’} rvers - Hasic IS Wik Dir 33 o
i~ I Web Servers - HS IS Wik Service & Io
=Y web Servers - IS IS Web Site 13 0

el W TCHD_APP Dis IS perver Purt i {3

-
[ i Websphere_MQ iz i 0
i sprere. Wb Server Virtusl Host 22 o
- @ others Wb Service 19 i)
Web Service Operation __[208 ____________________ 10 _
Total 843 a5

The following table contains a description of the Cls discovered by the
NTCMD_APP_Dis_lIS discovery pattern.

Display Name Cl Type Description

1IS Resource iisresource An abstract CIT from which all IIS resources
inherit.

1IS Service iisservice An abstract CIT from which all IIS services
inherit.

1S Web Service iiswebservice The World Wide Web Publishing Service for
hosting Internet and intranet content.
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Display Name

Cl Type

Description

IIS FTP Service

iisftpservice

The File Transfer Protocol (FTP) service for
hosting sites where you can upload and
download files.

IIS SMTP Service

iissmtpservice

The Simple Mail Transfer Protocol (SMTP)
service for sending and receiving e-mail
messages.

11S Application Pool

issapppool

A group that contains specific Web
applications and Web sites. For example, if
you want to separate Web sites running in the
same computer, you create a separate
application pool for every Web site and place
them in their corresponding application pool.

Note: This is relevant for IIS 6.0 only.

1S Web Site

iiswebsite

A Web site that represents a web application
in IIS.

IS FTP Site

iisftpsite

A Web site in which you can upload or
download files.

11S Web Dir

iiswebdir

A local or home directory that contains the
published Internet content.

1IS Virtual Dir

iisvirtualdir

A directory that is not contained in the home
directory but appears to client browsers as
though it were. It allows you to publish from
any directory not contained within your
home or root directory.

Web Service

webservice

Web Service.

Web Service Operation

webservice_operation

Web Service operation.
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Performing a WeblLogic Discovery

This chapter includes the steps involved in performing a WebLogic

discovery.
This chapter describes: On page:
Performing a WebLogic Discovery 186
Step 1 - Preparing for a WebLogic Discovery 186
Step 2 - Running the Discovery Patterns 188
Step 3 — Checking that the Discovery Ran Correctly 189
CIs Discovered by the Discovery Process 190

Note: For details about how to perform a discovery, see “Running the
Discovery Process” on page 25.
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Performing a WeblLogic Discovery

The WebLogic discovery process discovers all the deployed web services and
operations deployed on the WebLogic server. Mercury Business Availability
Center supports WebLogic versions 8 and 9.

Note: If you are using WebLogic version 7, do the following:

» Take the webserviceclient.jar and weblogic.jar files from the following
location: <BEA Installation root folder>\<WebLogic version
number>\server\lib.

» Place both jar files in the following location: <Discovery Probe
Installation root folder>\root\lib\collectors\probeManager\userExt.

> Rename the jar files by adding a suffix that includes the WebLogic
version number, as follows: webserviceclient70.jar, weblogic70.jar.

Step 1 - Preparing for a WebLogic Discovery

186

Before you run a WebLogic discovery, you must add a discovery probe and
then define the WebLogic protocol as described in this section.

Note: Ensure that the Discovery Probe is running.

To prepare for a WebLogic discovery:
1 In Mercury Business Availability Center, select Admin > CMDB.
2 Click the Discovery Manager tab.
3 Click the Probe Manager pane.
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4 In the Discovery Probes pane, select the relevant Discovery Probe.

Module Manager  Probe Manader |

~Dizcovery Probes

4 Probes

&9 DetauttProbe
ehlogicProbe

5 Click the Add IP Range button to open the Add IP Range window.

6 Enter the range of IP addresses that includes the IP address of the WebLogic
servers you want to discover. If there is only one address, enter its value in
both boxes. For details, see “Rules for Defining an IP Address Range” on
page 39.

7 Click OK.
8 Click Apply to save the changes you have made.
9 Expand the Discovery Probe:

Module Manager  Probe banager |

~Discovery Probes

4 Probes

£ DefauttProbe
= \WeblLogicProbe

—p-U JBOSS Protocal

— I MTCMD Pratocal

U SAP JMX Protocal
—p-U SAP Protocal

Y Siebel Gatewesy Protoct
— smP Protocal

- SaL Protocal

—& ==H Pratacal

—I Telnet Protocol

¥ Ucldli Registry Protocal
_D,-EI Wehlogic Protocol
—I Wehszphere Protocol

T Wl Protocal
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(2]

10 Select WebLogic Protocol, and click the Add new connection details for the

11

selected protocol type button. The Add Protocol Parameters dialog box
opens.

Populate the following fields:

¢ User Name. The name of the user you use to connect to the host as
administrator.

& User Password. The password of the user you use to connect to the host
as administrator.

12 Click OK to save the changes.

Step 2 - Running the Discovery Patterns

188

To run the discovery patterns, activate the following discovery patterns.
Each discovery pattern discovers different elements. For details on the CIs
that are discovered, see “Cls Discovered by the Discovery Process” on
page 190.

To run the discovery:

Click the Module Manager tab. Expand the modules, select the patterns, and
activate them in the following order.

Note: Before activating the following patterns, verify that you have already
run the following patterns:

» Host_ID_Discover
» ICMP_NET Dis_IpC

Both of these patterns are under the module Network-Basic.




Chapter 10 * Performing a WebLogic Discovery

1 First activate this pattern.

Expand Module Activate Pattern Description

J2EE WebLogic JMX_J2EE_Weblogic_Connection | Discovers WebLogic servers based on
the JMX protocol.

2 Then activate this pattern.

Expand Module Activate Pattern Description

J2EE WebLogic JMX_J2EE_Weblogic Discovers a WebLogic J2EE
environment and its components.

Step 3 - Checking that the Discovery Ran Correctly

After running all the discovery patterns, check that all the information in
the WebLogic_Topology view is displayed correctly.

For information on which ClIs are discovered, see “Cls Discovered by the
Discovery Process” on page 190.

To check that the discovery ran correctly:
1 Select Admin > CMDB.
2 Click the Topology Map tab.
3 In the Folders pane, select the view called WebLogic_Topology View.
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The following depicts the topology of the WebLogic_Topology view:
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Cis Discovered by the Discovery Process
You can view the CIs discovered by the WebLogic discovery process.

To view the Cls discovered by the WebLogic discovery:
1 In Mercury Business Availability Center, select Admin > CMDB.
2 Click the Discovery Manager tab.
3 Click the Module Manager tab.

4 In the Discovery Modules pane, select the JMX_J2EE_WebLogic_Connection
pattern.

In the Details View tab, the Statistics table displays the Cls discovered by the

WebLogic discovery.
Statistics: (Last update time: Thuy Sep 07 15:37:50 DT 2006)
@ CIT I Created Updated Deleted
j Cantainer link 1 0 0
J2EE Server 1 0 0
£ [Total 2 0 0
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The following table contains a description of the Cls discovered by the
WebLogic discovery process.

Display Name Cl Type Description

Configuration File configfile Holds data regarding a configuration
file of an application.

Connection Pool connectionpool

Contained contained The relationship between two ClIs
whereby a second CI is included in the
first CI. This relationship is found only
between IP and host.

Container link container_f The functional relationship between a
parent and a child. The child does not
inherit any properties.

Contains contains The relationship between two ClIs
whereby a second CI is included in the
first CI.

Database database A collection of data that is organized so
that its content can be easily accessed,
managed and updated.

Depend depend The relationship wherein one CI needs
a functionality of another CI.

Deployed deployed The relationship wherein one CI is put
into action by another CI.

Document document Holds data regarding a document in the
application.

EJB Module ejbmodule A module containing an EJB system.

Entity Bean entitybean An EJB entity.

J2EE Execute Queue executequeue

Host host Represents a network element that has
a unique IP address.
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Display Name

Cl Type

Description

IP

ip

Represents an IP address that identifies
the sender to receiver of information
that is sent across the internet.

J2EE Application

j2eeapplication

An application inside the application
Server.

J2EE Cluster

j2eecluster

J2EE Domain j2eedomain An application server domain.

J2EE Server j2eeserver A server within a J2EE application
server.

J2EE Socket j2eesocket

JDBC Data Source jdbcdatasource A JDBC data source.

JMS Destination

jmsdestination

JMS destination.

JMS Server jmsserver A JMS server.
JVM jvm JVM.
Member member The relationship between two ClIs

whereby one CI is included in another
CL

Message Driven Bean

messagedrivenbean

Servlet

servlet

SQL Database

sqldatabase

An SQL database from Microsoft.

Statefull Session Bean

statefulsessionbean

Stateless Session Bean

statelesssessionbean

Use use
Web Module webmodule A J2EE deployed CI.
Web Service webservice A web service.

Web Service Operation

webservice_operation

A web service operation.
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Performing a WebSphere Discovery

This chapter describes the steps involved in performing a WebSphere

discovery.
This chapter describes: On page:
Performing a WebSphere Discovery 194
Step 1 - Preparing for a WebSphere Discovery 194
Step 2 - Running the Discovery Patterns 197
Step 3 — Checking that the Discovery Ran Correctly 198
CIs Discovered by the Discovery Process 199

Note: For details about how to perform a discovery, see “Running the
Discovery Process” on page 25.
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Performing a WebSphere Discovery

The WebSphere discovery discovers the Web services that are deployed on
an IBM WebSphere server. The discovered Web services are represented by a
webservice CI in the CMDB.

Note: Mercury Business Availability Center supports WebSphere versions 5
and 6.

Step 1 - Preparing for a WebSphere Discovery

194

h W N =

Before you run a WebSphere discovery, you must define the protocols as
indicated in this section.

Note: Ensure that the Discovery Probe is running.

To prepare for a WebSphere discovery:

In Mercury Business Availability Center, select Admin > CMDB.
Click the Discovery Manager tab.

Click the Probe Manager tab.

In the Discovery Probes pane, select the relevant Discovery Probe.

Module Manager  Probe Manager I

Discovery Probes Probe Detail=
_ 4 Probes Probe IP=: Mo
DefauttProbe ;

] ’ ) Lazt time prot
WogicWServices L
".E AT Description
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5 Click the Add IP Range button to open the Add IP Range dialog box.

6 Enter the range of IP addresses that includes the IP address of the discovery
probe. If there is only one address, enter its value in both boxes. For details,
see “Rules for Defining an IP Address Range” on page 39.

7 Click OK.

8 Click the Add IP Range button to open the Add IP Range dialog box once
more.

9 Enter the range of IP addresses that includes the IP address of the WebSphere
server(s) you want to discover. If there is only one address, enter its value in
both boxes.

10 Click OK.
11 Click Apply.
12 Expand the Discovery Probe:

Module Manager  Probe banager |

Digcavery Probes

DefauttProke
WlogicWservices
WehSphereProbe

—p-U JBOSS Protocal

— I NTCMD Pratocal
U SAP JMX Protocal
U SAP Protocal

_D,-EI Siehel Gateway Protocol
B SnmP Protocol

¥ S@L Protocal

— ==H Protocal

—I Telnet Protocol

— Uddi Registry Protocol
—I Wehlogic Protocol
—I Wehszphere Protocol

I vl Protocal

13 Select WebSphere Protocol, and click the Add new connection details for
the selected protocol type button.

14 Ask the WebSphere system administrator for the following:

¢ Username. The name of the user you use to connect to the host as
administrator.
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196

¢ Password. The password of the user you use to connect to the host as
administrator.

¢ Truststore file. The name of the SSL truststore file.

Mercury Business Availability Centercontains a default truststore file
called DummyClientTrustFile. It is located in the userEXT folder
contained in the J2EE package. If you want to use a file other than the
default truststore file provided by the system, enter the name of your
own truststore file and place it in the userEXT folder. When the package
is updated, the truststore file is copied to the relevant location.

¢ Truststore password. The SSL truststore password.

Note: The default password for the default truststore file in Mercury
Business Availability Center is WebAs. If you are not using the default
truststore file provided by the system, enter the password for the file you are
using.

¢ Port Number. The protocol port number as provided by the WebSphere
system administrator.

You can also retrieve the protocol port number by connecting to the
Administrative Console using the username and password provided by
the WebSphere system administrator.

In your browser, enter the following URL: http:/<host>:9090/admin,
where:

e <host> is the IP address of the host running the WebSphere protocol
¢ 9090 is the port used to connect to the WebSphere console

Then go to System Administration > Deployment Manager to retrieve the
required port number.
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Step 2 - Running the Discovery Patterns

To run the discovery patterns, activate the following discovery patterns.
Each discovery pattern discovers different elements. For details on the CIs
that are discovered, see “Cls Discovered by the Discovery Process” on
page 199.

Note: For details about how to perform a discovery, see “Running the
Discovery Process” on page 25.

To run the discovery patterns:

Click the Module Manager tab. Expand the modules, select the patterns, and
activate them in the following order.

Note: Before activating the following patterns, verify that you have already
run the following patterns:

» Host_ID_Discover
» ICMP_NET_Dis_IpC

Both of these patterns are under the module Network-Basic.

1 First activate this pattern.

Expand Module Activate Pattern Description
JMX_J2EE JMX_J2EE_WebSphere_ Discovers WebSphere servers based
Connection on either SOAP or RMI
authentication.
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2 Then activate this pattern.

Expand Module Activate Pattern Description

JMX_J2EE JMX_J2EE_WebSphere Discovers the WebSphere J2EE
environment and components.

Step 3 - Checking that the Discovery Ran Correctly

After running all the discovery patterns, check that all the information in
the WebSphere_Topology view is displayed correctly.

For information on which ClIs are discovered, see “Cls Discovered by the
Discovery Process” on page 199.

To check that the discovery ran correctly:
1 Select Applications > Dashboard.
2 (Click the Topology Map tab.
3 In the Folders pane, select WebSphere_Topology View.
The following depicts the topology of the WebSphere_Topology view:
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Cis Discovered by the Discovery Process

You can view the CIs discovered by the WebSphere discovery process.

To view the Cls discovered by the WebSphere discovery:

1 In Mercury Business Availability Center, select Admin > CMDB.
2 Click the Discovery Manager tab.
3 Click the Module Manager tab.
4 In the Discovery Modules pane, select the JMX_J2EE_WebSphere_
Connection pattern.
The following table contains a description of the Cls discovered by the
WebSphere discovery process.
Display Name Cl Type Description
Configuration File configfile Holds data regarding a configuration file

of an application.

Container link

container _f Represents a containment relationship
between two Cls.

Contains container_f The relationship between two ClIs
whereby a second CI is included in the
first CI.

Database database A collection of data that is organized so
that its content can be easily accessed,
managed and updated.

Depend depend

Deployed deployed

Document document Holds data regarding a document in the
application.

EJB Module ejbmodule A module containing an EJB system.

Entity Bean entitybean An EJB entity.

Host host Represents a network element that has a

unique IP address.
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Display Name

Cl Type

Description

J2EE Application

j2eeapplication

An application inside the application
server.

J2EE Cluster

j2eecluster

J2EE cluster.

J2EE Server j2eeserver A server within a J2EE application
server.

JDBC Data Source jdbcdatasource A JDBC data source.

JDBC Provider jdbcprovider A provider for JDBC.

JMS Server jmsserver A JMS server.

JVM jvm JVML

Member member

Message Driven Bean

messagedrivenbean

Servlet

servlet

SQL Database

sqldatabase

An SQL database from Microsoft.

Statefull Session Bean

staefulsessionbean

Use

use

Web Module

webmodule

A J2EE deployed CI.

Web Service

webservice

A Web service.

Web Service Operation

webservice_operation

A Web service operation.

WebSphere

websphere

An application server of WebSphere
based on the Java 2 platform.

200




12

Performing a UDDI Discovery

This chapter includes the steps involved in discovering Web services from a
UDDI registry.

This chapter describes: On page:
Performing a UDDI Discovery 201
Step 1 - Preparing for a UDDI Discovery 202
Step 2 — Running the Discovery Patterns 204
Step 3 — Checking that the Discovery Ran Correctly 205
ClIs Discovered by the Discovery Process 205

Note: For details about how to perform a discovery, see “Running the
Discovery Process” on page 25.

Performing a UDDI Discovery

The discovery process queries the Universal Description, Discovery and
Integration (UDDI) registry for all its Web services, including non-SOAP
services, or for a specific publisher service (if defined in the UDDI Registry
protocol). The Web services found in the UDDI registry are represented by a
webservice CI in the CMDB and the registry is created as a uddiregistry CI.
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Note: Mercury Business Availability Center supports UDDI versions 2 and 3.

Step 1 - Preparing for a UDDI Discovery

Before you run a UDDI discovery, you must add a discovery probe and
define the NTCMD protocol as described in this section.

Note: Ensure that the Discovery Probe is running.

To prepare for a UDDI discovery:
1 In Mercury Business Availability Center, select Admin > CMDB.
2 Click the Discovery Manager tab.
3 Click the Probe Manager tab.
4 In the Discovery Probes pane, select the relevant Discovery Probe.

Module Manager  Probe Manader |

Discovery Probes Prot

_ 4 Probes Pral

o
i DefaultProkbe

Las

(]

|

[m] 5 Click the Add IP Range button to open the Add IP Range window.

6 Enter the range of IP addresses that includes the IP address of the Discovery
Probe you want to discover. If there is only one address, enter its value in
both boxes. For details, see “Rules for Defining an IP Address Range” on
page 39.
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7 Click OK.

8 Click Apply to save the changes you have made.

9 Expand the Discovery Probe:

10

11

12
13

Module Manager  Probe Manader |

Discovery Probes

5, | F:robes
=4
1 JBOSS Protocol

— I NTCMD Protocal

U SAP JMX Protocol

U SAP Protocol

oY Siethel Gateway Protocal
— I SR Protocal

o S0L Protocol

— I ==H Protocal

—I Telnet Protocal

o Udeli Registry Protocol
oW Wieblogic Protocol
—I Wighaphere Protocol

T vl Protocol

El—ﬁ DefaultProbe

Select UDDI Registry Protocol, and click the Add new connection details for
the selected protocol type button. The Add Protocol Parameters dialog box
opens.

Populate the following field:
UDDI inquiry URL. The URL where the UDDI Registry is located.
Click OK to save the changes.

(Optional) To enter the name of the service publisher whose services you
want to publish, do the following:

a Click the Module Manager tab.

b Expand the Application — Webservices module.

¢ Double-click the UDDI_Registry pattern to open the Pattern Editor.
d Click the Pattern Parameters tab.

e In the Discovery Pattern Parameters area, enter the name of the service
publisher whose services you want to publish in the Value field of the
organization parameter.
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f In the Description field, enter the required description of the
organization.

g Click OK to save your changes.

Step 2 - Running the Discovery Patterns

To run the discovery patterns, activate the following discovery patterns.
Each discovery pattern discovers different elements. For details on the
discovered elements, see “Cls Discovered by the Discovery Process” on
page 20S.

To run the discovery patterns:

Click the Module Manager tab. Expand the module, select the patterns, and
activate them in the following order.

1 First activate this pattern.

Expand Module Activate Pattern Description
Application _ UDDI_Registry_Connection Discovers a UDDI registry using a
Webservices given URL.

2 Then activate this pattern.

Expand Module Activate Pattern Description
Application _ UDDI_Registry Discovers business units and web
Webservices services based on the UDDI registry.
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Step 3 - Checking that the Discovery Ran Correctly

After running all the discovery patterns, check that all the information in
the SOA UDDI view is displayed correctly. For information on which ClIs are
discovered, see “Cls Discovered by the Discovery Process” on page 205.

To check that the discovery ran correctly:
1 Select Admin > CMDB.
2 Click the Topology Map tab.
3 In the Folders pane, select SOA UDDI View.

The following depicts the topology of the SOA_UDDI_View:

LIDDI Registry
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Web Senickontainer link
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'Y u j

Weh Service Operation Configuration File

Container link

Cls Discovered by the Discovery Process
You can view the CIs discovered by the UDDI discovery.

To view the Cls discovered by the UDDI discovery:
1 In Mercury Business Availability Center, select Admin > CMDB.
2 Click the Discovery Manager tab.
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3 Click the Module Manager tab.
4 In the Discovery Modules pane, select the UDDI_Registry pattern.

In the Details View tab, the Statistics table displays the Cls discovered by the
UDDI discovery.

~Statistics: (Last update time: Wed Sep 06 13:35:03 DT 2008)

& e | created | Updated Delsted

_j Businesz Unit 17 0 1]
Business Unit link 2 ] 1]

@ Configuration File 134 2 0
Cortainer link 353 0 1]
Cortains 252 ] 1]
DD Registry 2 1] [u]
Weh Service 117 0 1]
Wieh Service Operation (249 ] 1]
Total 1156 2 0

The following table contains a description of the Cls discovered by the
UDDI_Registry discovery pattern.

Display Name Cl Type Description

Business Unit business_unit A business entity, such as a customer or
a provider.

Business Unit link business_unitlink A relationship that links between

related business entities.

Configuration File configfile A WSDL (Web Service Description
Language) file that holds data regarding
the web services. For example, which
protocols are supported and the
location of the service and the
operations.

Container link container _f Represents a containment relationship
between two Cls.

Contains contains The relationship between two ClIs
whereby a second CI is included in the
first CIL.
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Display Name Cl Type Description

UDDI Registry uddiregistry Provides a standards-based foundation
for locating services, invoking services
and managing metadata about services
(security, transport, or quality of
service). This is similar to the traditional
phone book’s yellow and white pages.

Web Service webservice Represents a web service.

Web Service Operation webservice_operation Represents a web service operation.
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Performing an SQL Discovery

This chapter explains how to discover SQL servers and their components on
your network.

This chapter describes: On page:
Step 1 - Preparing for an SQL Discovery 209
Step 2 - Running the Pre-Discovery Pattern 212
Step 3 — Running the Discovery Patterns 212
Step 4 — Checking that the Discovery Ran Correctly 213
ClIs Discovered by the Discovery Process 214

Note: For details about how to perform a discovery, see “Running the
Discovery Process” on page 25.

Step 1 - Preparing for an SQL Discovery

Before you run an SQL discovery, you must add a discovery probe and define
the protocols.

Note: Ensure that the Discovery Probe is running.
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210
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To prepare for an SQL discovery:

In Mercury Business Availability Center, select Admin > CMDB.
Click the Discovery Manager tab.

Click the Probe Manager pane.

In the Discovery Probes pane, select the relevant Discovery Probe.

Module Manager  Probe hahager |

Dizcavery Probes Probe Details—
A Probes Probe IPs: 192
MyProbez Last time proke
tyProbe |

"Descripﬂnn—

5 Click the Add IP Range button to open the Add IP Range window.

6 Enter the range of IP addresses that includes the IP address of the probe you

want to discover.

7 Click OK.

8 Click the Add IP Range button to open the Add Range window once more.

9 Enter the range of IP addresses that includes the system with the SQL agent

10
11

you want to discover.
Click OK.
Click Apply to save the changes you have made.
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12 Expand the Discovery Probe:

-Digcovery Probes

_ 4 Probes

hyProke2
(=}

¥ JBOSS Protocal
¥ NTCMD Protocol
¥ S&P JMX Protocal
¥ S&P Protocol

_D/-EI Siehel Gatesnay Protocol
oY SHMP Protocal

- SGL Protocol

¥ S3H Protocol

_D/-EI Telnet Protocal

oY Uddi Registry Protocal
_D/-EI Wighlogic Protocol
_D/-EI Wighzphere Protocol

T vl Protocol
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13 Select SQL Protocol, and click the Add new connection details for the
selected protocol type button. The Add Protocol Parameters dialog box

opens.

14 Populate the following fields:

» User Name. The name of the user you use to connect to the host as

administrator.

» User Password. The password of the user you use to connect to the host

as administrator.

» Port Number. The default port which is used by Microsoft SQL is 1433.

> Database Type. Select Microsoft SQL Server.

> Database Name. The name assigned to the SQL database.

15 Click OK to save the changes.
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Step 2 - Running the Pre-Discovery Pattern

Click the Module Manager tab. Expand the module, select the pattern, and

activate it.

Expand Module

Activate Pattern

Description

Network Advanced

TCP_NET_Dis_Port

Discovers open TCP ports on a
host of known server ports.

Step 3 - Running the Discovery Patterns

To run the discovery patterns, you must trigger them in the order described
in this section. Each discovery pattern discovers different components. For
details on the components, see “Cls Discovered by the Discovery Process”

on page 214.

To run the discovery patterns:

Note: Before running the discovery patterns, verify that the machine where

the SQL server is installed is using port 1433.

Click the Module Manager tab. Expand the modules, select the patterns, and

activate them.

Expand Module

Activate Pattern

Description

Database - SQL Server

SQL_NET_Dis_Connection

Try to connect to host with
known database port using
JDBC and SQL protocol
credentials

Database - SQL Server

SQL_APP_Dis_SqlServer

Discover Microsoft SQL Server
in detail
(SQL_NET_Dis_Connection is
a prerequisite)

212




Chapter 13 ¢ Performing an SQL Discovery

Step 4 - Checking that the Discovery Ran Correctly

After running all the discoveries, check that all the information is displayed
correctly.

To check that the discovery ran correctly:
1 Select Admin > CMDB.
2 Click the IT Universe tab.

3 In the Folders pane, select the view called SQL Server.

The following depicts the topology of the SQL Server view:

4

Host

|Container|ink
¥

sul

Containerlink 5| gepyver™ ~. Container link

~Tontairfer link!  Contamegr link T
. - - y - T &=
sul 3 Mo Cantainer link ' =
t Sa |
_ S0L Database DB User SQL Job Configuration File SOL Server Maintenance Plan
T World Links ITWorld Links
/ \ lDB Link
' 9 X
Configuration File SQLFile SQL Job

This SQL Server view shows the hosts on which an SQL server is installed.
The SQL server contains the SQL server databases, users, SQL jobs, and
configuration files of this server and maintenance plans.
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Cis Discovered by the Discovery Process

You can view the CIs discovered by the SQL discovery.

To view the Cls discovered by the SQL discovery:

h W N =

Click the Module Manager tab.

Click the Discovery Manager tab.

the SQL_NET_Dis_Connection pattern.

In Mercury Business Availability Center, select Admin > CMDB.

In the Discovery Modules pane, expand the SQL Server module and select

> In the Details View tab, the Statistics table displays the CIs discovered by
the SQL_NET_Dis_Connection pattern.

-
== :lJ Database - SALSarver

I: = SOL_APP_Dis_SglServer
EM=GL MET Dis_Connection
Lir h! Database - Sybasze
5-3: J Host Resources - MTCKD
: i Host Resources - SMMP
- @ Host Resources - SSHiTelnet
LT _l Host Resources - Wil
G- @ J2EE - wisblogic
I o J2EE - Webzphers
H- g MS Cluster

B 2 Maintrame

214

[ ToLmame | poselimt || 7 |aq | status | prove
|E| b _ports |zl Probes=> [ | MILLER |active |DetautPrabe
| ¥
|I_|= &
% Page 1= of1 11 out of
Statistics: (Last updste time: Tue Oct 31 15036:22 15T 2006, walid to: Tue Oct 31 153634 ST 2006)———
& ar Crested | Updiates | Deleted
j Cortainer link 1 1] 0
Sl Server 1 0 0
&L |Total 2 o o
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> Select the SQL_APP_Dis_SqlServer pattern. In the Details View tab, the
Statistics table displays the ClIs discovered by the SQL_APP_Dis_SqlServer
pattern.

[ Detahase - DE2

a Databasze - Oracle

;.'.I Database - Oracle THNS
ﬂ-g Database - SQLServer

,#‘ Databasze - Sybase
'j" Host Resources - MTCMD
J Host Resources - ShMP

J Host Resources - WWhil
B J2EE -wsblogic

ol JZEE -wiehzphere
L MS Cluster

;.'.I Mainframe

,#‘ Metwork - Advanced
,ﬁ" Metwork - Basic

jfﬁ Metvwork - Layer2

i metwork - TCP Discavery

— =, SQL_MET_Dis_Connection

,ﬁ" Host Resources - S5HITelnet

i‘ Metlinks - Passive Metwork Connections

;.'.l Metwaork - Credertial-less Discovery

J Metvwork - Protocol Connections

b B

~Statistics: (Last update time: Tue Oct 31 15038:52 IST 2006, valid to; Tus Oct 31 15:35;:56 ST 2008

CIT Created Upciated
Configurstion File 49 0
Contained 14 0
Container link G 0
DB Cliert 36 0
DE Link ] ]
DE Uzer 22 1
Depencd 135 0
Dirive 2 0
File i) 0
Host 14 0
IP 14 ]
Crivnier 19 0
Program 25 7
SGEL Backup ] ]
SGL Databasze 47 0
SiEL File 135 0
SGEL Job 5 ]
SGL Processes 1] 0
SiEl Server 1 0
SGL Server Maintenance Plan 1 0
Lize 43 0
Total 960 8

The following table contains a description of the discovered ClIs.

Display Name Cl Type Description

Configuration File configfile Holds data regarding a configuration file of
the SQL server.

Contained contained The relationship that links the nodes and

IPs.

Container Link

container_f

The relationship that links the discovered
resource to the group to which it belongs.

DB Client dbclient
DB Link dblink
DB User dbuser Contains all the defined users in the

database.
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Display Name Cl Type Description

Depend depend The link between resources.

Drive drive A hard disk drive.

File file An entity of data.

Host host The host represents a network element
which has a unique IP address.

IP ip Represents an IP address which identifies
the sender or receiver of information that
is sent over the internet.

Owner owner The link between a node and its groups.

Program program The name of the installed software or
application.

SQL Backup sqlbackup A backup file which was generated by the
system by or by user requests.

SQL Database sqldatabase SQL database from Microsoft.

SQL File sqlfile SQL file.

SQL job sqljob A job is a specified series of operations
performed sequentially by SQL Server
Agent. A job can perform a wide range of
activities including running Transact-SQL
scripts, command line applications, and
Microsoft ActiveX scripts.

SQL Processes sqlprocesses SQL processes.

SQL Server sqlserver SQL server.

SQL Server sqlservermaintenanceplan

Maintenance Plan

Use use Use link.
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Performing a Microsoft Cluster Server

Discovery

This chapter explains how to discover the topology of a Microsoft Cluster

Server on your network.

This chapter describes: On page:
Step 1 - Preparing for a Microsoft Cluster Server Discovery 218
Step 2 - Running the Pre-Discovery Patterns 220
Step 3 — Running the Discovery Pattern 221
Step 4 — Checking that the Discovery Ran Correctly 221
ClIs Discovered by the Discovery Process 222
Troubleshooting 224

Note: For details about how to perform a discovery, see “Running the

Discovery Process” on page 25.
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Step 1 - Preparing for a Microsoft Cluster Server Discovery

W N =

Before you run an Microsoft Cluster Server discovery, you must add a
discovery probe and define the protocols as indicated in this section.

Note: Ensure that the Discovery Probe is running.

To prepare for an Microsoft Cluster Server discovery:

In Mercury Business Availability Center, select Admin > CMDB.
Click the Discovery Manager tab.

Click the Probe Manager pane.

In the Discovery Probes pane, select the relevant Discovery Probe.

Module Manager  Probe Manager I

Discovery Probes Probe Details —
_4 Probes Praoke IPs: 192
hyProbel Last titme prokbt
Wy Probe

"Descriptinn—

5 Click the Add IP Range button to open the Add IP Range window.

6 Enter the range of IP addresses that includes the IP address of the probe you

10
11

218

want to discover.

Click OK.

8 Click the Add IP Range button to open the Add Range window once more.

Enter the range of IP addresses that includes the system with the SQL agent
you want to discover. If there is only one address, enter its value in both
boxes.

Click OK.
Click Apply to save the changes you have made.
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12 Expand the Discovery Probe:

13 Select WMI Protocol, and click the Add new connection details for the
selected protocol type button. The Add Protocol Parameters dialog box

14

15

16
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-Digcovery Probes

=

_ 4 Probes

tg hyProke2

¥ JBOSS Protocal

¥ NTCMD Protocol

¥ S&P JMX Protocal

¥ S&P Protocol

_D/-EI Siehel Gatesnay Protocol
oY SHMP Protocal

- SGL Protocol

¥ S3H Protocol

_D/-EI Telnet Protocal

oY Uddi Registry Protocal
_D/-EI Wighlogic Protocol
_D/-EI Wighzphere Protocol

T vl Protocol

opens.

Populate the following fields:

>

Click OK to save the changes.

User Name. The name of the user you use to connect to the host as

administrator.

User Password. The password of the user you use to connect to the host

as administrator

NT Domain. The name of the domain that includes the host where
discovery probe is installed.

Select NTCMD Protocol, and click the Add new connection details for the

selected protocol type button. The Add Protocol Parameters dialog box

opens.
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17 Populate the following fields:

> User Name. The name of the user you use to connect to the host as
administrator.

» User Password. The password of the user you use to connect to the host
as administrator

» Windows Domain. The name of the domain that includes the host where
discovery probe is installed.

18 Click OK to save the changes.

Step 2 - Running the Pre-Discovery Patterns

To run the discovery patterns, you must trigger them with pre-discovery
patterns in the order described in this section. Each discovery pattern
discovers different components. For details on the components, see “Cls
Discovered by the Discovery Process” on page 222.

To run the pre-discovery patterns:

Click the Module Manager tab. Expand the modules, select the patterns, and
activate them.

Expand Module Activate Pattern Description

Network - Protocol WMI_NET_Dis_Connection Try to connect to a WIN server

Connections using WMI protocol

Network - Protocol NTCMD_NET_Dis_Connection | Try to connect to a WIN server

Connections using xCmd (NetBIOS)

Host Resources - WMI WMI_HR_Service DIscover services on host using
WMI
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Step 3 - Running the Discovery Pattern
This section describes the pattern you need to activate to run the Microsoft
Cluster Server discovery.
To run the discovery pattern:
In the Module Manager tab, expand the module, select the pattern, and
activate it.
Expand Module Activate Pattern Description
MS Cluster MS_Cluster_Topology Discover Microsoft Cluster
Server architecture by NTCMD
Step 4 - Checking that the Discovery Ran Correctly

After running all the discoveries, check that all the information is displayed
correctly.

To check that the discovery ran correctly:
1 Select Admin > CMDB.
2 Click the IT Universe tab.

3 In the Folders pane, select the view called Microsoft Cluster Server.
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The following depicts the topology of the Microsoft Cluster Server view:

PN

Container linl -
ontainer '”/‘)ﬂs Cluster  pMember

-~ Contailﬁer link

* ¥
J 4

=R el i st i
MSCS Group CDHTII:_ILIIatIDI‘l_FIIE. _ / Host Ownar
| Caontainer link Detutl o I
¥
i, ' [
MSCS resource Configuration File MSCS Group
Container link L L
,;/I;epentl EHERTE 'Cuntamer link
~H |
e i
Configuration File System Configuration File

This Microsoft Cluster Server view shows the clusters discovered in the
system. The clusters contains Microsoft Cluster groups. Each of the groups
contains Microsoft Cluster resources.

ClIs Discovered by the Discovery Process

You can view the CIs discovered by the Microsoft Cluster Server discovery.
To view the Cls discovered by the Microsoft Cluster Server discovery:

In Mercury Business Availability Center, select Admin > CMDB.

Click the Discovery Manager tab.
Click the Module Manager tab.

B W N =

In the Discovery Modules pane, expand the MS Cluster module and select
the MS_Cluster_Topology pattern.
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In the Details View tab, the Statistics table displays the Cls discovered by the
Microsoft Cluster Server discovery.

= MS Cluster

ster_Topology

,'J Mainframe

,;J Metlinks - Pazsive MNetwork Connections Dizcove
J Metwark - Advanced

;J Metwork - Basic

,'J Metweark - Credentisl-less Discovery
;J Metwork - Layer2

.‘a Metwork - Protocal Connections

;J Metwork - TCP Discovery

,'J Weritas Cluster

;J Wieh Servers - Basic

i wieh Servers - IHS

;J Wb Servers - IS

,'J Wiebsphere_MG

J Cthers z

|EJ ) ritcrnd Waiting for ... [Default...
b
il -
0% Page 1= ot1 1-2outor2
]
|
- Statistice: (Last update time: Tue Oct 31 16:38:15 IST 2008, valid to: Tue Oct 31 16:39:20 IST £
@ CIT Created Updated | Deleted
j Configuration File 29 0 ]
Cortainer link 44 0 0
% |pepend 12 i o
Host 0 0 0
WS Cluster 1 0 0
MECE Group 3 0 ]
MSCS resource 12 0 0
tdember 2 0 0
it 5 ] 0
Total 108 0 0

The following table contains a description of the discovered ClIs.

Display Name Cl Type Description

Contained contained The relationship that links the nodes and IPs.

Configuration File configfile Holds data regarding a configuration file of an
application.

Host host The host represents a network element which
has a unique IP address.

IP ip Represents an IP address which identifies the
sender or receiver of information that is sent
over the internet.

MS Cluster mscluster The Microsoft cluster server.

MSCS Group mscsgroup Collection of dependent or related resources to
be manages as a single unit.

MSCS Resource mscsresource Physical or logical entity managed by a cluster
node. A resource provides a service to clients in
a client/server environment.

Member member The link between a cluster and its nodes.
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Display Name Cl Type Description

Owner owner The link between a node and its groups.

Depend depend The link between resources.
Troubleshooting

224

This section provides information that can help troubleshooting some of
the problems that can occur when performing an Microsoft Cluster Server

discovery.

Problem 1. You do not have access to the requested cluster command.

Solution 1. Contact your administrator.

Problem 2. Clus_Svc was not discovered.

Solution 2. The discovered host is not a cluster node.
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Optional Variables in Discovery Patterns

> An empty string

To ensure that a discovery pattern does not fail if a specific variable is
missing, add the attribute optional="true” to a variable tag in a discovery
pattern.

If the optional="true” attribute is added, every reference to the missing
variable is replaced by either:

“wn

as a value

» A default value if it is provided for the attribute

<variables>

Use the following syntax to define the default value. The default value
appears in bold:

<destinationData name="retry">${SNMP.snmp_retry:5}</destinationData>

In the following example, the optional="true”attribute was added to the
variable tag and $SNMP was not found. The retry value is replaced by 5 since
the value that is put after the colon (:) becomes the default value if the
attribute does not exist.

<variable name="SNMP" getObjectBy="condition" optional="true">

<condition>
<object id="-1" class="snmp" subsystem="6" container_name="host_applicationlist">
<attribute name="snmp_port" type="java.lang.Integer" list="false"

operator="EQ">161</attribute>

<attribute name="root_container" type="host" list="false" operator="EQ">
<object id="${HOST.root_id}" class="host" subsystem="6" />
</attribute>
</object>
</condition>

</variable>

</variables>
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Note: Discovery patterns that do not use optional variables fail if the
specified variables are not found.
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Discovery Patterns

This appendix contains details on the following discovery patterns.

This chapter describes: On page:
Application - Oracle E-Business Suite 231
Application — SAP 232
Application - Siebel 236
Application — Webservices 240
Database — DB2 240
Database — Oracle 240
Database — Oracle TNS 244
Database — SQL Server 246
Database — Sybase 248
Host Resources - NTCMD 249
Host Resources — SNMP 250
Host Resources — SSH/FD 252
Host Resources — WMI 253
J2EE — Weblogic 255
J2EE — Websphere 257
MS_Cluster 259
Mainframe 260
NetLinks — Passive Network Connections Discovery 261
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230

This chapter describes: On page:
Network — Advanced 263
Network — Basic 265
Network — Credential-Less Discovery 267
Network — Layer2 269
Network — Protocol Connections 271
Network — TCP Discovery 275
Veritas Cluster 279
Web Servers — Basic 280
Web Servers — IHS 281
Web Servers — I1IS 282
Websphere_MQ 283
Others 285




Application - Oracle E-Business Suite

Appendix B ¢ Discovery Patterns

Pattern

OracleApps

Package

OracleApps

Parse Method

Protocol

Discovered
ClIs/Relationships

YYVYYVYYVYYVYYVYYVYYYVYYVYY

>
>

Contained
Container link

DB Tablespace
Depend

Deployed

Host

P

Member

Oracle

Oracle Application
Service

Service Manager
Oracle iAS

Oracle E-Business Suite
Web Component
Process

Resource

Use

TQL

oracle_database

Schedule

Once a day

Notes
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Application - SAP

Pattern

SAP_Dis_Applications Package SAP_discovery

Parse Method

Protocol SAP Protocol
Discovered » Container link
ClIs/Relationships » Contains

» SAP Application
Component

» SAP Transaction
» SAP Transport
» SAP Transport Charge

» Use
TQL sapsystem_connected
Schedule Once a day

Notes
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Pattern
SAP_Dis_ITS Package SAP_discovery
Parse Method
Protocol
Discovered » Contained
» Depend
» Host
> IP
» SAP ITS AGate
» SAP ITS WGate
» SAP R/3 Application
Server
TQL sap_its_process
Schedule Once a day
Notes
SAP_Dis_J2EE_Site Package SAP_discovery
Parse Method
Protocol
Discovered » Contained
Cls/Relationships » Container link
» Depend
» Host
» IP
» SAP ITS AGate
» SAP ITS WGate
> SAP R/3 Application
Server
TQL sap_jmx_ports
Schedule Once a day
Notes
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Pattern

SAP_Dis_Site

Package

SAP_discovery

Parse Method

Protocol

SAP_Protocol

Discovered
ClIs/Relationships

» Configuration File
Contained
Container link
Database

Depend

Host

P

Member

SAP Client

SAP Gateway

SAP R\3 Application
Server

» RFC Connection
» sap_software_component

YYVYYVYYYVYVYYVYY

» sap_support_package
» SAP System

» SAP Work Process

» Use

TQL

sap_ports

Schedule

Once a day

Notes
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Pattern
SAP_Dis_SolutionManager Package SAP_discovery
Parse Method
Protocol SAP Protocol
Discovered » Contained
Cls/Relationships » Container link
» Execute
» Host
> IP
» SAP Project
» SAP Business Process
» SAP Business Scenario
» SAP Process Step
» SAP Transaction
TQL sapsystem_connected
Schedule Once a day
Notes
WMI_APP_Lis_IIS_Down.xml Package IIS_Resources_By_WMI
Parse Method Dynamic
Protocol WMI (DCOM)
Discovered
ClIs/Relationships
Monitored iis
ClIs/Relationships
TQL iis_server
Schedule Once
Notes destination oriented
DCOM listener, pulling
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Application - Siebel

Pattern

SIEBEL_DIS_APP SERVERS

Package

Siebel_discovery

Parse Method

Protocol

Discovered
ClIs/Relationships

YYYYVYYVYYVYY

\

>

Configuration file
Contained
Container link
Contains

Depend

Host

P

Member

Siebel Application
Server

Siebel Application

Siebel Component
Group

Siebel Component

TQL

siebel_gtwy_connected

Schedule

Once a day

Notes

236




Appendix B ¢ Discovery Patterns

Pattern
SIEBEL_DIS_APP_SERVER_CONFIG Package Siebel_discovery
Parse Method
Protocol
Discovered » Configuration file
Cls/Relationships » Container link
» Siebel Application
Server
TQL siebel_appserver_shell
Schedule Once a day
Notes
SIEBEL_DIS_DB_NT Package Siebel_discovery
Parse Method
Protocol
Discovered » Container link
CIS/RelatiOnShipS > Database
» Depend
» Host
» Use
TQL siebel_appserver_nt
Schedule Once a day
Notes
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Pattern

SIEBEL_DIS_DB_UNIX

Package

Siebel_discovery

Parse Method

Protocol
Discovered » Container link
CIS/RelatiOHShipS > Database

» Depend

» Host

» Use
TQL siebel_appserver_shell
Schedule Once a day
Notes

SIEBEL_DIS_GATEWAY _ Package Siebel_discovery
CONNECTION_(GTWY)

Parse Method
Protocol Siebel Gateway Protocol
Discovered » Container link
ClIs/Relationships » Member

» Siebel Gateway

» Siebel Enterprise
TQL siebel_ports_or_gtwy
Schedule Once a day
Notes
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Pattern
SIEBEL_DIS_WEBAPPS_NT Package Siebel_discovery
Parse Method
Protocol
Discovered » Configuration file
Cls/Relationships » Container link
» Contains
» Depend
» Host
TQL siebel_webserver_nt
Schedule Once a day
Notes
SIEBEL_DIS_WEBAPPS_UNIX Package Siebel_discovery
Parse Method
Protocol
Discovered » Configuration File
Cls/Relationships » Container link
» Contains
» Depend
» Host
TQL siebel_webshell_server
Schedule Once a day
Notes
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Application - Webservices

Pattern
UDDI_Registry Package Webservice_discovery
Parse Method
Protocol Uddi Registry Protocol
Discovered » Business Unit
Cls/Relationships » Business Unit link
» Configuration File
» Container link
» Contains
TQL local
Schedule Once a day
Notes
Database - DB2
Pattern
SQL_APP_Dis_Db2 Package DB2
Parse Method
Protocol SQL Protocol
Discovered » Contained
Cls/Relationships » Container link
>» DB2
» DB2 Client
» DB2 Data File
TQL db2withuser
Schedule Every 1410 minutes
Notes
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Pattern
SQL_APP_Dis_Db2_Conn Package Database_Basic
Parse Method
Protocol SQL Protocol
Discovered » Container link
ClIs/Relationships » DB2
» Host
TQL db2_db_port
Schedule Every 1410 minutes
Notes
TCP_NET_Dis_Port Package Network
Parse Method
Protocol
Discovered » Container link
ClIs/Relationships » Server Port
» User
TQL host
Schedule Once a day
Notes
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Database - Oracle

Pattern

CF_Oracle

Package

Oracle

Parse Method

Protocol

Discovered » Configuration File
ClIs/Relationships » Container link
TQL oracle_database
Schedule Once a day

Notes
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Pattern

SQL_Dis_Oracle

Package

Oracle

Parse Method

Protocol

Discovered
Cls/Relationships

» Contained

» Container link
» DB_Archive File
DB_Control-File
DB_Re-do File
DB_Re-do File group
FBA Obiject

DB Client

DB Data File

DB Job

DB Link Object
DB Scheduler Job
DB Snapshot
DB Tablespace
DB User
Depend
Dependency
Host

> IP

» Member

» Oracle

» Owner

YYYYVYYYYVYYYVYVYYVYYVYYVYY

» Program

» Oracle RAC
» Resource
» Service

TQL

oracle_database

Schedule

Once a day

Notes
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Pattern

SQL_NET_Dis_Connection

Package

Database Basic

Parse Method

Protocol SQL Protocol
Discovered » Container link
ClIs/Relationships » Oracle
» SQL Server
TQL db_ports
Schedule Once a day
Notes
Database - Oracle TNS

Pattern

CF_Oracle Package Oracle
Parse Method
Protocol TCP
Discovered » Configuration File
Cls/Relationships » Container link
TQL oracle_database
Schedule Once a Day
Notes
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Pattern

SQL_Oracle_Connection

Package

Oracle

Parse Method

Protocol SQL Protocol
Discovered » Container Link
ClIs/Relationships » Oracle
TQL oracle_database
Schedule Once a Day
Notes
TNSNamesParser Package Oracle

Parse Method
Protocol
Discovered » Configuration File
ClIs/Relationships » Contained

» Container Link

» Host

> IP

» Oracle
TQL host_tnsnames_shell
Schedule Once a Day
Notes
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Database - SQL Server

Pattern

SQL_APP_Dis_SqlServer Package SQL_Server

Parse Method

Protocol

Discovered
ClIs/Relationships

Configuration File
Contained
Container link
DB Client

DB Link

DB User
Depend

Drive

File

Host

P

Owner
Program
Replicated
SQL Backup
SQL Database
SQL File

SQL Job

SQL Processes
SQL Server

Sql Server Distributor

YYVYYVYYYYVYYVYYVYYYVYYYYVYYVYYVYYVYYy

SQL Server Maintenance
Plan

» SQL Server Publication
» SQL Server Publisher

» SQL Server Subscription
» Use
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Pattern

SQL_APP_Dis_SqlServer TQL sqlServer
Schedule Once a Day
Notes

SQL_NET_Dis_Connection Package Database_Basic
Parse Method
Protocol SQL Protocol
Discovered » Container link
ClIs/Relationships » Oracle

» SQL Server

TQL sqlServer
Schedule Once a Day
Notes

247



Appendix B ¢ Discovery Patterns

Database - Sybase

Pattern

SQL_APP_Dis_Sybase Package Sybase
Parse Method
Protocol SQL Protocol
Discovered » Container link
ClIs/Relationships » DB Client
» DB Data File
» DB Tablespace
» Host
» Process
» Resource
» Sybase
TQL sybase_db
Schedule Once a Day
Notes
SQL_NET_Dis_sybase_Conn Package Database_Basic
Parse Method
Protocol SQL Protocol
Discovered » Container link
ClIs/Relationships » Host
» Sybase
TQL sybase_db_port
Schedule Every1410 minutes
Notes
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Pattern

TCP_NET_Dis_Port

Package

Network

Parse Method

Protocol
Discovered » Container link
CIS/RelatiOHShipS > Server Port
» Use
TQL host
Schedule Once a Day
Notes
Host Resources - NTCMD
Pattern
NTCMD_HR_All Package Host_Resources_By_NTCM
D
Parse Method
Protocol
Discovered » Container link
ClIs/Relationships » CPU
» Disk
» Memory
» Program
» Service
» Software
TQL ntcmd
Schedule Once a Day
Notes
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Host Resources - SNMP

Pattern

SNMP_HR_Disk

Package

Host_Resources_By_SNMP

Parse Method

Protocol
Discovered » Container link
ClIs/Relationships » Disk
TQL snmp
Schedule Once a Day
Notes
SNMP_HR_OSUser Package Host_Resources_By_SNMP
Parse Method
Protocol
Discovered » Container link
Cls/Relationships » Disk
TQL snmp
Schedule Once a Day
Notes
SNMP_HR_Printq Package Host_Resources_By_SNMP

Parse Method

Protocol

Discovered » Container Link
ClIs/Relationships » Print Queue
TQL snmp

Schedule Once a Day
Notes
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Pattern

SNMP_HR_Process

Package

Host_Resources_By_SNMP

Parse Method

Protocol
Discovered » Container link
ClIs/Relationships » Process
TQL snmp
Schedule Once a Day
Notes
SNMP_HR_Service Package Host_Resources_By_SNMP
Parse Method
Protocol
Discovered » Container link
ClIs/Relationships » Service
TQL snmp
Schedule Once a Day
Notes
SNMP_HR_Software Package Host_Resources_By_SNMP

Parse Method

Protocol

Discovered » Container link
ClIs/Relationships » Software

TQL snmp

Schedule Once a Day
Notes
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Host Resources — SSH/FD

Pattern

TTY_HR_All

Package

Host_Resources_By_TTY

Parse Method

Protocol XCMD (NetBIOS)
Discovered Container link
ClIs/Relationships CPU

Dir

Disk

Memory

OS User

Software
TQL shell_on_unix
Schedule Once a Day
Notes

TTY_HR_Process Package Host_Resources_By_TTY

Parse Method
Protocol
Discovered Container link
ClIs/Relationships Process
TQL shell_on_unix
Schedule Once a Day
Notes
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Pattern
WMI_HR_CPU Package Host_Resources_By_WMI
Parse Method
Protocol
Discovered » Container link
ClIs/Relationships » CPU
TQL wmi
Schedule Once on Arrival
Notes
WMI_HR_Disk Package Host_Resources_By_WMI
Parse Method
Protocol
Discovered » Container link
Cls/Relationships » Disk
TQL wmi
Schedule Once on Arrival
Notes
WMI_HR_Memory Package Host_Resources_By_WMI

Parse Method

Protocol

Discovered » Container link
ClIs/Relationships » Memory

TQL wmi

Schedule Once on Arrival
Notes
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Pattern

WMI_HR_Process

Package

Host_Resources_By_WMI

Parse Method

Protocol
Discovered » Container link
ClIs/Relationships » Program
TQL wmi
Schedule Once on Arrival
Notes

WMI_HR_Service Package Host_Resources_By_WMI
Parse Method
Protocol
Discovered » Container link
ClIs/Relationships » Service
TQL wmi
Schedule Once on Arrival
Notes
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J2EE - Weblogic

Pattern

JMX_J2EE_Weblogic Package J2EE

Parse Method

Protocol
Discovered » Configuration File
Cls/Relationships » Connection Pool

» Contained

» Container link
» Contains

» Database

» Depend

» Deployed

» Document

» EJB Module

> Entity Bean

» J2EE Execute Queue
» Host

> IP

» J2EE Application
» J2EE Cluster

» J2EE Domain

» J2EE Server

» J2EE Socket

» JDBC Datasource
» JMS Data Store
» JMS Destination
» JMS Server

> JVM

» Member

» Message Driven Bean
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Pattern
JMX_J2EE_Weblogic (cont’d) Discovered » Servlet
ClIs/Relationships > SQL Database
» Statefull Session Bean
» Stateless Session Bean
» Use
» Web Module)
» Web Service
» Web Service Operation
TQL sqlServer
Schedule Once a Day
Notes
JMX_J2EE_Weblogic_Connection Package J2EE

Parse Method

Protocol Weblogic Protocol
Discovered » Container link
ClIs/Relationships > J2EE Server
TQL weblogic_ports
Schedule Once a Day

Notes
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Appendix B ¢ Discovery Patterns

Pattern

JMX_J2EE_Websphere

Package

J2EE

Parse Method

Protocol Websphere Protocol
Discovered » Configuration File
ClIs/Relationships » Container link

» Contains

» Database

» Depend

» Deployed

» Document

» EJB Module

» Entity Bean

» Host

» J2EE Application

» J2EE Cluster

» J2EE Server

» JDBC Data Source

» JDBC Provider

» JMS Provider

» JMS Server

> JVM

» Member

» Message Driven Bean
» Servlet

» SQL Database

» Statefull Session Bean
» Stateless Session Bean
» Use

» Web Module

» Web Service

» Web Service Operation
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Pattern

JMX_J2EE_Websphere TQL websphere
Schedule Once a Day
Notes

JMX_J2EE_Websphere_Connection Package J2EE
Parse Method
Protocol Websphere Protocol
Discovered » Container link
ClIs/Relationships » Websphere
TQL websphere_ports
Schedule Once a Day
Notes
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MS_Cluster
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Pattern

MS_Cluster_Topology

Package MS_Cluster
Parse Method
Protocol
Discovered » Configuration File
Cls/Relationships » Contained
» Container link
» Depend
» Host
> IP
» Member
» MS Cluster
» MSCS Group
» MSCS resource
» Owner
TQL ntcmd_on_mscs
Schedule Once a day
Notes
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Mainframe

Pattern

SNMP_IBM_Mainframe_lpar_disco
very

Package

Mainframe

Parse Method

Protocols

clientserver & tcp relationships for
ipserver /ipclient

Discovered
Cls/Relationships

» Client-Server
» Contained

» Container link
» Dependency
» Host

> IP

» Client Port

» Server Port

» Logical Partition
» Member

» Service

» Sysplex

» Use

TQL

ip_on_mainframe_without_lpar

Schedule

Once a Day

Notes
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NetLinks — Passive Network Connections Discovery
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Pattern

NetFlow_StartCollector Package NetLinks
Parse Method
Protocols
Discovered
ClIs/Relationships
TQL local
Schedule Once on Arrival
Notes
Netlinks_Potential_Services Package NetLinks
Parse Method
Protocols
Discovered » Client Server
ClIs/Relationships » Contained
» Container link
» Host
» IP
» Server Port
TQL
Schedule Once a Day
Notes
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Pattern

Netlinks_Services

Package

NetLinks

Parse Method

Protocols
Discovered » Client-Server
Cls/Relationships » Contained
» Container link
» Dependency
» Host
> IP
» Server Port
» Use
TQL local
Schedule Every 10 Minutes
Notes
Netlinks_ServicesConnectivity Package NetLinks
Parse Method
Protocols
Discovered » Contained
Cls/Relationships » Host
> 1P
» Traffic
TQL server ip
Schedule Once a Day
Notes
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Network - Advanced
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Pattern

SNMP_NET_Dis_HostBase

Package

Network

Parse Method

Protocols
Discovered » ATM Switch
ClIs/Relationships » Bridge

» Contained

» Container link
» Firewall

» Host

» Interface

» Interface Index
> IP

> LB

» Member

» Net Device

» Net Printer
» Network

» Windows

» Parent

» RAS

» Route

» Router

» SNMP

» Switch

» trminalserver
» Unix

» Unnumbered
» VAX

» X Terminal
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Pattern

SNMP_NET_Dis_HostBase TQL snmp
Schedule Once a Day
Notes

SNMP_NET_Dis_Router_Arp Package Network

Parse Method

Protocols
Discovered » Contained
Cls/Relationships » Container link
» Host
» Interface
» IP
» Member
» Network
» Parent
TQL snmp_router
Schedule Once a Day
Notes
TCP_NET _Dis_Port Package Network
Parse Method
Protocols SSH
Discovered clientserver & tcp relationships for
ClIs/Relationships ipserver /ipclient
TQL host
Schedule
Notes
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Pattern

Host_ID_Discover

Package

Network

Parse Method

Protocols

NTCMD Protocol
SNMP Protocol
SSH Protocol
Telnet Protocol
WMI Protocol

Discovered
Cls/Relationships

» ATM Switch
» Contained
» Container link
» Firewall

» Host

» Interface

> IP

> LB

» Mainframe
» Member

» Net Device
» Net Printer
» Network

» novell

» Windows
» NTCMD

» Parent

» RAS

» Router

» SNMP
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Pattern
Host_ID_Discover (cont’d) Discovered » SSH
Cls/Relationships » Switch
» Telnet
» trminalserver
» Unix
» VAX
> WMI
» X Terminal
TQL > ip
Schedule » Once a Day
Notes
ICMP_NET_Dis_IpC Package Network
Parse Method
Protocols
Discovered » Depend
ClIs/Relationships > [P
» Member
TQL network_C
Schedule Once a Day
Notes
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Network - Credential-Less Discovery
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Pattern

MS_NET_Dis_Domain

Package

Network

Parse Method

Protocols
Discovered » Contained
ClIs/Relationships » Host
» IP
» Member
» MS Domain
» Windows
TQL probe
Schedule Once a Day
Notes
NSLOOKUP_on_Probe Package Network

Parse Method

Protocols
Discovered » Contained
ClIs/Relationships » Host
» IP
» Net Printer
» Windows
» Unix
TQL probe
Schedule Once a Day
Notes
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Pattern

OS_Fingerprint

Package

Credential_Less_Discovery

Parse Method

Protocols
Discovered » Software Element
Cls/Relationships » Contained

» Container link

» Host

» Interface

> IP

» Server Port

» Member

» Use
TQL network_C
Schedule Once a Day
Notes
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Network - Layer2
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Pattern

SNMP_Dis_L2_Bridge Package Layer2
Parse Method
Protocols
Discovered » Bridge
ClIs/Relationships » Concentrator
» Container link
» Physical Port
TQL catalyst_bridge_no_vlan
Schedule Once on Arrival
Notes
SNMP_Dis_L2_Vlan Package Network
Parse Method
Protocols
Discovered » Bridge
ClIs/Relationships » Concentrator
» Container link
» Physical Port
TQL catalyst_vlan_with_bridge
Schedule Once on Arrival
Notes
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Pattern

SNMP_NET_Dis_Catalyst_Vlans

Package

Layer2

Parse Method

Protocols
Discovered » Container link
ClIs/Relationships » VLAN
TQL snmp_of_catalyst_switch
Schedule Once on Arrival
Notes
SNMP_NET_Dis_VMS_catalyst Package Layer2
Parse Method
Protocols
Discovered » Bridge
Cls/Relationships » Container link
» Contains
» Physical Port
» VLAN
» VLAN Membership
» Vlan ToBridge
TQL catalyst_vlan
Schedule Once on Arrival
Notes
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Pattern

NTCMD_NET_Dis_Connection

Package

Network

Parse Method

Protocols NTCMD Protocol
Discovered » Contained
ClIs/Relationships » Container link

» Host

» Interface

> IP

» Member

» Network

» Windows

» NTCMD

» Parent
TQL ip
Schedule Once a Day
Notes

271



Appendix B ¢ Discovery Patterns

Pattern

SNMP_NET_Dis_Connection

Package

Network

Parse Method

Protocols

SNMP Protocol

Discovered
Cls/Relationships

» ATM Switch
» Contained
» Container link
» Firewall

» Host

» Interface

> IP

> LB

» Mainframe
» Member

» Net Device
» Net Printer
» Network

» novell

» Windows
» RAS

» Router

» SNMP

» Switch

» trminalserver
» Unix

» VAX

» X Terminal

TQL

ip

Schedule

Once a Day

Notes
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Pattern
TTY_Net_Dis_Connection Package Network
Parse Method
Protocols SSH Protocol
Telnet Protocol
Discovered » Contained
Cls/Relationships » Container link
» Host
» Interface
» IP
» Member
» Network
» Parent
>» SSH
» Telnet
TQL ip
Schedule Once a Day
Notes
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Pattern

WMI_NET_Dis_Connection

Package

Network

Parse Method

Protocols WMI Protocol
Discovered Contained
Cls/Relationships Container link
Host
Interface
P
Member
Network
Windows
WMI
TQL ip
Schedule Once a Day
Notes
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Network - TCP Discovery
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Pattern

Dis_TCP

Package

TCP_discovery

Parse Method

Protocols NTCMD Protocol
Discovered » Client-Server
ClIs/Relationships » Contained
» Container link
» Dependency
» Host
» IP
» Server Port
» I[P Unknown
» Traffic
» Use
TQL snmp_and_shell
Schedule Once a Day
Notes
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Pattern

SNMP_NET_Dis_Connection

Package

Network

Parse Method

Protocols

SNMP Protocol

Discovered
Cls/Relationships

» ATM Switch
» Contained
» Container link
» Firewall

» Host

» Interface

> IP

> LB

» Mainframe
» Member

» Net Device
» Net Printer
» Network

» novell

» Windows
» RAS

» Router

» SNMP

» Switch

» trminalserver
» Unix

» VAX

» X Terminal

TQL

ip

Schedule

Once a Day

Notes
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Pattern
TTY_Net_Dis_Connection Package Network
Parse Method
Protocols SSH Protocol
Telnet Protocol
Discovered » Contained
Cls/Relationships » Container link
» Host
» Interface
» IP
» Member
» Network
» Parent
>» SSH
» Telnet
TQL ip
Schedule Once a Day
Notes
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Pattern

WMI_NET_Dis_Connection

Package

Network

Parse Method

Protocols WMI Protocol
Discovered » Contained
CIS/RelatiOnShipS » Container hnk
» Host
» Interface
> IP
» Member
» Network
» Windows
> WMI
TQL ip
Schedule Once a Day
Notes
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Veritas Cluster
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Pattern

Veritas_Cluster_Topology

Package

Vertias_cluster

Parse Method

Protocols
Discovered » Configuration File
ClIs/Relationships » Contained
» Container link
» Depend
» Host
» IP
» Member
» Owner
» VCS Group
» VCS resource
» Veritas Cluster
TQL shell_of_veritas_cs
Schedule Once a Day
Notes
TQL ip
Schedule Once a Day
Notes
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Web Servers - Basic

Pattern

Apache

Package

WebServer

Parse Method

Protocols
Discovered » Configuration File
Cls/Relationships » Contained

» Container link

» Host

> IP

» Server Port

» Use

» Web Server

» Web Server Virtual Host
TQL shell_on_unix
Schedule Once a Day
Notes

TCP_Webserver_Detection Package WebServer

Parse Method

Protocols

Discovered » Container link
Cls/Relationships » Web Server
TQL http_ports
Schedule Once a Day
Notes
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Web Servers - IHS

Pattern
IHS_Dis_WebspherePlugin Package IBM_HTTP_Server
Parse Method
Protocols
Discovered » Configuration File
ClIs/Relationships » Contained
» Container link
» Host
» HTTP Context
» IBM HTTP Server
> IP
» Server Port
» Route
TQL unix_ihs_shell
Schedule Once on Arrival
Notes
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Web Servers - IIS

Pattern
NTCMD_APP_Dis_IIS Package 1N
Parse Method
Protocols
Discovered » Configuration File
Cls/Relationships » Container link
» Contains
» IIS Resource
» Server Port
» Use
» Web Service
» Web Service Operation
» Web Server Virtual Host
TQL host_ntcmd_iis
Schedule Once a Day
Notes
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Websphere_MQ
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Pattern

MQ_Topology

Package

Websphere_MQ

Parse Method

Protocols
Discovered » Container link
ClIs/Relationships » Host

> IP

» Server Port

» Member

» IBM MQ Alias

» IBM MQ Alias Queue
» IBM MQ Channel

» IBM MQ Channel Of

» IBM MQ Client Connection
Channel

» IBM MQ Cluster Reciever
Channel

» IBM MQ Cluster Sender
Channel

» IBM MQ Requester Channel
» IBM MQ Sender Channel

» IBM MQ Sender Channel

» IBM MQ Cluster

>» IBM MQ Queue

» IBM MQ Queue Local

» IBM MQ Queue Manager
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Pattern
MQ_Topology (cont’d) Discovered » IBM MQ Queue Remote
Cls/Relationships » IBM MQ Repository
» IBM MQ Transmission Q
» Raw Event
» Use
» IBM Websphere MQ
TQL shell_on_mgq_host
Schedule Once a Day
Notes
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Pattern

FILE_Mon

Package

FileMonitoring

Parse Method

Protocols
Discovered » Configuration File
Cls/Relationships » Container link
» Dir
» Document
TQL host_shell
Schedule Once a Day
Notes
ICPM_NET_Dis_IpB Package Network
Parse Method
Protocols
Discovered » Depend
ClIs/Relationships > [P
» Member
TQL network_B
Schedule Once a Day
Notes
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Pattern

JMX_J2EE_JBoss

Package

J2EE

Parse Method

Protocols

Discovered
Cls/Relationships

» Connection Pool

» Container link

» EJB Module

» Entity Bean

» J2EE Server

» JMS Destination

» JMS Server

> JVM

» Message Driven Bean
» Servlet

» Statefull Session Bean
» Stateless Session Bean
» Web Application

TQL

jboss_server

Schedule

Once a Day

Notes

JMX_J2EE_JBoss_Connection

Package

J2EE

Parse Method

Protocols JBOSS Protocol
Discovered » Container link
ClIs/Relationships > J2EE Server
TQL rmi_ports
Schedule Once a Day
Notes
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Pattern

NSLOOKUP_on_DNS_Server

Package

Network

Parse Method

Protocols
Discovered » Contained
Cls/Relationships » Host

> IP

» Net Printer

» Windows

» Unix
TQL dns_server_shell
Schedule Once a Day
Notes

NTCMD_HR_Dis_Disk Package Host_Resources_By_NTCMD

Parse Method
Protocols
Discovered » Container link
Cls/Relationships » Disk
TQL ntcmd
Schedule Once a Day
Notes
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Pattern

NTCMD_HR_Dis_Memory

Package

Host_Resources_By_NTCMD

Parse Method

Protocols
Discovered » Container link
ClIs/Relationships » Memory
TQL ntcmd
Schedule Once a Day
Notes
NTCMD_HR_Dis_Process Package Host_Resources_By_NTCMD
Parse Method
Protocols
Discovered » Container link
Cls/Relationships » Program
TQL ntcmd
Schedule Once a Day
Notes
NTCMD_HR_REG_CPU Package Host_Resources_By_NTCMD

Parse Method

Protocols

Discovered » Container link
ClIs/Relationships » CPU

TQL ntcmd

Schedule Once a Day
Notes

288




Appendix B ¢ Discovery Patterns

Pattern

NTCMD_HR_REG_Service

Package

Host_Resources_By_NTCMD

Parse Method

Protocols
Discovered » Container link
Cls/Relationships » Service
TQL ntcmd
Schedule Once a Day
Notes

NTCMD_HR_REG_Software Package Host_Resources_By_NTCMD
Parse Method
Protocols
Discovered » Container link
ClIs/Relationships » Software
TQL ntcmd
Schedule Once a Day
Notes

SQL_NET_Dis_db2_from_db2 Package Database_Basic

Parse Method

Protocols SQL Protocol
Discovered DB2
Cls/Relationships

TQL db2_no_user
Schedule Every 7 Days
Notes
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Pattern

SQL_NET_Dis_informix_Conn

Package

Database_Basic

Parse Method

Protocols SQL Protocol
Discovered Container link
ClIs/Relationships informix
TQL informixdb_port
Schedule Every 7 Days
Notes

TTY_HR_CPU Package Host_Resources_By_TTY
Parse Method
Protocols
Discovered » Container link
ClIs/Relationships » CPU
TQL shell_on_unix
Schedule Once a Day
Notes

TTY_HR_Disk Package Host_Resources_By_TTY

Parse Method

Protocols

Discovered » Container link
Cls/Relationships » Disk

TQL shell_on_unix
Schedule Once a Day
Notes
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Pattern

TTY_HR_Memory

Package

Host_Resources_By_TTY

Parse Method

Protocols
Discovered » Container link
Cls/Relationships » Memory
TQL shell_on_unix
Schedule Once a Day
Notes
TTY_HR_Software Package Host_Resources_By_TTY
Parse Method
Protocols
Discovered » Container link
ClIs/Relationships » Software
TQL shell_on_unix
Schedule Once a Day
Notes
TTY_HR_User Package Host_Resources_By_TTY

Parse Method

Protocols
Discovered » Container link
Cls/Relationships » Dir

» OS User
TQL shell_on_unix
Schedule Once a Day
Notes
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Pattern

WMI_HR_Software

Package

Host_Resources_By_WMI

Parse Method

Protocols

Discovered » Container link
ClIs/Relationships » Software

TQL

Schedule Once on Arrival
Notes
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C

Discovery Methods

This chapter describes the list of supported discovery methods, the protocol
type that is used to communicate with the device or application, the data

that can be discovered, and the required permissions or prerequisites for

each type of protocol and operating system.

Mercury Business Availability Center discovery methods hold the logic for

the discovery of IT infrastructure components for OSI layers 2 to 7. For

details, refer to http://www.cisco.com/univercd/cc/td/doc/cisintwk/ito_doc/
introint.htm#xtocid5.

Discovered Through | Permissions/ Discovered Data Notes
Domain Protocol | Prerequisites
Layer 2 SNMP SNMP » concentrator (switch)
community > port
string with
GET
permission.
IP sweep ICMP N/A P
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Discovered Through | Permissions/ Discovered Data Notes
Domain Protocol | Prerequisites
Network SNMP SNMP » host
infrastructure community > IP
g;}?g with > interface
permission. > SNMP
» network
> bridge
>» port
» layertwo
relationships
» backbone
relationships
» route relationships
» bridge relationships
Telnet Regular » host
(non-root) » IP
operating » interface
system user. > Telnet
» network
SSH Regular » host
(non-root) » IP
operating > interface
system user > SSH
» network
WMI Non-admin » host
account with » IP
only “Enable » interface
Account” and .
“Remote > wmi
Enable”. » network
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Discovered Through | Permissions/ Discovered Data Notes
Domain Protocol | Prerequisites
NTCMD | Admin user » host
> 1P
» interface
» ntcmd
» network
Java Etc/hosts DNS name for IP.
Server SNMP SNMP » disk Server inventory
inventory community > printq can be discovered
sGtETr‘lg with > program by:
. > service > SNMP
permission
> software > Telnet
» operating > WMI
> system user > NetBios
> BB
TTY Regular » disk
(Telnet (non-root) » daemon
or SSH) operating » software
system user
» program.
NetBIOS | Admin User » service
» software
» disk
» program
WMI Admin User » CPU
» disk
> memory
» program
» service
TCP SNMP SNMP » [Pserver
connections community » IPclient

string with
GET
permission

» TCP relationships
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Discovered Through | Permissions/ Discovered Data Notes
Domain Protocol | Prerequisites
NetBIOS | Administrator | » IPserver,
Windows » IPclient
User/Password | TCp relationships
Telnet Local Admin » IPserver
User » IPclient
» TCP relationships
SSH Regular » [Pserver
(non-root) » IPclient
operating » TCP relationships
system user
Microsoft WIN APT | N/A » msdomain
domains » nt
DB2 SQL DB user with > DB2
select » DB Tablespace
permissions » DB Datafile
for.sysproc, » DB Client
sysibm and
sysproc table > Host
functions > Ip
» Process
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Discovered Through | Permissions/ Discovered Data Notes
Domain Protocol | Prerequisites
Oracle SQL DB user with » dbaobjects Data sources:
READ » dbarchivefile dba_data_files,
permission » dbclient dba_db_links,
from V$ and dba_jobs
DBA_ tibles > dbcontrolfile dba:]ob]'e’cts,
» dbdatafile dba_snapshots,
> dbjob dba_tablespaces,
» dblinkobj dba_users,
» dbredofile vibackup,
> dbsnapshot v$controlfile,
» dbtablespace V$datab.ase,
vidatafile,
> dbuser v$log, v$logfile,
» owner v§parameter,
» program virecover_file,
v$session
Versions 8.x, 9i
SQL Server SQL Access to » sqldatabase Data sources:
master tables | » sqlbackup » sysprocesses
> sqlalert » sysdatabases
> sqljob > backupset
> sqljobstep > sysalerts
» sqlperformance > sysjobs
> monitor » sysloginsysjobhi
» sqlprocesses story
» program » sysjobschedules
» dbclient » sysperfinfo
» sqlfile Versions 7, 8
» disk
Sybase SQL sybasedb Data source:

sysdatabases
Versions 11, 12
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Discovered Through | Permissions/ Discovered Data Notes
Domain Protocol | Prerequisites
WebSphere_ Telnet UNIX » mqgqueuemanager Version 5.3
MQ Operating » mgqcluster
System > mgxmitq
Accounton an » mqqueuelocal
MQ server
that allows >» mqqueueremote
SUDO access > mqaliasq
to: >» mqqueue
» clusqmgr > mgqalias
» dspmq » mqchsdr
> runmglsr » mqchsvr
» mgqchannel
» mgqchannelof
» mqchrgstr
» mgqchclntconn
» mgqchclusrcvr
» mqchclussdr
» webspheremq
NetBIOS | Administrator
Windows
User/Password
Weblogic JMX JMX MBean » Jboss Versions 6.1, 7.0,
Server » jmsdestination 8.1
User/Password | jmsserver
» ejbcomponent
» webapplication
» servlet
» connectionpool
» j2eecluster
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Discovered Through | Permissions/ Discovered Data Notes
Domain Protocol | Prerequisites
JBoss JMX JMX MBean » Jboss Versions 2.3, 3.2,
Server » jmsdestination 4
User/Password | 5, jmsserver
» ejbcomponent
» webapplication
» servlet
» connectionpool
» j2eecluster
WebSphere JMX JMX MBean Versions 5.0, 5.1
Application Server
Server User/Password
SAP BAPI SAP » SAP server Versions 3, 4
user/password | » SAP site
for SAPGUI > SAP service
» SAP support package
» SAP component
Siebel Siebel Siebel » Siebel appserver Versions 7.5, 7.7
protocol | user/password | » Siebel compgrp
for the Server | . gjehel component
Manager .
. » Siebel gateway
utility
» Siebel site
» Siebel wse
» Siebel webapp
» Siebel webserver
WMI Admin User » database

» dbconnector
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Discovered Through | Permissions/ Discovered Data Notes
Domain Protocol | Prerequisites
Telnet Regular » database
(non-root) » Siebel application
operating server
system user > siebelwse
» siebelgateway
» siebelsite
» siebelwebapp
» webserver
SSH Regular » database
(non-root) > Siebel App server
operating > siebelwse
system user » siebelgateway
» siebelsite
» siebelwebapp
» webserver
NTCMD | Admin User » Siebelwse
» Siebel gateway
» Siebel site
» Siebel webapp

>

Siebel webserver




Discovery Log Files

This chapter describes various discovery log files and how you can use them
to perform basic troubleshooting.

This chapter describes: On page:
Understanding Discovery Log Files 301
Discovery Server Logs 302
Discovery Probe Logs 304

Understanding Discovery Log Files

The Discovery Probe is composed of two components: the Probe Gateway
and the Probe Manager. The Probe Gateway is responsible for
communication with the Mercury Business Availability Center server, such
as downloading tasks and sending task results. The Probe Manager is
responsible for running the discovery process itself. By default, they run as a
single process.

Discovery log files store messages relating to the activation of discovery
patterns. This includes a record of errors that may have occurred when
trying to activate a discovery pattern.
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Discovery Server Logs

Discovery Server log files reside on the Mercury Business Availability Center
server. They store information about discovery server activity, including
error messages that occur on the server side.

The logs in this section are located in <Mercury Business Availability Center
root directory>\log\.

> “Management Log” on page 302
» “User Servlet Log” on page 303
> “Probe Servlet Logs” on page 303

Management Log

» The log name is collectorsManagement.log. In a distributed environment,
the collectorsManagement.log file resides on the Data Processing server.

Description Error Information | Debug Basic Troubleshooting

Level Level Level
Contains information All Information | Logs Check this log when you have
about tasks running on | discovery | about mainly for | invalid user interface
the server. The server process requests debugging | responses or errors you want to
provides services to the | errors on | being purposes. explore. This log provides
Mercury Business theserver | processed. information to enable you to
Availability Center user | side. analyze the problems.

interface or the Probe
Gateway, such as:
activating patterns,
processing results from
the Discovery Probe, or
creating tasks for the
Discovery Probe.
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User Servlet Log

Appendix D e Discovery Log Files

» The log name is collectorsUTtilitiesServlet.log.In a distributed environment,
the collectorsUtilitiesServlet.log file resides on the Center server.

—_— Error Information | D . .
Description ° ormatio ebug Basic Troubleshooting
Level Level Level
This log receives all the | All errors | Information | Record of | 1. Look at this log mostly to
messages from the in the about user any user see user User Interface-Server
Collectors Utilities servlet. requests. request. communication problems.

Servlet. The user
interface connects to
the server through this
servlet.

2. Some processing problems
might be written to this log
instead of the
collectorsManagement.log.

Probe Servlet Logs

» The log name is collectorsServlet.log.In a distributed environment, the
collectorsServlet.log file resides on the Core server.

Purpose Informati | Error Level Debug Basic Troubleshooting

on Level Level
This log receives all the | All errors | Information | Record of 1. Check this log to see
messages from the in the about every Discovery Probe-Server
Collectors Servlet. The servlet. Discovery Discovery | communication problems.
Discovery Probe Probe task Probe 2. Some processing problems
requests new tasks requests. request to might be written to this log
from the server read instead of the
through this servlet. disliovery collectorsManagement.log

tasks.
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» The log name is collectorsResultsServlet.log.In a distributed environment,
the collectorsResultsServlet.log file resides on the Core server.

Description Error Information | Debug Basic Troubleshooting

Level Level Level
This log receives all the | All errors | Information | N/A 1. Look at this log mostly to
messages from the in the about see Discovery Probe-Server
Collectors Results servlet. Discovery communication problems.
Servlet. The Discovery Probe Tasks 2. Some processing problems
Probe sends new results requests.

through this servlet.

might appear in this log
instead of the
collectorsManagement.log.

» The log name is collectorsDownloadServlet.log.In a distributed
environment, the collectorsDownloadServlet.log file resides on the Core

Server.

Description Error Information | Debug Basic Troubleshooting
Level Level Level

This log receives all the | All errors | Information | Record of | 1. Look at this log mainly to
messages from in the about every see Probe-Server
collectors Download servlet. Discovery Discovery | communication problems.
Servlet. The Discovery Probe task Probe 2. Some processing problems
Probe downloads new. requests. access of might appear in this log
server data through this the instead of the
servlet. servlet.

collectorsManagement.log.

Discovery Probe Logs

Discovery Probe logs store information involving discovery pattern
activation that occurs in the Probe Gateway and Probe Manager.

The logs in this section are located in <Mercury Business Availability Center
root directory>\<Discovery Probe installation location>\root\logs.

> “General Logs” on page 305

» “Probe Gateway Logs” on page 306
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> “Probe Manager Logs” on page 307

General Logs

» The log name is wrapperProbe.log.

Appendix D e Discovery Log Files

Description Error Information | Debug Basic Troubleshooting
Level Level Level
Records all the Any Important Record of | This is the first place to look
Discovery Probe's discovery | information | every for any Probe Gateway
console output in a error that | messages, probe problem. This log file shows
single log file. occurs such as the | access what the Probe Gateway was
within arrival or of the doing at what time and any
the Probe | removalofa | servlet important problems it
Gateway. | new task. encountered.
» The log name is probe-error.log.
Description Error Level Information | Debug Basic Troubleshooting
Level Level
Summary of the All errors in N/A N/A Check this log to see if errors
errors from the the Discovery occurred in the Discovery
Discovery Probe. Probe Probe components.
components.
» The log name is probe-infra.log.
Description Error Level Information Debug Basic Troubleshooting
Level Level
This log lists all the All Information Messages Open this log to see
infrastructure infrastructure | about mainly for | messages from the
messages. €ITOTS. infrastructure | debug Discovery Probe’s
actions. purpose. infrastructure only.
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» The log name is wrapperlLocal.log.

Description Error Level Information Debug Basic Troubleshooting
Level Level
Any Important This is the first place to look
discovery information for any Probe Manager
error that messages problem. This log file shows
occurs within | such as, what the Probe Manager was
the Probe received doing at what time and any
Manager. tasks, task important problems it
activation, encountered.
and the
transferring
of results.

Probe Gateway Logs

» The log name is probeGW-taskResults.log.

the server.

Probe Gateway to

number of CIs
to
delete/update.

results that
are sent to
the server
(in an XML
string).

Description Error Level | Information Debug Level | Basic Troubleshooting
Level

Thislogrecordsall | N/A Result details: The 1. If there is a problem with

the tasks results task ID, ObjectState the results that reach the

sent from the pattern ID, HolderVector | server, check this log to see

which results were sent to
the server by the Probe
Gateway.

2. The results in this log are
written only after they are
sent to the server. Before
that, the results can be
viewed through the probe
JMX console (Use the
ProbeGW Results Sender
MBean).

306




» The log name is probeGW-tasks.log.

Appendix D e Discovery Log Files

Description Error Level | Information | Debug Level Basic Troubleshooting

Level
This logrecords all | N/A N/A The task’s 1. If the Probe Gateway
the tasks received XML. tasks are not synchronized
by the Probe with the server tasks, check
Gateway. this log to determine which

tasks the Probe Gateway
received.

2. You can view the current
task’s state through the J]MX
console (Use the Discovery
Scheduler MBean).

Probe Manager Logs

» The log name is probeMgr-services.log.

Description Error Level | Information | Debug Level | Basic Troubleshooting
Level

Java services debug N/A N/A N/A Check this log to view Java

messages. services debug messages.

» The log name is probeMgr-performance.log.

Description Error Level | Information | Debug Level | Basic Troubleshooting
Level
Performance N/A N/A N/A 1. Check this log to

statistics dump,
collected every
predefined period of
time, which includes
memory information
and thread pool
statuses.

investigate memory issues
over time.

2. The statistics are logged
every 1 minute, by default.
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» The log name is probeMgr-patternsDebug.log.

Description Error Level | Information | Debug Level | Basic Troubleshooting
Level

This log contains N/A N/A N/A Use this log file for

messages used to debugging discovery

debug discovery patterns.

pattern issues.
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